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LESSON - 1 

DATA PROCESSING 
1.0 OBJECTIVE: 

• To know the meaning of data, information, data processing cycle and methods of data 
processing.  

STRUCTURE: 

1.1 Introduction 
1.2 Data processing 
1.3 Data Process Cycle or stages  
1.4 Methods of Data Processing 
1.5 Important terms 
1.6 Self Assessment Questions 
1.7 References  

1.1 INTRODUCTION: 

 Computers are a unique mode of storing, manipulating and retrieving the information. 
Gone are the days when an accountant had to manually deal with a number of vouchers, 
accounts and files. Now he has to simply put the required items in the computer and the same 
arc manipulated or processed by the computer and the desired result is produced. 

1.2 DATA PROCESSING: 

 Data Processing is a term meant for process of collecting all items of data together to 
produce meaningful information. Data Processing is a term mostly associated with business and 
commercial work. But it does involve scientific data processing. All the input items are raw in 
nature. These are entered in the computer. These items of input are manipulated in the 
computer and the user can obtain a meaningful or desired information- 

Examples of Raw Data and Processed Data 

a. Marks of Students 

 The data items pertaining to students viz. marks obtained by them in different subjects arc 
entered in the computer and the information (after processing) is received in the form of 
certificates showing complete details of marks, percentage of marks, division etc. 
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b. Pay Roll System 

 In an organization, the records of employees are feeded in the computer. These records 
may have various fields viz. Name, Designation, Address, Basic Pay, D.A., H.R.A. etc. They are 
provided salary slips showing complete details of salary. 

1.3 DATA PROCESS CYCLE (or) STAGES IN DATA PROCESSING: 

 Data processing follows a logical series of steps called Data Processing Cycle. 

 

 

 

Fig: Data Processing Cycle 

 There are basically five steps: 

 1) Preparation of Source Documents 
 2) Data Input 
 3) Data Manipulation 
 4) Output of Information 
 5) Data Storage 
 

1) Preparation of source documents: The first step is to obtain the relevant facts and 
figures and to set these out on source documents. For example, in a population survey, the 
name, address, age, sex, occupation etc., must be first written down on to a survey sheet or 
some other document. These documents may be so designed that information is recorded in 
the same structure as the data required by the computer program. 

 



 
 
Business Data Processing Systems   1.3  Data Processing      
 

  

2) Data Input: Once the data has been extracted from the source document, it must then be 
transposed into some form suitable for entry into the computer, so that processing can take 
place. The method will depend upon the input media or device. 

 Input devices are of many types but basically they are meant for presenting the 
information to computer in machine readable form. A computer system may have one or more 
of following input devices depending upon its type, size and use. 

  1) Punch Card Reader 
  2) Punched paper tape reader 
  3) Magnetic Tape 
  4) Magnetic Disk 
  5) Visual Display Unit (V.D.U) 
  6) Voice Data Entry terminal (V.D.E) 

3) Data Manipulation: Information input as data, for processing may have to be classified or 
sorted. It is this form of operation or data manipulation, rather than pure computation, with which 
data processing is mainly concerned. For example, in the population survey, we may want to 
classify people by occupation or by age. The purpose for which data is required determines the 
character of the information. Data manipulation lies between the input of data and the output of 
information. 

 a) Classifying: The classifying of data involves the identification of like data according 
to one or more characteristics. 

 b)  Sorting: After data is classified, it is usually necessary to arrange or rearrange the 
data into some logical order to facilitate processing. 

 c)  Verification of data: This involves checking its accuracy prior to submitting it for 
processing. 

 d)  Scanning: This involves searching for and assimilarity facts about events and 
relationships in an organisation's outside environment. 

 e)  Comparing: It is the simultaneous examination of two or more items of data as a 
basis for subsequent action. 

 f)  Calculating: The arithmetical manipulation of data to create meaningful results is 
known as calculating. This process is usually the most significant part of the manipulation 
operation because the results are generally provided as part of the output. 

 g)  Recording: Generally, the processing of data produces immediate results. These 
results may be recorded until further processing. 

 h)  Summarizing: Data must be often be reduced to a meaningful, concise form. This 
process is called summarizing. 

 i) Filtration: Filtration is the screening out of extraneous data. Indexing involves 
assigning codes to an item of data within a reference system is order to facilitate the retrieval of 
that data. 
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 Data manipulation may not follow all the steps involved but it will follow some options, 
which depends on application. 

4) Output of Information: The objective of outputting results of summaries is to provide 
meaningful information to managers, accountants, population survey analysts and so forth. 
Careful consideration, therefore, should be given to the presentation of results so that they can 
be digested easily and quickly. People receiving computer output have been forced to think out 
more exactly what information they requires from the computer and how it can be presented 
most usefully. 

5) Data Storage: In most cases, the results of processing one set of data are retained for 
future use or reference. For example, the survey results can be used to compare with the future 
population survey. 

1.4 DATA PROCESSING METHODS: 

 Data Processing varies from being completely manual to those which rely on the use of 
large electronic computers and accordingly can be  

I. Manual  
II. Semi-manual 

III. Mechanical 
IV. Electronic 

i) Manual Data Processing Systems:  

 The human being is the earliest and still the most prevalent form of data processor. Man 
receives data through his five senses of which most relevant portion comes through visual 
perception and hearing. These data are stored in the brain which also acts as a control and 
logic unit. Human mind performs many operations on data with the help of inbuilt internal 
storage? i.e. memory and experience and external data storage like books, reports, record 
cassettes. Mind acting as a control and logic unit can perform many operations on data like 
additions, subtractions, multiplications and division, storing results in the memory, comparing 
two items etc. Despite his ability to perform the foregoing tasks the human remains as an 
unreliable processor. Th2 human mind is slow in performing the arithmetical computations and 
rather erratic in applying rules of logic when they are repetitively required. Judgment is needed 
to make decisions in data processing systems because of the difficulty of planning to handle all 
eventualities. Thus human beings alone are inefficient data processors, but they are essential 
ingredient of data processing due to need of decision and judgment in planning the computer 
program. The examples are Abacus, Slide rule, Napier's bone, logarithmic tables etc. 

ii) Semi-manual data processing system:  

 The manual processing goes on manually using one's and competence. In semi-manual 
data processing, both man and small instruments are involved. These small 
instruments/devices may run by small batteries or D.C. 

  The instruments include 
 a) Calculators, 
 b) Totaling machines, 
 c) Type Writers etc. 
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iii) Mechanical Data Processing Systems:  

 Mechanical data processing uses mechanical devices of various kinds. This type of data 
processing has an edge over manual and semi-manual data processing systems. 

 The following are some advantages of mechanical data processing. 

  • Speed 
  • Accuracy 
  • Neatness 
  • Control 

 Mechanical data processing system includes Milometer, Facit calculators etc. 

iv) Electronic Data Processing System (EDP):  

 Data Processing means transformation of data for producing meaningful results for 
carrying out business/scientific activities. The result of data processing is called 
INFORMATION. The transformation of data consists of a sequence of operations. This 
sequence is called PROCEDURE. A data processing system is a system which takes data as 
input., carries out the required processing on data and produces the information. The system is 
called manual when processing is performed by human beings and automatic when machines 
are used. When computers are used, for data processing, the system is called Electronic Data 
Processing (E.D.R). 

 Data exist at five levels : 

 1) Raw data 
 2) Lists (Sequence) 
 3) Arrays (Tables) 
 4) Records (Groups) 
 5) File 

1.5 IMPORTANT TERMS: 

DATA: This term is used to describe basic facts about the activities of a business. Data is 
generally in form of names and numbers, times, dates etc. 

INFORMATION: It is the set of data which has been converted or organised into a more 
useful or intelligible form. Thus information is obtained by assembling items of data into a 
meaningful form. Whereas marks obtained by students and their roll numbers form data, the 
report card is the information. 

KNOWLEDGE: Information containing wisdom is knowledge. Knowledge is of two types : 

 Facts based or Information based: Knowledge gained from fundamentals and 
through experiments. The knowledge like the information contained in fundamental 
science which has been derived from experiments, rules, regulations commonly 
agreed by experts. 
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 Heuristic knowledge: It is the knowledge of good practice, experience and good 
judgments like hypothesis. 

 

1.6 SELF ASSESSMENT QUESTIONS: 

1. What is data processing? 

2. Explain various stages of data processing? 

3. Explain various data processing methods? 

4. What is Data Manipulation? Explain 

 

1.7 REFERENCES: 

 dBase III Plus    - R.K.Taxali 

 Business data processing system - kalyani Publications 

 Business data processing system - Telugu Akademi 
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LESSON - 2 
FILES 

2.0 OBJECTIVE: 
• To know the meaning of file, file concepts, classification of files, systems concept of data 

processing and processes carried out on files. 

STRUCTURE 

2.1 File concepts 

2.2 Types of files 

2.3 Systems Concept in Data Processing  

2.4 Processes carried out on files 

2.5 Self Assessment Questions 

2.6 References  

2.1 FILE CONCEPTS: 

Byte:    A byte is a group of 8 bits which is used to store a character.  

Field:   A field is a collection (group) of characters. This group is handled as a single unit and 
has its individual meaning. 

Record: A record is a collection (group) of fields. This group of field is related with particular 
information. For example the information regarding a customer (Name, Account, etc.) is a 
record. 

File: A file is a collection of organized records related to each other. For example, the records 
of 40 students in a class can be placed as a file in form of a collection. Any suitable name can 
be given to that file. 

 For example for disbursement of loans under various special schemes, a survey report is 
prepared and the following information is collected about the persons of a particular village. 

  The data/information necessary for a survey report is given as under: 

1. Name of Village   
2. Name of Person 
3. Age 
4. Sex 
5. Occupation 
6. Address 
7. Land Holdings  (I) Irrigated  (ii)  Unirrigated 
8. Family Income 
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9. Holding of assets  

     (i) Tractor  (ii)........  (iii)   ........ 

 Each of the above records, after survey, is put into the computer in a file and to obtain 
printed output thereafter. 

2.2 TYPES OF FILES: 

 Depending upon the purpose and nature of work, files are of various types: 

 a. Master File 
 b. Transaction File 
 c. Backup File (Dump File) 
 d. Report File 
 e. Archival File 
 f. Transfer File 

a. Master File 

 A master file is also called a primary file and contains records of permanent nature. A 
Master File is the most important file for business organizations where the records are stored for 
a fairly long time. The complete bio-data of all employees in the organization is kept in Master 
File. In the business organizations like banks a master file may contain the complete records of 
customers viz. name, address, account number, balance etc. It is necessary that these files be 
updated regularly so that the information retrieved from these files is self sufficient. 

 A Master File can be categorized into two types: 

 1. Reference Master File 
 2. Dynamic Master File 

 Both of these files are separately maintained and can be combined into one as and when 
need arises. 

• Reference Master File: This file contains the records which are unlikely to change in 
future. However, this file can be referred for information. Employees' complete bio-data 
can be kept in this file. 

• Dynamic Master File: This file is frequently updated. Dynamic Master File is 
maintained to keep business transactions. For example, a file containing the reservation 
charts of various trains need frequent modifications due to cancellation and fresh 
reservations. This type of a file is called Dynamic Master File. 

b. Transaction File 

 This file is generally known as movement or input file.  In a business house, various 
business transactions happen in day to day routine. A transaction file, therefore, contains the 
complete records of day to day transactions. For example a business house may create two 
separate transaction files for purchase and sales transactions. The amount of goods purchased 
is entered in the purchase file and receipts of sales are entered in the sales file. These files are 
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required to update the Master File. These files are of temporary nature because after updating a 
master file, they are no more required. 

c. Backup File (Dump File) 

 A backup is a duplicate copy of a Master or a transaction file. A backup file is created for 
security of data. In case, the master file or transaction file is damaged, there is a backup file to 
retrieve the data/information. The backup files are also called dump files. 

d. Report File 

 This file is known as output file. The report file is in the output form wherein the data has 
been extracted from the Master File. This report or output can be provided to the customers. For 
example-Water and Electricity Department sends computerized bills to the consumers. 

 The monthly salary slips are provided to the employees of the organizations. The report 
file containing the details of salaries of the employees can be stored on hard disk, floppy disks 
or magnetic tape in order to serve as an output file which is required for aggregating the annual 
salaries of the employees. 

e. Archival File 

 The file which contains the information regarding the past events that happened in the 
history of an organization is called Archival file. This file is of utmost importance because 
inference can be drawn and conclusions can be made knowing the past performances of the 
organization. 

f. Transfer File 

 A transfer file is required/used to carry data relating to an event. This event may be 
business transaction or production transaction. This file stores the information which serves as 
input to another process to create or update another file e.g. a transaction file may be used to 
serve as input file to a sorting process resulting in a sort file as an output file of sorted records. 
This sorted file may again serve as an input file for the next process i.e. for updating a master 
file etc. 

2.3 SYSTEMS CONCEPT IN DATA PROCESSING: 

 The activities of data processing can be viewed as a "System". The system can be 
broadly defined as a group of interrelated or interacting elements to achieve a common goal by 
accepting inputs and producing outputs in an organized process. Such a system has three basic 
components. They are: 
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Fig: Data Processing System 

1. Input: It consists of elements that enter the system in order to be processed. 

2. Processing: It involves "transformation" processes that convert input into 
output. 

3. Output: It represents elements that have been produced by the 
transformation process. 

 There are varieties of data processing systems, such as batch processing, online, real-
time data processing systems which have been covered in this section.  

Batch Processing System: 

 When transaction data are collected and are kept for sometime, until a large group of 
transactions are collected and then processed as group, it is called Batch Processing. The 
series of batches of data, can be processed without the operator's invention with proper 
instructions to the operating system, programs are executed sequentially. This process is often 
referred to as Stacked Job Processing and controlled by instructions which are referred to Job 
Control Language (JCL). The input and output devices in batch processing may be either at the 
CPU location or away from CPU. Most often the I/O devices are located near the CPU. When 
I/O devices are located away from the CPU, the procedure is called Remote Job Entry (RJE). In 
this case, the I/O devices are not permanently connected to the CPU. Generally the physical 
connection is made through telephone lines. As a batch of data is collected and accumulated at 
the CPU, it processes the data and transmits the result to the output portion of the RJE station.  

Off - Line Processing: 

 Transmission of data from the computing system can be achieved by many kinds of 
devices. This data flow through the input or output devices can be of different natures i.e. Off-
line, On-line, Real-time Processing. This data flow system may apply to varieties of systems 
starting from single to multi-programming and multiprocessing systems to mini or super 
computers or to the network of computers. 
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 An information processing device that functions independently of the CPU, is termed as 
an Off-line device and the operation of Off-line processing consists of conversion, collection, 
storage and output of data. The conversion of data from an invoice form to a machine readable 
document via a key-punch machine is an example of Off-line processing. The conversion* to 
magnetic disk data by use of a keyboard to disk system is also an Off-line processing. Other 
Off-line processing devices are MICR and cash register key. Data is thus stored temporarily 
until the devices are connected to a computer. The data is then transferred to the computer. 
Until that time, the data is Off-line. In some cases, a special purpose computer controls the 
transfer of the data to the magnetic disk. However, until the disk device is connected to the main 
computer, processing is Offline. 

On - Line Processing: 

 It indicates that the I/O device is under the computer's direct and absolute control. Broadly 
saying On-line deals with the user's ability to interact at any time with a computer. An I/O device 
that is inputing or outputing data to or from the CPU is On-line. An On-line device can be 
physically adjacent to the CPU or far away from it. The connection ^an be simply a few feet of 
cable and a transceiver. Real Time Processing : 

 The ultimate challenge in On-line processing is real time processing. With real time 
processing there is an automatic update of the data file without human intervention. The 
computer response to the next interrogation of the inventory file would reflect that newly 
decreased inventory volume. Such a system is also called a closed-loop system i.e. a computer 
caused action affects the next computer action. 

 In the extreme, an on-line system called a process control system uses computer-
connected devices that physically control an on-going process. If a warehouse were automated, 
the inventory balance would be decreased on the basis of how many items were pulled from the 
stock by a computer controlled mobile robot carrying items. 

2.4 PROCESSES CARRIED OUT ON FILES: 

 The various processes carried out on files may be summarized as follows: 

1) File creation:  

 This is the method of organizing one's data for use by the computer system into a series 
of records of a particular length, content and layout. 

2) File access:  

 When the particular application program is in use, it will have to access the relevant 
file(s). Since each file may contain a great deal of data, it may not be possible for the entire file 
to reside in main memory and portions of it will have to be drawn from secondary storage as 
required. A part of the operating system known as the file management system takes care of 
this activity. It is able to pass a certain number of records into main memory, to know when 
these have been processed, to transfer them back to the storage device and to user in some 
more. 
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Modes of Accessing Files: Another approach to classifying the use of a file in an 
information system is by the way that a particular program accesses the file. There are 
three possible modes of access to a file by a program. 

  a) Input 
  b) Output 
  c) Input/Output  

a) Input: 

 An input file is only read by the program. For example, a file of tax rates and tables 
would be an input file for the program that computes income taxes. A transaction file is 
generally an input file to an update program. A program file of source code is an input file 
to a compiler program. 

 b) Output: 

 An output file is only written by a program; it is created by the program. For 
example, a report file may be the output of a program that updates a master file. A 
program file of object code is an output file from a compiler program. 

c) Input/Output: 

 An input/output file is both read from and written to during a program's execution. 
For example, the payroll master file might be used by the payroll program both as a 
source of data about employee pay rates and as a repository of month-to-date and 
year-to-date pay totals. A master file commonly is an input/output file. 

3) File manipulation and maintenance: Having accessed the file, the individual records 
will be processed in some way but, in addition, other records may have to be added or deleted. 
In some cases, all the records on file may be printed out; in others, perhaps only selected 
records would need to be printed. 

4) File generation:   As a result of the manipulation of data in files, new files will be 
generated. Once an existing file has been altered, it is necessary to create a new file by writing 
the updated file on a new tape or another area of disk. The old tape or area of disk can then 
become available for re-use. 

2.5 SELF ASSESSMENT QUESTIONS: 

1. What is byte, field, record and file? 
2. Explain the classification of files? 
3. What is batch processing? 
4. What are the processes carried out on files? 

2.6 REFERENCES: 

 dBase III Plus    - R.K.Taxali 
 Business data processing system - kalyani Publications 
 Business data processing system - Telugu Akademi 
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LESSON - 3 

FILE ORGANIZATION 
3.0 OBJECTIVE: 

• To know the file organization, file operations, techniques of file organization. 

STRUCTURE : 

3.1 Introduction  

3.2 File organization  

3.3 File operations  

3.4 File organization techniques  

3.5 Comparison of file organization techniques 

3.6 Self Assessment Questions 

3.7 References  

3.1 INTRODUCTION: 

 Before proceeding to the concept of file organization one should know what is data? Data 
is a collection of well defined numbers, information and facts. This collection of numbers and 
information is feeded into computer and then processed. Data processing involves great deal of 
computations. The volume of data processing depends upon the volume of data feeded into the 
computer. In a small organization, where the quantity of data is small, the volume of data 
processing is also small. 

3.2 FILE ORGANIZATION:  

 The technique used to represent, positioned and store the records on a file is called the 
file organization. For data processing, it is a must that the output and information must be 
meaningful otherwise this processing is vague. Mere writing of a number or information which 
has no meaning, the processing of data is absolutely time wasting. For example take a number 
i.e. 745756. This number does not indicate any meaningful information because this can be an 
LIC Policy No., Bank Account No., Driving License No., Chassis No. etc. If "Phone Number" is 
written with this word, then this number becomes meaningful. Data Processing is an essential 
function in the business organizations. 
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3.3 FILE OPERATIONS: 

 A file can be accessed by a program that executes in batch mode or by a program that 
executes interactively. 

 The fundamental operations that are performed on files are the following: 

  1) Creation 
  2) Update, including  

 Record insertion  
 Record modification  
 Record deletion 

  3) Retrieval including  
 Inquiry   
 Report generation 

  4) Maintenance including   
 Restructuring  
 Reorganization 

1) Creating a file: 

 The initial creation of a file also is referred to as the loading of the file. The bulk of the 
work in creating transaction and master files involves data collection.  In some implementations, 
space is first allocated to the file, then the data are loaded into that Skelton. In other 
implementations, the file is constructed a record at a time. 

2) Updating a file: 

 Changing the contents of a file to make it reflect a more current snapshot of the real world 
is known as updating the file. These changes may include (1) the insertion of new record 
occurrences, e.g., adding a record for a newly hired employee, (2) the modification of existing 
record occurrences e.g. changing the pay rate for an employee who has received a raise, and 
(3) the deletion of existing record occurrences e.g. removing the record of an employee who 
has left the company. 

 In some implementations, the records of a file can be modified in place, new records can 
be inserted in available free space, and records can be deleted to make space available for 
reuse. If a file is updated in place by a program, then the file usually is an input/output file for 
that program. 

3) Retrieving from a file: 

 The access of a file for purposes of extracting meaningful information is called retrieval. 
There are two basic classes of file retrievals. They are inquiry and report generation. These two 
classes can be distinguished by the volume of data that they produce. An inquiry results in a 
relatively low volume response, whereas a report may create many pages of output. However, 
same installations prefer to distinguish between inquiry and report generation by their modes of 
processing. If a retrieval is processed interactively, these installations would call the retrieval an 
inquiry or query. If retrieval is processed in batch mode, the retrieval would be called report 
generation. 
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 A file retrieval request can be comprehensive or selective. Comprehensive retrieval 
reports information from all the records on a file, whereas selective retrieval applies some 
qualification criteria to choose which records will supply information for output. 

4) Maintaining a file: 

  Changes that are made to files to improve the performance of the programs that 
access them are known as maintenance activities. There are two basic classes of maintenance 
operations: restructuring and reorganization. Restructuring a file implies that structural changes 
are made to the file within the context of the same file organization technique. 

 File reorganization implies a change from one file organization to another. The various file 
organizations differ in their maintenance requirements : In general, master files and program 
files are created, updated, retrieved from and maintained. Work files are created, updated and 
retrieved from but are not maintained. Report files generally are not updated, retrieved from, or 
maintained transaction files are generally created and used for one-time processing. 

3.4 FILE ORGANIZATION TECHNIQUES: 

 There are four basic file organization techniques i.e., 

 1. Serial Files 
 2. Sequential Files 
 3. Indexed Sequential Files 
 4. Random/Direct Access Files 

1. Serial Files 

 The records in these files are stored one after the other serially. The records on the 
storage medium are stored one after one. There is no particular or organized order for 
arrangement of these records. On a magnetic tape the files are arranged as serial files along 
the length of the tape. 

  
10 

 
7 

 
9 

 
6 

 
12 

Fig : Serial File 

 In the above figure, to reach the file with key value 12, we have to surpass all the previous 
four values. It is a time consuming process to reach a later file. The only use of serial files is that 
the space on the tape is fully utilized. 

2. Sequential Files 

 A Sequential file is characterized by the fact that individual data items are arranged 
serially in a sequence, one after another. They can only be processed in serial order from the 
beginning. In other words, the records can be accessed in the same manner in which they have 
been stored. It is not possible to start reading or writing a sequential file from any where except 
at the beginning. If somebody wishes to access record number 20, he must go through the first 
19 records before one can get to record 20. Hence short cuts are not possible. Sequential 
access mechanism is similar to storing songs in cassettes by an audio tape recorder. If 
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somebody wants to hear a song which is in the middle of the tape, he has to press the forward 
or rewind button and get the particular song by hit or miss method. Possible medium of storing 
in sequential file is Magnetic Tape. The records in a sequential file are arranged one after one 
as in the serial file but the main difference is that, they are organized in the ascending order of 
the key field. To reach a particular record we have to make sequential search. These files are 
used as master files on which batch processing is done. The process of addition or deletion of 
records from these files is a tedious task. Updation of records takes a lot of time. 

 
6 

 
7 

 
9 

 
10 

 
12 

Fig: Sequential File 

Advantages 

 1. This file organization is very simple and file design is very easy. 
 2. If the processing rate is high, this system is economical and efficient. 
 3. The input medium is less expensive. 
 4. To locate a record, only a record key is required. 
 5. Sequential file can be created on any device. 

Disadvantages 

1. It is very time consuming to update a file when the activity rate is very slow. 
2. Only disk files can be updated and another new updated file (master file) is to be 

created for files on other devices. 
3. Addition or deletion of records from sequential file is a tedious job. 

3. Index Sequential Files 

 An Index Sequential File is created on a magnetic disk. In this method of file organization, 
a record can be written or retrieved by either a direct access or sequential access. The records 
in these files are normally in sequence by the key filed. In this organization two files are created. 
One is Main File and the other is Index File. The Index File contains a list of records in 
ascending order. The main advantage of these files is that the particular record can be 
accessed without having read the previous records. To reach a particular record in Index 
Sequential File, any mode direct or sequential can be applied. To reach this record is same as 
reaching a particular chapter of the book. Suppose your Accountancy book contains 12 
chapters. You want to reach 10th chapter named as Depreciation. You can choose two ways. 
You can either start turning/flipping all the pages until you reach this chapter or you can refer to 
the index of the book and look the page number of this chapter and access to that chapter. 

Advantages 

 1. Updating is simple. 
 2. Records can be linked between two files. 
 3. Quick access to a record is possible. 
 4. This file organization is economical and efficient. 

Disadvantages 

1. Storage space is not fully utilized. 
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2. Records can be linked between two files. 
3. This organization is expensive because relatively expensive hardware and software 

is required for storage of these files. 
4. Addition or deletion of records is a tedious job. If a record is deleted, it affects the 

index as well. 
5. These files can be stored only on direct access storage devices like disks. 

 

4. Random/Direct Access Files 

 This method of arranging records of a file is called direct access or random access. In this 
arrangement one can have access to any record which is situated at the middle of the file 
without reading or passing through other records in the file. Such arrangement is very much 
similar to a long play record in which if one wants to hear a particular song, he can pick up the 
head of the recorder and put it directly to the required track without hearing the songs records 
on the outer tracks. Magnetic multiple disks provide such facility. In this arrangement the user 
has the facility to access any record in the file. Random files are created and stored on the 
disks. In this approach the computer can directly locate the key record without searching or 
reading the previous records. In this file organization, the record is given a particular number. 
Using this key number, you can reach directly to this record. It is also possible to write or delete 
records to any position in the file by specifying the record number. 

 

Fig: Random/Direct Access Files 

Advantages 

1. Immediate updating of various files is possible in a lesser time. 
2. Addition or deletion of records is very simple. Only record number is required for 

such jobs. 
3. The job is efficient because time consumption is less. 
4. Immediate access to the files is possible. 
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Disadvantages 

1. This is a relatively expensive file organization Expensive hardware is required. 
2. It is less efficient in terms of utilizing storage space. 
3. This file organization is not well suited for batch processing. 
4. Direct files can be opened on the devices like magnetic disks. Hence medium like 

magnetic tape is a waste. 
 

3.5 COMPARISON OF FILE ORGANIZATION TECHNIQUES: 

S.No. File 
Organization 

Method 

Method of 
Access 

Possible Medium Possible use 

01 Serial Serial Magnetic Tape or 
Disk 

Unsorted transaction file 

02 Sequential Sequential Magnetic Tape or 
Disk 

Sorted transaction file or 
sequential Master file 

03 Indexed 
sequential 

a) Sequential

b) Selective 
sequential 
c) Random 

Magnetic Disk 

(Not magnetic 

tape) 

Master files requiring a 
variety of Processing 
activities 

 

04 Random / 
Direct Access 
Files 

 

Random Magnetic Disk (Not 
magnetic tape) 

Master files requiring fast 
reference or enquiry 

 

3.6 SELF ASSESSMENT QUESTIONS: 

1) What is file organization? 
2) What are the file operations? 
3) Explain the file organization techniques? 
4) Write The Comparison Of File Organization Techniques? 

 

3.7 REFERENCES: 

 dBase III Plus    - R.K.Taxali 
 Business data processing system - kalyani Publications 
 Business data processing system - Telugu Akademi 
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LESSON - 4 

LOTUS 1-2-3 
4.0 OBJECTIVE:  

• To know about the lotus 1-2-3 work sheet, advantages and applications of electronic 
spreadsheet. 

STRUCTURE : 

4.1 Introduction 

4.2 Spreadsheet / worksheet 

4.3 Advantages of Electronic Spreadsheet 

4.4 Applications of worksheet 

4.5 Indicators in lotus 1-2-3 worksheet 

4.6 Self Assessment Questions 

4.7 References 

4.1 INTRODUCTION: 

 LOTUS 1-2-3 is a combination of three utilities and therefore it is named 1-2-3 (some say 
that learning and using the package is as easy as learning 1,2 and 3. The programs have been 
developed to include : 

• 1 stands for Electronic Spread sheet 
• 2 stands for Business Graphs and 
• 3 stands for   Database Management System 

 Data is maintained in the form of tabular columns. The number of columns present is 256 
and the number of rows is 8192. Thus one can imagine a large sheet of paper with 8192 rows 
and 256 columns in which data can be stored.  The spreadsheet, as the name implies, indicates 
such a vast sheet.  Since, this is in the electronic media, it is known as the electronic 
spreadsheet. 

 In many business applications, one needs to make decisions based on the information.  
The information will be present in the form of values.  It is found that it is easier and less time 
consuming to analyze using graphs than actually analyzing values.  LOTUS 1-2-3 has an easy 
way to develop Business Graphs from the data present in the spreadsheet.  One can develop 
different types of graphs and choose the best one suited for the application. 
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 Since the data is maintained in the spreadsheet, it is possible to carry out the various 
functions of a DBMS package. 

4.2 SPREADSHEET / WORKSHEET:  

 A Spreadsheet is a tool for calculating and evaluating numbers.  It offers capabilities for 
creating reports and presentations to communicate what analysis reveals. The information 
already entered in the worksheet can be changed very easily. The worksheet calculates results; 
for instance, it can work out the total sales by multiplying the quantity sold with the unit price.  If 
some information is altered, the worksheet will automatically recalculate the results, for example 
if unit price is changed it will automatically recalculate and display the new total sales.  The 
information entered in the worksheet can also be printed. 

 Simply, a spreadsheet is a table of rows and column.  The intersection of each row and 
column is called a cell.  A cell holds any type of data including numbers, formulas, text etc.  
Most spreadsheets number the rows from top of the spreadsheet to the bottom, starts with 1.  
Columns are referred from left to right alphabetically. 

 A cell can be identified in a spreadsheet by its address.  A cell address is a combination of 
its column letter and row number.  For example D15 is the address of the cell at the intersection 
of Fourth column and 15th row.   

4.3 ADVANTAGES OF ELECTRONIC SPREADSHEET: 

 There are so many advantages of electronic spreadsheet over normal spreadsheet.  
Some of them are: 

1. Flexibility 

2. Speed 

3. Accuracy 

4. Automatic recalculation of results 

5. Several mathematical, trigonometric, Financial and Statistical functions are built-in. 

6. The results are accurate 

7. Big worksheet can be viewed or edited as a part of whole 

8. Data can be viewed in the form of graphs,  which can be of various types can be 
printed 

9. The entire worksheet or any part of it can be printed in desired format 

10. The worksheet is saved in an electronic file, and can be retrieved and modified later 
if required. 

11. An existing worksheet or any part of it can be merged with any existing or new 
worksheet. 

12. The information entered in a worksheet can be stored in a desired format 

13. With the electronic worksheet we can easily produce reports and get answers to 
"what-if" questions. 
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14. The information stored in a worksheet can be transferred to other software packages 
Oracle, Access, DBASE and WordStar.  Similarly, information stored in other 
software programs can also be transferred to a worksheet.   

4.4 APPLICATIONS OF WORKSHEET: 

 The following are some of the applications of worksheet / spreadsheet in the areas. 
• Budgets 
• Annual reports of business firms 
• Income statement and Income tax calculations 
• Payrolls 
• Invoices or bills 
• Accounts payable and receivable 
• Production and marketing analysis  
• Investment and loan analysis 
• Banking 
• Inventory control 
• Tender evaluation 
• Scientific calculation 
• Cost - effective analysis 
• Micro - economic analysis 
• Population analysis 
• Financial analysis 

4.5 INDICATORS IN LOTUS 1-2-3 WORKSHEET: 

 In a worksheet, there are 3 locations, where we can see the information regarding the 
worksheet, which are called indicators. 

 These indicators are: 

• Mode indicator 
• Status indicator 
• Date and Time indicator 

1. Mode indicator, which is present at the upper right corner of the worksheet.  Mode 
indicators display the status of the worksheet, message, the kind of data being typed 
and so on. 

2. Status indicator, which is present at place lower right of the worksheets.  Status 
indicators display the name of the worksheet file in use, error messages, such as disk 
and printer errors, status of special keys. 

3. Date and Time indicator, which is present at the lower left of the worksheet. 
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Mode Indicator:  

 This indicator appears at the upper right corner of the worksheet. There are 11 types of 
modes: 

• WAIT:    This is indicated while Lotus is executing or processing a command.  This 
mode goes off after the completion of execution. 

• VALUE:  This is indicated when the user is entering a number or a formula or 
quantitative data. 

• Ex: + B11 + A2   or  2577 

• EDIT:   This is indicted when the user perform any kind of editing by pressing   key. 

• READY:  This is indicated when the Lotus is ready to accept the next command or 
the next action.  In this mode user can enter data and activate menus. 
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• MENU:   This is indicated when the Lotus activates the menus.  The menus are 
activated by pressing (/) slash. 

• POINT:   This is indicated when user specifies a range or other cell reference using 
the cursor to highlight the desired cell.  This indicator also appears when user creates 
formulas using cell point techniques. 

• LABEL:   This is indicated while the user is entering a label into the cell.  A label is 
nothing but a non-numeric data. 

• HELP:   This is indicated when the user has invoked the HELP facility. 

• FIND:    This is indicated while the Lotus is in searching process.  That is / Data query 
command is executed. 

• FILES:   this is indicated when the File Menu is activated. 

• ERROR:   This is indicated when a software, macro or non-entry error occurs. 

Status Indicator: 

 This indicator appears at the lower right of the worksheet. 

• CAPS:   This indicates that the Caps Lock Key in ON.  To turn OFF press   key. 

• CALC:   This indicates that the worksheet has to be recalculated.  Press   key of OFF 
this mode. 

• NUM:   This indicates that the NUM Lock Key is ON.  To toggle NUM on or off, press 
Num Lock.  When active, any number pressed on the numeric keypad results in a 
number rather than pointer movement.  Now the arrow keys act as numeric pad and 
cannot be used for cursor movements. 

• SCROLL:   It indicates the Scroll Key is ON.  The upper, lower, left and right keys 
acts as scroll keys.  When active 1-2-3 moves both the worksheet and the cursor 
when user presses the arrow key. 

• SST:   This indicator appears when user debug the macro in single step mode. 

• STEP:  This indicator appears when a single step mode has been turned ON.  To turn 
the step on, press Alt and F2 at the same time.  To turn off press Alt and F2. 

• OVR:  This indicator appears if the insert key is ON. 

• END:  This indicates that the END key is ON.  This is used in combination with any of 
the arrow keys. 

• CMD:  This indicator appears during the execution of a macro.  When macro is 
executed, this indicator will disappear. 
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• CIRC:  This indicator appears of a cell is referring to itself. 

• MEM:  This indicator denotes a low memory warning.  Whenever the memory falls 
below 64KB 1-2-3 display this indicator. 

• UNDO:   When this indicator appears 1-2-3 saves the keystrokes in a special buffer.  
By pressing ALT + F4, user can reverse the effects of the previous command 
sequence. 

Date and Time Indicator: 

 This indicator appears at the lower left corner of the screen.  We can change this format 
by using Worksheet Global Default Other Clock None. 

4.6 SELF ASSESSMENT QUESTIONS: 

1. What is Lotus 1-2-3 ? 

2. What is spreadsheet or work sheet ? 

3. Explain the advantages and application of spreadsheet ? 

4. Explain the indicators in lotus 1-2-3 ?  

4.7 REFERENCES: 

• Working with lotus 1-2-3 : Hossein Bidgoli, Jai Co. Publishing House, Mumbai 

• Lotus1-2-3, A Guide and work book : E-Bala Guruswamy, Mi Sai Kumar, M.S.Sarma 
Macmiltan India Ltd., Delhi. 
 

• Lotus 1-2-3.     : A Tutorial Ruth Yaroo Cicilioni, Jai Co.  
                                                                       Publishing House, Mumbai 
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LESSON - 5 

ORGANIZATION OF THE WORKSHEET 
5.0 OBJECTIVE :  

• To learn about the Organization and Components of a worksheet, and functional keys in 
lotus 1-2-3. 

STRUCTURE : 

5.1 Organization of the worksheet 

5.2 Components of a worksheet in lotus 1-2-3 

5.3 Functional keys 

5.4 Self Assessment Questions 

5.5 References 

5.1 ORGANIZATION OF THE WORKSHEET: 

 The worksheet area is the most important part of the 1-2-3 screen. Its organization is as 
follows: 

a) Cell and Cell Address 

b) Row and Column Numbering 

c) Cell Pointer and Current Cell 

a) Cell and Cell Address: 

 The area formed by the intersection of a column and row is called a cell.  The cell is the 
smallest unit in the worksheet which is used to store data.  A cell referred by the column and the 
row number, The cell on the top left of the worksheet area,  is referred by A1.  Similarly, the cell 
below A1 is called A2 and that to the right of A1 is denoted by B1.  

 Although 1-2-3 is displaying only 20 rows and 8 columns in the worksheet,  the actual 
worksheet size is significantly larger than this.  The worksheet contains 256 columns and 8192 
rows. 
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b) Row and Column Numbering: 

 Row numbering in a 1-2-3 worksheet is straightforward, the fifth row is called row 5, the 
hundredth row is called row 100 and so on.  Column numbering is a little different.  The first 26 
columns are referred by letters A through Z.  The 27th column is referred as AA, the 28th 
column AB and so on.  The 256th column is referred as IV.  Accordingly the last cell in the first 
row is called IV 1  and the last column in the last row (8,192) is denoted by IV 8192. 

c) Cell Pointer and Current Cell: 

 The worksheet area contains a highlighted rectangle initially located in cell A1.  This is 
called the cell pointer.  The cell where the cell pointer is located is called the current cell.  Any 
data you typed is stored in the current cell.  You can move the cell pointer to any cell in the 
worksheet using the cursor movement keys located on the right hand side of your keyboard. 

 Cell Pointer Movement Key Moves Cell Pointer 

← Left by one cell 
→ Right by one cell 
↑ To the previous row 
↓ Down by one cell 
Tab Right by one screen (8 columns) 
Shift + Tab Left by one screen (8 columns) 
PgDn Down by one screen (20 rows) 
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PgUp Up by one screen (20 rows) 
Home To cell A1 
End followed by an arrow key To the end of worksheet in the     direction 

of the arrow keys 
F5 (Goto) To the specified cell address 

 

5.2 COMPONENTS OF A WORKSHEET IN LOTUS 1-2-3: 

 The worksheet can be divided into the following three parts: 

 a)   The Control Panel 
 b) The Worksheet Area and 
 c) The Status Line 
 

 
 

a) The Control Panel:    The first part comprising the top three rows is called the control 
panel.   1-2-3 uses the control panel to display information,  such as the first line contains the 

• The cell address 
• Contents of he current cell 
• Mode indicator 

       The second line contains three different types of information. 

• The information being entered into the cell 
• Menu choices when menu is invoked 
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• Message when a command is selected which needs additional information 

       The third line contains two different types of information. 

• Information about a highlighted menu selection when a menu appears on the second 
line. 

• A selection list when prompts requiring specific choices appear on the second line.  
For example if 1-2-3 requires a filename,  it prompts you for the name on the second 
line and displays a list of files on the third line. 

b) The worksheet area:   The middle portion of the screen which occupies most of it,  is 
called the worksheet area.  In this area,  data is entered and the calculated results are 
displayed.  The worksheet area is a grid of rows and columns.  This window has a highlighted 
border on the top and the left side.  This is also called the worksheet frame.  We will notice 
column letters A, B, C, etc. and row numbers 1, 2, 3 and so on displayed in the worksheet 
frame. 

c) The status line: The last line on the screen is called the status line. The status line 
consists of two parts.  The first part is the file and clock indicator.  1-2-3 displays the current 
date and time when the worksheet contains an unnamed file.  After you save the file and assign 
it a name,  1-2-3 displays the filename,  instead.   The second part is a series of status 
indicators.  These indicators provide information about system hardware and worksheet.  The 
following screen displays the various parts of the status line. 

5.3 FUNCTIONAL KEYS: 

 The Function keys F1 to F12 are used to perform the operations quickly.  It can be used 
as a single key or a combination with other.  The following are some of them. 

  Function Key      Description  

  1)  F1 Help It Access the Lotus help. 
2)  F2 Edit It shifts Lotus into Edit mode. 
3)  F3 Name It displays all the range names in 

POINT mode all the file names in 
the FILE mode. 

4)  F4 Abs It changes an address from 
absolute, to mixed or to relative. 

5)  F5 Goto It is used to move the cell pointer 
to any specified address. 

6)  F6 Window It moves the cursor between 
windows splitted screen. 

7)  F7 Query It performs the most recently 
used/data query commands. 

8)  F8 Table It executes the most recently 
used /data table command. 
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9)  F9 Calc It is used for recalculating the 
worksheet. 

10)  F10 Graph It is used to redraw the graph 
after performing some changes 
in the dat of worksheet. 

11)  Alt + F1 Compose It is used to generate 
international characters. 

12)  Alt + F2 Step It is used to generate 
international characters. 

13)  Alt + F3 Run Allows the user to select and 
execute a macro 

14)  Alt + F4 Undo Restores the contents of a 
worksheet after editing 1-2-3 
enables this feature as defalut. 

15)  Alt + F5 Learn Toggles the learn feature ON 
and OFF. 

SPECIAL KEYS: 

  There are some special keys to perform the task. 

 Backspace   : It erases the character 
 Tab      : In READY mode, it moves the cursor one screen to the right 
 Del      : It erases the character 
 Esc      : It cancels the current command in execution 
 Return Key:It finalizes the operations like entering data issuing a command. 
 

5.4  SELF ASSESSMENT QUESTIONS: 

1. Explain the organization of the worksheet in lotus 123? 
2. Explain the components of a worksheet in lotus 1-2-3? 
3. Explain the functional keys in lotus 1-2-3? 
 

5.5 REFERENCES: 

• Working with lotus 1-2-3 : Hossein Bidgoli, Jai Co. Publishing House, Mumbai 

• Lotus1-2-3, A Guide and work book : E-Bala Guruswamy, Mi Sai Kumar, M.S.Sarma 
Macmiltan India Ltd., Delhi. 
 

• Lotus 1-2-3.     : A Tutorial Ruth Yaroo Cicilioni, Jai Co.  
                                                                       Publishing House, Mumbai 
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LESSON – 6  

MENUS IN LOTUS 1-2-3 
6.0 OBJECTIVE: 

 To know about the Manus in Lotus 1-2-3. 

STRUCTURE 

6.1 Introduction 

6.2 Creation of worksheet 

6.3 File menu options 

6.4 Save option in lotus 

6.5 Quit menu options 

6.6 Self Assessment Questions 

6.7 References 

6.1 INTRODUCTION: 

 LOTUS 1-2-3 is a menu driven package. There is no need to type the commands. To get 
the menu the '/' key is to be pressed. As soon as this is pressed, the main menu appears on the 
second row of the screen (menu line) and the mode changed to MENU. The screen would look 
as shown in figure. 
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 The main menu consists of 10 options, which are shown, in the second row of the screen. 
The usage of these options is as follows. 

• Worksheet (/W):  This consists of menu commands to carry out various functions 
with the entire worksheet. 

• Range (/R):  This consists of menu commands to carry out different operations with 
a range of cells. The range indicates either a single cell or a group of continuously 
placed cells. 

• Copy (/C):   This main menu option is used to copy the contents of a range of cells 
into another range. After copy, both the ranges have data. 

• Move (/M):   This main menu option is used to move the contents of a range of 
cells into another range. After move, the data in the original range is erased but is 
present in the new range. 

• File (/F):   This option consists of commands to carry out different operations with 
files like saving file, retrieving file, etc. 

• Print (/P):   This option is used to send the required part of the worksheet on the 
printer or save in a file as a print file. 

• Graph (/G):  The business graphs are developed using this main menu option.
  

• Data (/D): The DBMS functions such as sorting, searching etc., are carried out 
using this main menu option. 

• System (/S): This option exits out of LOTUS 1-2-3 Temporarily into the DOS 
environment. Some of the DOS commands can be executed and one can re-enter 
LOTUS 1-2-3 and our worksheet by typing the command EXIT. 

• Quit (/Q): This command is used to come out of LOTUS 1-2-3 permanently. 

6.2 CREATION OF WORKSHEET: 

  To load 1-2-3 from the system prompt, complete the following step: 

 C:\ CD lotus <Enter key> 
 C:\lotus>123 <ENTER key>. 

 1-2-3 displays the copyright screen then presents a blank worksheet. 
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Enter the data as follows: 

Profit and Loss Statement 

  Particulars January February March 

  Cost 60,000 80,000 90,000 
  Overheads 10,000 15,000 20,000 
  Sales 80,000 1,00,000 1,20,000 
  Profit 10,000 5,000 10,000 

 

Cell Address Data to be entered 

A1 Profit and Loss Statement 
B3 January 
C3 February 

D3 March 
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A4 Cost 
B4 60,000 
C4 80,000 
D4 90,000 
A5 Overheads 
B5 10,000 
C5 15,000 
D5 20,000 
A6 Sales 
B6 80,000 
C6 1,00,000 
D6 1,20,000 
A8 Profit 
B8 10,000 
C8 5,000 
D8 10,000 

6.3 FILE MENU OPTIONS: 

Saving the worksheet: 

 The worksheet that we have typed is stored in the RAM (Random Access Memory) of the 
computer.  The RAM is volatile i.e.  it loses its contents if the power is switched off.  So the 
worksheet must be saved. 

 The commands for saving and retrieving a worksheet are available under File option in the 
main menu. 

• Press ‘/’     to invoke the main menu. 
• Select File Menu (either press or highlight File and press enter key) 

 Then 1-2-3 displays a new menu as shown. 

 Retrieve  save  combine  Xtract  Erase  List  Import  Directory  Admin 

   Highlight Save 

  1-2-3 displays a message "Store the entire worksheet in a worksheet file"  in the last 
line of the control panel.    

• Press Enter Key to select the save 
  1-2-3 displays the following prompt in the control panel. 

 If we are using a hard disk,  the message has C :  in place of A :  and may also include the 
directory name.  If the disk already contains some files.  1-2-3 also shows the file names in the 
control panel.  Type a new file name.  This file name can have upto 8 characters,  and include 
letters of the alphabet, numbers and underscore.  Punctuation marks and spaces are not 
allowed in file names.   
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• Type PROFIT and press enter key.   
  1-2-3 starts writing the worksheet into the disk.    

 It changes the mode indicator to WAIT.  After saving the worksheet in the file PROFIT,  it 
clears the menu and displays READY in the control panel.  1-2-3 automatically adds the 
extension name “.WK1” to the worksheet file.  So, the PROFIT worksheet is saved as 
PROFIT.WK1. 

Loading or Retrieving a worksheet file: 

  When we want to work with an existing worksheet file, we can retrieve it with the / 
File Retrieve Command. 

  Let us retrieve the PROFIT.WK1 worksheet 
  The following are the steps: 
  Press   or   to invoke the main menu 
  Select File Retrieve 
  1-2-3 displays the following prompt or one similar to it  
  Name of file to retrieve :  A  :  \ *.WK1? 

 It also displays the list of files present in the default disk or directory.  The desired file can 
be highlighted with arrow keys and load it in the worksheet by pressing enter key.  Any existing 
worksheet is erased and new worksheet is displayed. 

  To retrieve the PROFIT worksheet,  highlight PROFIT.WK1 and press enter key. 

File Menu Options in Lotus 1-2-3:  

 When the file option is exercised, the system displays the following sub-menu. 

Retrieve Save    Combine      Xtract       Erase        List      Import    Directory   

Combine (/FC): When this option is used a sub-menu  Copy Add Subtract  would be 
displayed.  One can copy,  add or subtract data from another worksheet into the current 
worksheet.  In all the three cases, the system would ask whether the entire worksheet has to be 
considered or only a part of the worksheet.  If a part of the worksheet has to be considered,  
then it would ask for the range.  One can specify the range using the address or the range 
name.  After it would ask for the name of the worksheet file,  which has to be specified.  The 
named range should have been created in the worksheet and the file saved. Then the action 
taken depends upon the option exercised.  These are as follows: 

Copy:  This copies the entire worksheet/named range from the cell where the cell 
pointer is located.  The cell pointer becomes the top left corner of the range.  the old data 
present in the current worksheet would be lost.  The formulas copied are automatically 
adjusted based on the current addresses. 

Add: This option adds the values in the worksheet/named range with the values present 
in the current worksheet.  If any label or formula is present in the cell,  then this is not 
erased. 
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Subtract: This is similar to the add option except tha the incoming values are 
subtracted from the values present in the current worksheet. 

Xtract (/FX): This is used extract part of the current worksheet into another worksheet.  One 
can extract formulas or values. The range from which the data has to be extracted, then they 
automatically get adjusted depending upon their location in the new worksheet. If values are 
specified, then only the values arising out of the formulas would be copied and not the formulas. 
The labels will be copied in either case. 

Erase (/FE): This option is used to erase a worksheet,  print,  graph  or any other types of file.  
One need to specify the name of the file and the file is erased permanently. 

List (/FL):  This option shows the names of files (worksheet, print, graph or other types of 
files). 

Import (/FI): This option is used to copy data from a print or any standard ASCII text file.  One 
can import either Text or Numbers.  In both cases,  one has to specify the name of the file from 
which it has to import. 

• When import is specified it copies the data from the text file with each line in a 
cell from the current cell.  This means that if the cell pointer is in cell X10, the 
entire first line of the text file will be entered into X10.  The second line will be in 
X11 and so on.  Each data is treated as a label. 

• When numbers are specified, the characters, if enclosed in quotes, and the 
numbers in the same line in the text file are entered in separate columns.  Any 
space, or other character present in the text is treated as a delimiter (separator) 
and the data will be entered on the next column. 

Directory (/FD): 

  This is used to see the current working directory and/or change to a new working 
directory. 

6.4 SAVE OPTION IN LOTUS: 

 The save option is used to save the new worksheet in Lotus.  This option is present 
under file option of main menu. 

 To save a new worksheet choose / File save and enter a name.  

 If we are working with the already saved file that has opened, Lotus displays option Cancel, 
Replace. 

 If cancel is chosen, changes will be lost and if replace is chosen older version will be 
replaced with current file. 

Save option with password. 

The following are the steps for saving with password. 
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 1) Create a worksheet. 
 2) Select/File Save from main menu 
 3) Type the file name and press space bar 
 4) Press key to activate password entry 
 5) Enter password (Maximum of 15 characters) and press enter key for confirmation. 

 

6.5 QUIT MENU OPTIONS: 

 When we want to quit from 1-2-3, the following steps are to be performed. 

• Press   or   while in the READY mode to select the main menu. 

• Select Quit: 

 1-2-3 displays the following message in the Control Panel. 

 Do not end 1-2-3 session; return to Ready Mode. As a safeguard, it displays No in 
highlight. 

 To quit 1-2-3, highlight Yes and press enter (or type Y) 

 If we have made some modifications in the current worksheet since the time you last 
saved it, 1-2-3 will warn with a message. 

 WORKSHEET CHANGES NOT SAVED!  End 1-2-3 anyway? 

 `Now type  to end 1-2-3  or  to return to READY mode. 

Save the current worksheet file. 

Select /Quit option and it quits the 1-2-3 session and returns to DOS. At the DOS prompt type 
LOTUS and press ENTER key.  

 1-2-3 Access system menu will be displayed with the following options. 
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6.6 SELF ASSESSMENT QUESTIONS: 

1) What are the menus in lotus 123? Explain 
2) How to create worksheet in lotus 123? 
3) Explain about file menu in lotus 123? 
4) Explain the Save option in lotus 123? 
5) Explain the Quit menu options in lotus 123? 

 

6.7 REFERENCES: 

• Working with lotus 1-2-3 : Hossein Bidgoli, Jai Co. Publishing House, Mumbai 

• Lotus1-2-3, A Guide and work book : E-Bala Guruswamy, Mi Sai Kumar, M.S.Sarma 
Macmiltan India Ltd., Delhi. 
 

• Lotus 1-2-3.     : A Tutorial Ruth Yaroo Cicilioni, Jai Co.  
                                                                       Publishing House, Mumbai 
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LESSON - 7 

FORMATTING WORKSHEET 
7.0 OBJECTIVE: 

 To know the how to formatting the cell on the worksheet and cell referencing. 

STRUCTURE : 

7.1 Introduction 

7.2 Format command options 

7.3 Move cell pointer on the worksheet 

7.4 Titles in lotus 1-2-3 

7.5 Worksheet window option 

7.6 Cell referencing 

7.7 Self Assessment Questions  

7.8 References  

7.1 INTRODUCTION: 

 A Worksheet can be formatted to meet user's requirements.  Lotus supports a number of 
formatting options. A variety of formatted reports can be generated easily. 

 A Worksheet can be formatted entirely or a specific portion of worksheet.  To format the 
worksheet there are 2 types of commands in Lotus 1-2-3. 

 1) /Worksheet Global Format is used to format the entire worksheet. 

 2) /Range Format is used to format the specific portion of the worksheet.   

7.2 FORMAT COMMAND OPTIONS: 

 Numbers of options are available under Format command. 

 Fixed   Scientific  Currency  General  +/-  Percent  Data  Text  Hidden  Reset 

1)  Fixed (/RFF):  This option is used to display fixed number of decimal places in the values 
present in the cells.  When this option is exercised, the system asks for the number of decimal 
places can be from 0 to 15.  When these two have been specified, the value type in that range 
of cells would be displayed with the specified number of decimal places. 
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2) Scientific (/RFS): This option is used for large or very small numbers.  It can have up to 15 
decimal places.  When this option is exercised,  the system asks for the number of decimal 
places required and the range of cells that have to be formatted.  When these two have been 
specified, the value typed in that range of cells would be displayed in the scientific notation with 
the mantissa having specified number of decimal places. 

3) Currency (/RFC): The currency format displays numbers preceded by a dollar sign ($).  
You can change the leading character by choosing a different currency using the Worksheet 
Global Default Other International Currency Command.  A comma appears between every third 
positions in the integer portion.  1-2-3 displays negative currency within parentheses.  Although 
1-2-3 uses a default of 2 decimal places, user may display upto 15 decimal places. 

4) General (/RFG): This is the usual default format. This indicates that the number would be 
displayed as it is typed, if the column width is sufficient.  In this format the significant zeroes to 
the right of a decimal place are eliminated.  If the width of the column is not sufficient, then it 
would be displayed in the scientific notation. 

5) +/- Option (/RF+):  This displays the values as a series of + signs or - signs depending 
upon the sign of the value.  If the value is positive,  then + signs are displayed and if negative,  
then - signs are displayed. The number of + or - signs equal to the magnitude of the value.  If 
the value is zero,  then a point (.) is displayed. 

6) Percent (/RFP): The percent format displays values in percent format.  In other words 1-2-
3 multiplies each value by 100 and follows it with a percent sign (%).  1-2-3 automatically 
displays upto 15 decimal places. 

7) Date (/RFD):  This is used to display date and time in the required format.  When this option 
is exercised, a sub menu is displayed.  This menu contains the different formats for displaying 
the date and time.  The menu shown in is as follows. 

 1.  (DD-MMM-YY)  2.  (DD-MMM)  3.  (MMM-YY) 

 4.  Long Intn'l   5.  Short Intn'l Time 

 DD-MMM-YY:   The display would be 08-JUL-02.  This is LOTUS long form for dates. 

 DD-MMM:   The display would be 08-JUL.  This is LOTUS short form for dates. 

 MMM-YY:   The display would be JUL-02.  This is also LOTUS short form for dates. 

8) Text (/RFT):  This format is used to display the formula in the cell instead of the value. 

9) Hidden (/RFH):  When a cell is formatted using the hidden format,  then the data entered in 
that cell is not displayed.  This is normally used when certain details present in the range are 
not to be printed. The data is not lost.  When the cell pointer is moved to the cell,  then the data 
is shown in the edit line. 

10) Reset (/RFR): This resets the formatting in the cell range to the current setting specified in 
the worksheet global format. 
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7.3 MOVE CELL POINTER ON THE WORKSHEET: 

 By using the cursor control keys the cell pointer can be moved. The four keys, viz. left, 
right, up and down arrow keys, move the cell pointer left, right, up and down respectively by one 
cell. 

 The Pg.Up and Pg.Dn. keys would move the cell pointer up and down respectively by one 
screen page (20 rows). Thus with the cell pointer in the 1st row, when the Pg.Dn. key is 
pressed, then the cell pointer moves to the 21st row(in the same column). 

 When the Tab key is pressed, the cell pointer moves right by one screen page (8 
columns). This means that if the cell pointer is currently in the column A, pressing the Tab key 
would move the cell pointer to column I (in the same row). Pressing the Shift + Tab key would 
move the cell pointer left by one screen page. 

 Pressing the function key F5 moves the cell pointer to the required cell. This key 
corresponds to GOTO. When the function key F5 is pressed, the message 

Enter address to Goto: 

 Appear on the edit line and the mode indicator shows Point indicating that the address 
has to be typed. When the address to which the cell pointer has to be moved, say AD2454, is 
typed and the ENTER key pressed, it will be seen that the cell pointer will be present in that 
particular cell immediately. 

 Home key always brings the pointer to the top most left corner cell e.e.  A1   + Arrow keys 
move the cell pointer to the last row/column of the worksheet. 

Ex:  From the cell B5 if we operate the keys +   which moves the cell pointer to B8192 similarly 
+ moves the cell pointer to /V5. 

7.4 TITLES IN LOTUS 123: 
 Let us consider a typical database having large number of records.  When the cell pointer 
is moved beyond row 21,  the first row would not be seen on the screen.  Then it would become 
difficult to know which of the data values one is analyzing.  Similarly, if one goes beyond the 
column H,  one would not be able to see the column A, which contains the names of 
employees.  Thus one may find it difficult to know whose salary particulars is being analyzed.  
The problem arises because the titles, names of employees or names of data fields have not 
been shown consistently on the screen.  If this has to be seen always, one makes use of the 
worksheet title option.  When this option is used, the sub-menu displayed would be 

   Both    Horizontal         Vertical          Clear 

Horizontal : When a particular row, say row 1, has to be displayed as title for all screen 
pages, then the cell pointer should be kept below that row and the Worksheet Titles, Horizontal 
option is exercised. This means that the horizontal title is fixed. If more than one row has to be 
displayed, say rows 1 and 2, then the cell pointer is kept in the row 3 and the option is to be 
exercised. 
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Vertical :   When a particular column, say column A, has to be  displayed as title for all screen 
pages, then the cell pointer should be kept  to the right of that column and the Worksheet Titles, 
Vertical option is exercised. This means that the vertical title is fixed. If more than one column  
has to 6e displayed, say columns A and B, then the cell pointer is kept in the column C and the 
option is to be exercised.  

Both :   This is used to fix both vertical and horizontal titles. 

Clear :  This clears the titles set. Unless the title is cleared, the cell pointer cannot move to the 
column and/or row fixed as title. 

7.5 WORKSHEET WINDOW OPTION: 

 This option is useful if one would like to see the data present in two different portions of 
the worksheet simultaneously. If the two address locations are such that they can be seen on a 
screen page simultaneously there is no problem. But if the locations are say A10 and BY10, it is 
obvious that both the locations cannot be seen on a single screen page simultaneously. For this 
purpose the cell pointer is moved to a cell near the center of the screen and Worksheet 
Windows option is used. The submenu displayed would be 

   Horizontal       Vertical       Sync Unsync    Clear 

Horizontal : This indicates that the screen has to be split up into two windows in the horizontal 
direction. The size of the two windows depends upon the position of the cell pointer. The 
windows only reflect whatever data is present in the worksheet. It is as if one is able to look at 
the same scenery through two different windows in a room. One can move the cell pointer to 
any cell. For example, when the down arrow key is pressed, the cell pointer, which is currently 
present in the top window, will move the next row. Only the top window would scroll and the 
bottom window will not move. When the data in a cell in one window is changed, one can notice 
that data present in the same cell ir the other window also changes. This indicates that one is 
having only one worksheet but seeing them in two different windows. To move the cell pointer 
from one window to other, press the function key F6. 

Vertical: This option splits up the screen into two windows vertically   

Sync :    This is the default option. This means that if the screen has been split up horizontally, 
then one can see different rows in the windows but the same columns. When we move the cell 
pointer to the next screen page horizontally using the tab key, simultaneously the other window 
would also display the next screen page. Thus the two windows move synchronously. 

Unsync :   In case we do not want the other window to move in relation with the current 
window then this option is used. Using this one can see two different cell addresses such as 
A10 and AX2550 simultaneously on the screen. 

Clear : This option clears the windows.  

Note : There is no option to see both horizontal and vertical windows. Setting one would 
automatically clear the other. 
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7.6 CELL REFERENCING: 

 The cell in a worksheet has its unique location at intersecting row and column. (e,g. B5, 
D10 etc.). When a particular cell is referred to in a formula, this is called cell referencing. 

 When a cell address is referred to in a formula; its style determines how it will be referred 
during the process of calculations. 

Referencing is of 3 types: 

  1. Relative Referencing 
  2. Absolute Referencing 
  3. Mixed Referencing 

RELATIVE REFERENCING: 

 When cells are referenced by their position in the worksheet on the ba of their position 
relative to the cell containing the formula, is called Relative Referencing. 

 This definition will be clear with the following example- 

 Lotus 1-2-3 maintains the address of a particular cell and compares it to the origin of the 
worksheet.  

 Consider the example: 

    B C D E 
   6 10 50 10 11 
   7 20 10 10 12 
   8 30 20 20 13 
   9 40 30 20 14  
   10 -- -- -- -- 
   11 100 100 60 50 
   12 -- -- -- -- 
 Enter the formula + B6 + B7 + B8 + B9 in the cell B11.  Copy this formula into the cells 
C11,  D11,  E11,  then it will appear as follows: 

   B11  =  +  B6  +  B7  +  B8  +  B9 
   C11  =  +  C6  +  C7  +  C8  +  C9 
   D11  =  +  D6  +  D7  +  D8  +  D9 
   E11  =  +  E6  +  E7  +  E8  +  E9 
 This is called relative addressing.  It is called relative address because it is stored as an 
address relative to the formula cell. 
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 In the above figure, the total can be calculated by using a formula =  +  B6  +  B7  +  B8  +  
B9 in the cell B11. 

 This formula used in B11 cell is interpreted internally in terms of position of cells (C11, 
D11 and E11) relative to the cell containing the formula (cell B11). 

 A formula copied from one cell to another adjusts itself according to the  position of new 
cell. The formula used in E2 cell will adjust itself automatically relative to current cell. 

 In the above figure it is obvious that the formula used in B11 cell has adjusted itself 
automatically relative to the position of cells where it has been used.  

ABSOLUTE REFERENCING: 

 The address can be specified in relative and absolute form.  The relative addressing 
indicates that the address is considered in relation to another cell where as the absolute 
addressing cell. Cell referencing in which references do not change when a formula is copied to 
a different cell is called Absolute Referencing. Cells are referenced by their fixed position in the 
worksheet. A $ (dollar) sign is used before the parts of a formula (before row and column). This 
is similar to the manner in which we specify the address for say, our house.  One way is to 
specify the house number, name of the house.  Another way is to give the position of the house 
in relation to some key place near the house such as a school, college, and worshipping place, 
place near the house such as a school, college and worshipping place, playground, etc,  

 This is relative addressing.  Consider the absolute address: 

   C D E F Formula 

  7 10 0.1   + C7/$C$11 
  8 20 0.2   +C8/$C$11 Copy 
  9 30 0.3   + C9/$C$11 
  10 40 0.4   + C10/$C$11 
  11 100 
  12  
  13 

 The cell D7 contains the formula C7/$C$11.  If this formula is copied to the range 
D8..D10, then the formula changes only the dividend portion but $C$11 does not changes.  This 
is because of Absolute (Fixed) Addressing. 

 To make a cell absolute, place a dollar sing ($) before the row number and also before 
the column letter. 

MIXED REFERENCING: 

 A combination of relative and absolute referencing is called Mixed Referencing.  A cell 
address is an intersection of a column and a row. It, therefore, contains two parts-column letter 
and row number. 
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Points to note: 

(i) The $ sign before column letter as well as row number makes it absolute cell address. 

        A                  B         C  D E F 
 1 PRINCIPAL INTEREST   0.65 
 2 
   3 10000 =A3*$E1 =A3*$E1 
   4 12000 =A4*$E1 =A4*$E2  
   5 15000 =A5*$E1 =A5*$E3 
   6 18000 =A6*$E1 =A6*$E4 
   7 20000 =A7*$E1 =A7*$E5 

Fig: MIXED REFERNECING 

(ii) The $ sign before row number or column letter makes it mixed cell address. In that address 
part of the cell is relative and other is absolute,  

(iii) Without any dollar sign, the cell address is relative cell address. 

        A                  B          C D E F 
 1 PRINCIPAL INTEREST   0.65 
 2 
   3 10000  6500  6500 
   4 12000  7800  0  
   5 15000  9750  0 
   6 18000  11700  0 
   7 20000  13000  0 

Fig: FORMULA USED IN MIXED REFERNECING 

 You will observe that in column B cell B3 Contains the formula = A3  *  E $ 1 

 It has been copied to other cells (B4, B5, B6 and B7) 

 In B4 cell, the copied formula is = A4 * E $ 1 and so on. 

 You will observe that relative part of the formula is updated and the absolute part remains 
the same. 

 The $ sign before row number makes the cell as relative cell address. You should note 
that E$ 1 is same as $E$1. 
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7.7 SELF ASSESSMENT QUESTIONS: 

1. What are the Format command options? Explain 

2. How to Move cell pointer on the worksheet? Explain 

3. How to fix the titles to worksheet in lotus 123? 

4. Explain the worksheet window options? 

5. What is cell referencing?  

6. Explain various types of cell references with examples? 

7.8 REFERENCES: 

• Working with lotus 1-2-3 : Hossein Bidgoli, Jai Co. Publishing House, Mumbai 

• Lotus1-2-3, A Guide and work book : E-Bala Guruswamy, Mi Sai Kumar, M.S.Sarma 
Macmiltan India Ltd., Delhi. 
 

• Lotus 1-2-3.     : A Tutorial Ruth Yaroo Cicilioni, Jai Co.  
                                                                 Publishing House, Mumbai 
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LESSON - 9 

FUNCTIONS IN LOTUS 1-2-3 
9.0 OBJECTIVE: 

 To know about the functions in the lotus 1-2-3. 

STRUCTURE 

9.1 Introduction 

9.2 Formulas 

9.3 Functions in Lotus 1-2-3 

9.4 Self Assessment Questions 

9.5 References 

9.1 INTRODUCTION: 

 The numeric data can be used for calculations. These calculations can be done by 
writing the formulas, whether you need to find a sum or calculate a complex set of formulas, 1-
2-3 can quickly provide the answer. In addition, it also provides some prewritten formulas called 
functions that can handle the complex calculations. The following are discussed in this chapter. 

• How to write a simple math formula 

• How to write a function 

• What is a range 

• How to find sums and averages, maximum & minimum values 

• How to convert a label entry to upper/lower case 

• How to compare the content of a cell with a specified value or label 

9.2 FORMULAS: 

 The advantage of an electronic worksheet is most apparent when you begin doing 
calculations. 

 A formula is a mathematical expression you write to perform calculations on your 
numbers. You can use the following five operators in formula:  +  (pkus),  -  (minus),  / (divide), x 
(multiply) and  ^ (Exponentiate). When you change the data,  1-2-3 automatically recalculates 
formulas that arc affected, 

 A formula always starts with a + or - or @ or ( or # or $) symbols. 
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Writing a Formula: 

 A formula can be written using both numbers and cell addresses.  Incase a cell address 
has been entered in the formula, the calculation is done on tin in the addressed cell. 

 If a cell address comes first in the formula, it must be preceded In (-) or opening 
parenthesis ‘(‘. 

 The following are some of the valid formulas: 

  840/2  

  10xD3  

  +Ax220  

  D7+Dx62  

  (D2+E2)-10 

 If a formula contains various operators, 1 -2-3 performs calculations in a preset order i.e 
multiplication is done before addition. So, in the formula 2*3+4, the result will be 10 and not 14. 
You may, however, use Bets of parenthesis to determine the order. For example, if you want to 
multiply 2 with the sum of 3 A, you could write as 2*(3+4) 

Note: The preset order for calculation is ( [parenthesis), x [multiplication], / [division], + [plus], - 
[minus]). Between I and whichever comes first in the formula is done first. 

 In the following worksheet, you have to enter the total marks of AAA, in the cell F2. 

Move the pointer to F2.   Type  

 +C2+D2+E2J 

 The result of formula i.e 243 is displayed in the F2 cell. You'll want similar formulas to 
calculate the total marks of the rest of I he students. Since the real content of the cell is the 
formula, it means that when you copy the content of this cell, you'll be copying the formula, and 
not the 243. 

 So instead of typing five more formulas, you can simply copy the formula to the other 
cells.  

9.3 FUNCTIONS IN LOTUS 1-2-3: 

 In the previous example, you learned how to write a simple formula that added the 
numbers across several cells. But imagine adding 100 numbers. You would have to type a 
formula with 100 cell addresses to get the answer. 

 This type of calculations can be made simpler, by using certain built-in formulas called 
functions. 
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Writing a Function: 

 You write a function by typing @, then the function name, and then in the parenthesis 
the values or range of cells over which the function will act. 

Ranges: 

 Before using functions, it's important to understand exactly what a range is.  A range is 
any unbroken rectangular group of cells. 

 To specify a range, you can type the first (upper left) and last (lower right) I ell address, 
separated by two periods. The following figure shows a few example! of ranges and the way 
you would write them in a command.  

1. Range A1..A1 includes the cell Al 

2. Range C3..E4 includes the cells C3,  C4,  B3,  B4,  E3,  E4. 

3. Range G1..G4 includes the cells G1,G2,G3,G4. 

Another method is pointer technique. Place the cell pointer on the first cell of the range and 
press. (dot). Now using the arrow keys, you can anchor the pointer to the left, right, up or down, 
to include all the cells in the range4 and press ENTER key 

 You may enter more than one range of cells in the above function, 

 For example, you could add three ranges, separating them with commas, like this 
@SUM(B2..B5,C2..C5,D2). 

(1) THE @SUM FUNCTION 

 With this function you can find out the sum of the values in a range of cells. 

 In the previous example (Fig. L-3.1), you had calculated the total MARKS Ol F2, by 
entering the formula    

  +C2+D2+E2 

 However same result can be accomplished byenteringin F2, the following function 

  @ SUM (C2..E2) 

 The cell F2 would show the result of the above calculation i.e the sum of cells C2, D2 & 
E2. 

 The @ SUM function therefore provides the sum of the given range of cells. 

(2) THE @ AVG FUNCTION: 

 In the above worksheet, if you want to put in cell C8,  the average marks obtained by 
students in Physics, then you can use the formula (+C2+C3+C4+C5+C6+C7)/6. 



 
 
Centre for Distance Education   9.4   Acharya Nagarjuna University   
 

 

 However with the  @AVG function you can make the entry much simpler as follows: 
  @AVG(C2..C7) 

 now the value 78.66667 will be entered in C8. 

 Therefore the @AVG function gives the average of the given range of cells. Other 
examples of the ®AVG function are 

 @AVG(F3..F10) 

 @AVG(B2..E2,G2,I2,L2) 

(3) THE @ MAX FUNCTION: 

 In the above worksheet if you want to put the maximum value of marks obtained in 
Physics, in the cell C9, do as follows: 

 (i) Move the cell pointer to C9. 

 (ii) Now enter here 

  @MAX(C2..C7) 

 and t he value 90 will be placed in C9: That is the maximum of the values in the cells C2, 
C3, C4, C5, C6 and C7 is placed in C9. 

 Therefore the  @MAX function gives the maximum of the values in a given range. 

(4) THE @ MIN FUNCTION: 

 In the above worksheet, if you want to put the minimum value of marks obtained in 
Physics, in cell C10. 

 (i) Move the cell pointer to C10 

 (ii) At C10 make the entry 

  @MIN(C2..C7) 

  and now the value 65 will be placed in C10. 

  Thus the minimum of the value in the cells C2 to C7 have been placed in C10. 

(5) THE @ UPPER FUNCTION: 

 Suppose you have made the entry name in the cellA2. Now you would like to make it all 
capitals as NAME in cell D2. Then 

 (i)  Move the cell pointer to D2.  

 (ii) Here make the entry 
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  @UPPER(A2) 

 and the 'name' will become all capital Letters. 

 You could have also used the Junction as follows  

  @UPPER(name)  

(6) THE @LOWER FUNCTION. 

 This function converts capital letters to ordinary lower case. 

 If in the cell D2 you have the entry 'SALES' and you would like to convert it to lower case 
in D3, do as follows: 

 (i) Move the cell pointer to D3. 

 (ii) Here make the entry 

  @LOWER(D2) 

 Now the entry will become 'sales', In the Cell D3. 

(7)  THE @COUNT FUNCTION 

 Say that you have entered a worksheet as follows 

 Place the cell pointer in B8 and enter  

  @COUNT(B2..B7) 

 and the value 4 will be placed in B8. 

 The ©COUNT function therefore gives the count of the number fl rolls in the range B2 to 
B7 that contain value. As B4 and B6 are empty the result is displayed as 4. 

(8) THE @IF FUNCTION 

 The @IF function is a logical function that lets you compare the content of a cell to a 
value or label you specify. If there's a match, 1-2-3 will take one action;  if there’s not a match,  
1-2-3  will take another action.  The format of the command is 

 @IF (comparison, action if match, action if no match) 

 The action could be to write a label or number, perform a calculation, or some other 
operation.  If an action is to write a label,  you must enclose the label in quotes. 

 If in the above example you place the cell pointer in B6 and make the entry. 

  @IF (B5>B3,1,0) 

 the 1 gets displayed in B6. 
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 This is because the value in B5 (471) is greater than B3 (275), the ‘B5 > B3’ is true and 
so the 1 gets displayed. 

9.4 SELF ASSESSMENT QUESTIONS: 

1. What is formula? 

2. What is function ? 

3. How to write a function? Explain with examples. 

4. Explain various types of functions in lotus 123 ? 

9.5 REFERENCES: 

• Working with lotus 1-2-3 : Hossein Bidgoli, Jai Co. Publishing House, Mumbai 

• Lotus1-2-3, A Guide and work book : E-Bala Guruswamy, Mi Sai Kumar, M.S.Sarma 
Macmiltan India Ltd., Delhi. 
 

• Lotus 1-2-3.     : A Tutorial Ruth Yaroo Cicilioni, Jai Co.  
                                                                       Publishing House, Mumbai 
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LESSON - 10  

PRINT OPTIONS IN LOTUS 1-2-3 
10.0 OBJECTIVE: 

 To know the printing procedure of work sheet and graphs in lotus 123. 

STRUCTURE  

10.1 Print command options 

10.2 Printing the worksheet 

10.3 Printing the Graph 

10.4 Self Assessment Questions 

10.5 References 

10.1 PRINT COMMAND OPTIONS: 

      When the /print command is selected, then user will get 2 options printer and file. 
 Both have the following options. 

 Range Line Page Options Clear Align Go Quit 

  Specify a range to print 

Range:  It allows to print either entire worksheet or a specific portion of the worksheet.  Here 
we have to specify the range address or use pointing. 

Line:  This option is used to perform minor adjustments to the page position.  This is especially 
convenient when you need to adjust minor differences in forms.  By setting the printer to the 
exact top of the form,  user can always offset the paper to the exact number of lines needed.  If 
the printer is at the bottom of the report, this command will advance the printer to the next page. 

Page:  It skips a page or advances a page.  If here is a footer.  It is printed at the bottom of the 
page. 

Align:   When the printer is switched ON and ready, this option resets the printer indicating that 
it is at the page one should note that the printer keeps track of the lines being printed so that as 
soon as the specified number of lines are completed, it would eject to the next page. 

Go: This option sends the specified range to the printer/File. 

Clear:  This clears all the ranges and options set. 
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Options:  This option is used to set other details for the printout.  This displays a further sub 
menu. 

Header Footer   Margins Borders       Setup Pg-Length Other Quit 

Header and Footer:  The header option is used to specify the heading on each page of the 
printout.  Similarly the footer option is used to specify the footer at the bottom of each page of 
the printout.  These are character strings with a maximum of 240 characters.  Any character can 
be used but three characters are specially reserved for certain purposes these are: 

  #  prints page number 
  @  prints the current date 
  |  Divide the header / footer into left aligned,  center and right - aligned text 

Margins:  This is used to indicate the left, right, top and bottom margins for the printout.  The 
left margin and right margin can be any value from 0 to 240 with the right margin greater than 
the left margin.  The printing each line and the right margin indicates the column position where 
it should stop the top and bottom margins indicate the number of lines to be left blank at the top 
and bottom of each page.  These can have any value from 0 to 32. 

Borders: This is used to print a particular column or row as border on each page of the 
printout.  If the number of rows to be printed exceeds the page length, then the column 
headings would be present only on the first page and not on the subsequent pages, for example 
if we consider a company with 1000 employees,  then the printout would run to many pages and 
except on the first page, no page would have the headings such as “Name of Employee,  
Designation,  etc...”.  If these have to be printed on each page then the borders rows option is 
selected and the range that should be considered has to be given.  This order would 
automatically appear on each page before printing the actual data. 

Setup: This is used to specify certain initial printer setups usually to change the size of the 
characters.  The setup strings is in the form of \nnn, where nnn is a decimal number indicating 
the control character.  By default the setup would be \010 indicating normal printing.  In case 
condensed printing is required, one can use \015. 

Pg-Length:  This is used to specify the number of lines to be printed on each page.  This can 
change from 1 to 100.  This should be greater than the top margin + bottom margin + header + 
footer. 

Other:  This contains other options such as 

 As-Displayed Cell-Formulas        Formatted Unformatted 

Cell-Formulas:  It prints the contents of each occupied cell in the specified print rage,  one 
cell per line.  If formulas have been entered,  the formula would be printed and not the values. 

 As-Displayed:   It prints the report as it appears on the monitor. 

 Formatted:  It restores the previous format setting for headers. 

 Unformatted:  It prints a specified range without headers,  footers and page breaks. 
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10.2 PRINTING THE WORKSHEET: 

 The worksheet can be printed by the printer.  To Print the worksheet /Print command is 
used. Let us print the PROFIT.WK1 worksheet. 

 The following steps are to be followed: 

1) Retrieve or load the worksheet into 1-2-3 

2) Invoke the 1-2-3 main menu select print from the menu.  The control panel displays two 
options - Printer and File.  1-2-3 allows to print the worksheet file directly on a printer 
with the printer option or on to a disk file with the File Option. 

3) Select printer option and press enter key.  1-2-3 displays the following options in the 
control panel.  

  Range Line Page Options Clear Align Go Quit 

  Specify a range to print 

4) Range is one that must be defined.  Range specifies the part of the worksheet to be 
printed.  Entire worksheet or a part of it can be printed. 

5) Select Range and 1-2-3 prompts to enter print range. 

6) Press key to move the cell pointer to cell A1 

7) Press key and then  key followed by  key to highlight the complete worksheet. 

8) Press Enter key to select the highlighted range.  1-2-3 displays the defined range in the 
settings sheet. Having specified the print range, check that the printer is connected to 
the PC and is switched on. 

9) Select GO option. 

 1-2-3 starts printing the worksheet.  After completing the printing, if returns to the print 
menu. 

10.3 PRINTING OF GRAPH IN LOTUS 1-2-3: 

 In order to print a graph in LOTUS 1-2-3 we need a separate sub system of LOTUS 1-2-
3 i.e. PRINT Graph. 

 The following are the steps to print a graph from Lotus 1-2-3. 

 Save the current worksheet file. 

 Select /Quit option and it quits the 1-2-3 session and returns to DOS. At the DOS 
prompt type LOTUS and press ENTER key. 1-2-3 access system menu will be displayed 
with the following options. 
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 Select Print Graph option. 

 Now it displays the following menu. 

 

 

 Adjust the paper in the printer at the  beginning of the page. 
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 Select Align. This informs Print Graph that the paper is positioned at the top of a new 
page.  

 Next select Go to initiate the printing of graph. 

 

10.4 SELF ASSESSMENT QUESTIONS: 

1) Explain the Print command options? 

2) How to print the worksheet in lotus 1-2-3? 

3) How to print the graph in lotus 1-2-3? 

 

10.5 REFERENCES: 

• Working with lotus 1-2-3 : Hossein Bidgoli, Jai Co. Publishing House, Mumbai 

• Lotus1-2-3, A Guide and work book : E-Bala Guruswamy, Mi Sai Kumar, M.S.Sarma 
Macmiltan India Ltd., Delhi. 
 

• Lotus 1-2-3.     : A Tutorial Ruth Yaroo Cicilioni, Jai Co.  
                                                                       Publishing House, Mumbai 
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LESSON - 11 

DBASE III PLUS 
11.0 OBJECTIVE: 

 To Know the Concepts Of Data Base and Dbase III Plus 

STRUCTURE 

11.1 Introduction 

11.2 Data base concept 

11.3 Approaches to Data Base Management System 

11.4 Data base management system 

11.5 Uses of data base system 

 11.6 Structure of Data Base 

 11.7 Security Measures 

11.8 Dbase III plus 

11.9 Features of dBASE III plus 

 11.10 Dealing with files in dBASE 

11.11 Self Assessment Questions 

11.12 References  

11.1 INTRODUCTION: 

 Every organization has to deal with different types of data depending upon the volume of 
transactions. These transactions may be of different nature. There are the following stages 
involved while dealing with the data. 

    1. Receive  2. Storing  

   3. Retrieval  4. Processing 

    5. Distribution 
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11.2 DATA BASE CONCEPT: 

 Let us try to understand the concept of Data Base in the following reference. Consider an 
example of a large manufacturing organization. The organization has various departments 
mentioned as under: 

   1. Sales Department  2. Production Department 

   3. Purchase Department  4. Stores Department 

   5. Accounts Department  6. Management 

 All the departments are linked with each other in one way or another. If the organization 
has computerized Data Base, the process of storing, retrieval, processing and distribution of 
information becomes very easier. Sitting in Sales Department, one can obtain the information of 
total purchases through the computer in no time. Management obtains a clear picture of the 
performance of the organization. 

 A collection of logically related data stored together is called-data base. Various 
Approaches of Data Base Management Systems 

11.3 APPROACHES TO DATA BASE MANAGEMENT SYSTEMS 

  It is of utmost importance that data must be retrieved from computer in minimum 
possible time. When we are dealing with large databases, it is not simply possible to go through 
the entire file and to extract the required data. The files are to be arranged in some particular 
order according to the requirement. The information can be achieved in the following 
approaches. 

   1. Hierarchical Approach 
   2. Network Approach 
   3. Relational Approach 

HIERARCHICAL APPROACH 

 Hierarchical Approach is an old approach. Initially this approach could provide only limited 
facilities but with the improvement of Data Base Packages, there has been an improved trend. 

 In the hierarchical approach, the order of information and storage thereof is decided. 
There may be many users. For each user a hierarchy is decided. 

 This model uses tree like structures to represent relationship among records. Tree has 
nodes and branches. The top node is called root. The dependent nodes at lower levels are 
called children.  

 Characteristics of Hierarchical Approach 

 (i) A hierarchical approach starts with a root node. 
 (ii) Parent node can have one or more child nodes. 
 (iii) Node contains one or more attributes. 
 (iv) Nodes can be accessed through their parents. 
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 NETWORK APPROACH 

 Network Approach is a complex approach. A child record may have more than one parent 
in it. The records are not rearranged as in case of Hierarchical Approach. Files are kept 
separately. Let us take the same example of three files - Order file, Customer File, Product File. 
As and when the orders are received, order file records are stored. One extra field is added to 
customer Record and Order Record. 

  A network is created by the link of Order Records the Customer Record. Order Records 
are referred to as Children and Customer Record as Parent 

RELATIONAL APPROACH  

 Relational Approach is the newest approach for Data Base Management. The data stored 
in the files by the organization may be very large. Suppose the file is stored in the form of a 
table. Each file is supposed to contain only one type of record having a fixed number' of fields. 
Let us consider that the organization is involved in the process of production of some items and 
it supplies the products to the customers as per their orders.  

 Features of Relational Approach 

1. All the files are termed as tables. 
2. All the records are termed as rows. 
3. All the fields are termed as entities or columns. 
4. Each table is stored separately. 
5. Each table is indexed on those columns desired by the user. There may be more 

than one index for the same Table. 
6. More than one table can be joined through a common column. 

The Relational Approach can be used in the following packages : 

 1. MS-ACCESS 
 2. UNIFY 
 3. INGRESS 
 4. ORACLE 
 5. dBASE III PLUS 
 6. FOXBASE 
 7. Soft Base 

RELATION 

 In each column of the table, one particular item relating to that column appears. In the 
given table, the STUDENTNAME column, only names of the students appear and in ROOLNO 
column, only roll numbers of the students appear. Each and every column of the table has a 
particular relationship. The whole table can be referred to as Relation. 

11.4 DATA BASE MANAGEMENT SYSTEMS 

 When large organizations and offices are computerized, the large amount of data is so 
managed that it can be effectively used on the computers. Data Base Management System is a 
part of effective data management. 
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 Data Base Management means maintenance of records and information. This is a 
computer based management. The following diagram depicts the parts of Data Base System. 

 Data is a collection of number and figures which we feed into the computer for the 
purpose of processing. This is an essential raw material for computers. 

 Hardware means the internal structure, storage devices etc. Software is for the purpose of 
understanding the programs and hardware of the computer. Programming languages are the 
part of software. 

The person who works on the data is called user. 

11.5 USES OF DATA BASE SYSTEM: 

1. The data can be easily shared and stored. 
2. Data base system helps user understand the computer commands and other 

functions. 
3. DBMS helps in reading the data. 
4. DBMS helps in removing errors. 
5. The old records can be removed and the readable data can be extracted in case of 

need. 
6. Various security measures can be taken with the help of DBMS.     

  

11.6 STRUCTURE OF DATA BASE 

 The data base which is to be created is provided 8 characters. Data base has two 
divisions. 

  1. Header 
  2. Data Field 

 The data elements and description is stored in header whereas actual data is stored in 
data field. Records can be viewed on computer screen with the help of data base. Output is 
printed with the help of printer. 

 Files can be opened by commands. Once the data is on the screen, it can be edited and 
various functions can be performed. The managing of data within one file is called file 
management. 

11.7 SECURITY MEASURES 

 The data must be secure and safe in Data Base. Unauthorized access may be harmful for 
the data. Various steps should be taken to discourage unauthorized persons. It is very important 
that data must be secure and only authorized persons can read, change or amend it. 
Sometimes the data is so important that a little leakage by an unauthorized person cause the 
damage to whole of the organization. 

 Data Protection Act (1984) however is in practice. This act consists of two levels. 

  1. Users 
  2. Data 
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 The main aim of that act is that the users must follow some rules and regulations and 
abide by them. These rules may be general to mechanical. 

 The use of pass words is a general security step. The password is known only to the user. 
Data can be locked into the computer. The machine should be capable to recognize the actual 
user. Secrecy is directly related with security. Computer systems can be made more secure 
through a control on hardware and software. There must be internal system in the computer to 
know who changed the data, when changed the data? 

 Computers have become an integral part of activities. This is necessary for us to keep 
care of them so that they may provide maximum benefits in return. 

11.8 DBASE III PLUS: 

 When large organizations and offices are computerized, the large amount of data is so 
managed that it can be effectively used on the computers. Data Base Management System is a 
part of effective data management. 

 Database is a collection of information. A database system is nothing but a computer 
based record keeping system. On a database we can perform database management. The 
management operation includes: 

• Creating the structure of the table 
• Adding new data to the database 
• Modifying the existing data of the database 
• Updating the existing data of the database 
• Deleting the data from the database 
• Searching for data in the database 
• Editing the data in the database 
• Sorting the data in the database 
• Printing the data from the database 
• Listing the data from the database 

 The dBASE III Plus is a Data Base Management System for Micro Computers developed 
by ASHTON-TATE, USA. 

11.9 FEATURES OF DBASE III PLUS:   

 The dBASE III Plus has many special features. 

• All the instructions in dBASE are in the form of commands. These commands are 
English like commands. 

• The commands are powerful and flexible. 
• It can be used to create and manage small and medium size databases. 
• It can be used to develop business, financial, inventory and other applications etc. 
• It can support Networking and it can also be used on a Local Area Network (LAN) where 

several persons work simultaneously on different computers. 

 Data Base Management means maintenance of records and information. This is a 
computer based management and organized collection of related information. The data can be 
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managed in the computers in the desired form or formats. The information in a data base can 
be stored column wise (fields) or row-wise (records). 

     Field No. 1  2      3 

     Name   Address  Phone 
   Record 1    Sunil   47-D, Chandigarh 613083 
   Record 2    Pratiek   1012, Palsora  640642 

11.10 DEALING WITH FILES IN DBASE: 

 You have to handle various types of files including employees files and records. Let us 
consider the following example containing detail pertaining to employees for our further study. 

   1. Name of the Employee 
   2. Date of Birth 
   3. Father's Name 
   4. Date of Appointment 
   5. Place of Posting 
   6. Basic Pay 
   7. Educational Qualifications 
   8. Professional Qualifications 
   9. Male/Female (M/F) 
   10. SC/ST/Gen. 

 The date of permanent nature is stored in one file and the data of variable nature is stored 
in another file. The former is called Master File and the latter as Transaction File. 

Fields Structure 

 It is specified what fields will constitute a record. The number of fields in a record depends 
upon the choice of the user. It will be better to allot a certain code number to each employee to 
avoid typing lengthy names/ data. The simplest method of coding is to give running serial 
number like 1, 2, 3, .... 

11.11 SELF ASSESSMENT QUESTIONS: 

1. Explain the concept of data base? 
2. What are the approaches to data base management? Explain 
3. Explain the Data base management system? 
4. What are the uses of data base system? 
5. Explain the features of Dbase III plus? 

11.12 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 
2. Al.Stevens    : Disk Operating System, BPB 
3. T.D. Malhotra    : Business Data Processing Systems, K.P 
4. Mandova, N Prasad Rao  : Dosware 
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LESSON -  12 

CREATION OF DATABASE FILES 
12.0 OBJECTIVE:  

 To know how to create, open and close the data base files in Dbase III Plus. 

STRUCTURE 

12.1 Introduction 

12.2 Create a database 

12.3 Data types in dbase 

12.4 Opening a database 

12.5 Closing the database 

12.6 Structure of a database 

12.7 Add new records to the database 

12.8 Self Assessment Questions  

12.9 References  

12.1 INTRODUCTION: 

 In order to create a database in any DBMS package, first analyze the requirements for 
database and afterwards design the database fields. Also identify the primary key and other key 
attributes; we must also take care regarding the width of the field so that we can eliminate 
wastage of memory space. 

12.2 CREATE A DATABASE: 

 The following are the steps to create a database in dBASE III plus. 

 1) CREATE command is used to create a database in dBASE. 

  After entering into dBase, issue the CREATE command at the dot prompt. 

 Syntax :  

  CREATE 
     (OR)  
  CREATE filename  
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 Ex :  . CREATE INVENTORY 

 2) After typing the CREATE command the dBase displays a screen for the following : 

  a) Name of the field 
  b) Type of the field 
  c) Width of the field 
  d) Width of the decimal part for number type fields 

 3) Enter the Name of the field, Type of the field, width for each field of the database. 

FIELD NAME:  The field name should not exceed 10 characters. It can start with any 
alphabet and it may contain numbers, underscores. But spaces and special symbols are not 
allowed. 

12.3 DATA TYPES IN DBASE: 

 The dBASE supports 5 different types of data types: 

  1) Character 
  2) Numeric 
  3) Date 
  4) Memo 
  5) Logical 

1) Character : The character field can store all printable characters. The width of a character 
field can be 1 to 254 character long. 

2) Numeric : The numeric field can hold only numeric data. A numeric field can be upto 19 
digit wide. It can also have decimal part. 

3) Date : It is used to store dates. The dates are stored in a specific format in the database file 
i.e. MM/DD/YY. We can retrieve it in British format i.e. DD/MM/YY. 

4) Memo : The Memo field is a special field where we can store data upto 5000 (or even more) 
characters. This is particularly useful for storing long text of information. The data is stored in 
the memo field is not stored in the database file but in an auxiliary database file with the same 
name but with extension ".dbt" (database text). 

5) Logical : The logical field is a special one byte field which is used to store either T (for true) 
or F (for false). 

 The dBASE supports 5 different data types. 

  Sl.No. Type  Character to be pressed to specify type  

  1 Character C 
  2 Numeric N 
  3 Logical L 
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  4 Date D 
  5 Memo M 

 We can press space bar to view the data types. The default date format will be mm/dd/yy. 

WIDTH :   For any type there is a maximum limit. The width of the field means size of the 
field. The size of the record means sum of widths of the field. The following table illustrates the 
maximum limit for each data type : 

   Type   Maximum Limit 

 Character 254 
 Numeric 19 (including decimal) 
 Logical 1 
 Date 8 (No need to enter) 
 Memo Upto 5000 

 DEC:  This option is activated only for Numeric type of fields. 

  In dBASE, the database can have upto 128 fields. 

Ex : After issuing the CREATE command type the following : 

 

 After entering the fields, types, widths and decimals press to save and enter the data. 
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12.4 OPENING A DATABASE: 

 In order to execute the commands on a particular database to retrieve, edit, delete, 
update the data, the database must be in use. To open the database, the USE command 
followed by a database filename-is used. 

 a) Opening a database in default drive and current directory:  

  . USE < filename >  
 Ex:  .USE STUDENT 

 b) Opening the database with an index file : 

  . USE <filename> INDEX <index-name>  

 Ex :  Assume that the database STUDENT is indexed on HTNO field with filename 
INDHTNO 

  . USE STUDENT INDEX INDHTNO 

 c) Opening the database with specified drive and directory: 

  . USE [drive:\] [path] <filename> 

 Ex : USE C:\DBASE\STUDENT 

 d) Opening the database with specified drive path, with index file : 

  . USE [drive:\] [path] <filename> INDEX < index-name>  
  . USE C:\DBASE\STUDENT INDEX INDHTNO.  

12.5 CLOSING THE DATABASE:  

 The CLOSE command is used to close the database. 

 a) Closing all files:   The command CLOSE ALL is used to close all opened files. 

 b) Closing the database files: The command CLOSE DATABASES is used to 
close only database files i.e. .dbf files. 

 c) Closing Index files only :  The command CLOSE INDEX closes the index files 
i.e., .index file only. 

 d) Closing procedure files : The command CLOSE PROCEDURE closes the 
procedure files  i.e. .Prg files containing the procedures only. 
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12.6 STRUCTURE OF A DATABASE:   

 The structure of database is nothing but the collection of field names, field type, and field 
width.  The collection of fields is a record and inturn collection of records is called a Database.  
dBASE supports upto a minimum of 128 fields. 

Creation of the Structure: 

  The CREATE command is used to create the structure of the database. 

  General Form: 

  CREATE   <file name> 
   [FROM <file name>] 
  where   <file name>  is saved with .dbf extension. 

 Ex:  CREATE INVENTORY 

 

 Viewing the structure: 

  The DISPLAY STRUCTURE command can be used to view the structure. 

 General Form: 

  .  USE <file name> 
  .  DISPLAY STRUCTURE [TO PRINT] 
 Ex: .  USE STUDENT 
  .   DISPLAY STRUCTURE 
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Modify the structure of database: 

  The MODIFY STRUCTURE command is used to modify the already existing 
database structure. 

 General form: 

  .  USE <file name> 
  .  MODIFY STRUCTURE 
 Ex: .  USE INVENTORY 
  .  MODIFY STRUCTURE 

12.7 ADD NEW RECORDS TO THE DATABASE: 

The following are the different ways a new record can be added to the database. 

 a) By using APPEND command :   The APPEND command can be used to add 
records to the database in use. The command can be used in both programs as well as from 
dot prompt. 

  APPEND : 

 When this command is executed a screen is displayed with field names and record 
number.  

 APPEND BLANK : 

 This command adds a blank record at the bottom of the database.  

 APPEND FROM <filename> : 

 This command Adds records from other database file.  
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 APPEND FROM <filename> FOR <condition> : 

 This command adds all records which satisfies the < condition > from another database 
file. 

 b) By using BROWSE command :   After issuing the BROWSE command without 
NO APPEND option, we can add new records to the database. Move cursor to last record and 
press down arrow key, then dBASE will prompt "Add new record (Y/N)". Press 0 to add new 
record. 

 c) By using INSERT command :   It is similar to the APPEND except it adds the 
new records after the current record instead of bottom. 

 INSERT BLANK : This command adds a blank record immediately after the current 
record. 

 INSERT BEFORE : This command adds a new record before the current record. 

 

12.8 SELF ASSESSMENT QUESTIONS: 
1. How to create a database file in Dbase III Plus? 
2. Explain the various data types in Dbase III Plus? 
3. How to opening a database file in Dbase III Plus? 
4. Procedure to closing the database file in Dbase III Plus? 

 5. How to add new records to the database? 
 6. What is a structure? How to Create, View, and Modify the structure? 

  

12.9 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 
2. Al.Stevens    : Disk Operating System, BPB 
3. T.D. Malhotra    : Business Data Processing Systems, K.P 
4. Mandova, N Prasad Rao  : Dosware 
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LESSON - 13 

SEARCHING FOR FILES AND RECORDS 
13.0 OBJECTIVE: 

 Learn how to search the files and records in dbase III Plus. 

STRUCTURE 

13.1 Searching  

13.1.1 Locate  

13.1.2 Find and seek 

13.2 Differences between locate and find/seek. 

13.3 Viewing the records in a database 

13.3.1 List command  

13.3.2 Display command  

13.4 Self Assessment Questions 

13.5 References 

13.1 SEARCHING: 

 Finding for a record(s) in the database with the specified condition in dBase III PLUS we 
can perform searching .or a record on a database using the following commands: 

  i) LOCATE command 
  ii) FIND or SEEK commands 

13.1.1 LOCATE Command: This command is used to search for a record(s) sequentially in 
a database which satisfies the specified condition.  

 Syntax: 

  . USE < filename > 
  . LOCATE FOR < condition > 
  Where < condition > can be any simple condition  
     or any compound condition  

 Ex :  Let us search for a record in ADRLIST.dbf whose NAME is Raj. 
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  First we have to open the database 

  . USE ADRLIST 

  Search the record(s) whose NAME field starts with "Raj"  

 . LOCATE FOR NAME = "Raj"  

 Record = 2 

 When the above command is given if it finds the record, it displays the record number. 

 We can view the located record using the DISPLAY command.  

 . DISPLAY 

  Record # NAME   LOCALITY     CITY PIN 
      2 Rajinder       G-232, Naraina New Delhi 110028 
  We can search for the next record(s) after the first encountered record by using 
CONTINUE command.  

  .CONTINUE  
  . Record = 4 

 Now it has shown the next Record  

  . DISPLAY 

  Record #   NAME     LOCALITY CITY           PIN 
        4          Raj Kumar       12/34, Golf Links   New Delhi     110003 
  Still if we want to view the more records which satisfies the condition, enter 
CONTINUE command. 

  .  CONTINUE 
  End of LOCATE scope 

  If no records are present, which satisfies the specified condition, then we will get 
message "End of LOCATE scope". 

  We can also use Multiple conditions using logical operators .AND.. .OR., .NOT. 

  . LOCATE FOR NAME = "Raj" .AND. PIN = "110003"  

 The above command searches for the NAME = "Raj" and PIN = "110003" 

  . LOCATE FOR PIN = "110003" .OR. CITY = "Delhi"  

 The above command searches for the records PIN = "110003" or CITY - "Delhi" 
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13.1.2 SEARCHING AN INDEXED FILE (FIND/SEEK COMMANDS)  

a) FIND 

  If the database is indexed on a field that contains the information to be Searched, It 
Is very simple to find the information in a matter of seconds with find command. With an indexed 
file, dBase knows where to look for the infoi mation and the record pointer will point to that 
particular record. 

 Let us create an Index file INDNAME on field NAME for the STUDENT database file. 

  . USE STUDENT 
  .  INDEX ON NAME TO INDNAME 

  Now,  let us try to find out “James Robert” in this file.  The commands are 

  .  USE STUDENT INDEX INDNAME 
  .  FIND James Robert 

  If search is success, it will display the lecord that contains James Robert in the 
NAME field and makes the record pointer to point to a particular record. If it is not found, it 
displays a "No find" message. 

  Once a record has been found, Edit, Display, Replace or any other command can 
be used,  

b) SEEK:  

  The SEEK command is quite similar to FIND command and is used  to search for 
information in an indexed database file.  

  .  USE STUDENT INDEX INDNAME  
  . STORE "James Robert" TO XNAME  
  . SEEK XNAM E  Looks for contents of the XNAME  

  dBASE Ill+ displays the dot in response to the SEEK command,  indicating that it 
has found the information. 

  The difference between the SEEK and FIND command is that the SEEK command 
looks for contents (specified) of a variable in the database file. 

  SEEK XNAME  looks for contents of the XNAME  
  FIND XNAME  tries to search the word XNAME in the database file. 

13.2 DIFFERENCES BETWEEN LOCATE, FIND/SEEK 

   LOCATE    FIND/SEEK 

1. Locate command can be 1. FIND/SEEK commands can he 

 use to search the file opened  used to search the data is indexed 

 with or without the index file.  files only 
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2. Locate command can be 2. FIND/SEEK commands can be 

 used to search data with  used to search for data corresponding 

 respect to any field.  to only the field on which the file is  

   indexed. 

3. The LOCATE command is 3. These commands use the binary 

 slower as it uses linear search.  search technique, so the time 

   required lor searching is less 

4. If the record is not present 4. If the record is not present the 

 the LOCATE command will  1 INI) and SEEK command give 

 take more time as it has to  the NO FIND message with in 

 search from first to last record.  a small time. 

5. LOCATE command is used 5. The FIND and SEEK commands 

 for both equality and non-  can be used only for equality 

 equality conditions.  conditions. 

6. Complex conditions can also 6. Complex conditions cannot be 

 used in LOCATE command.  used in SEEK and FIND commands. 

    

13.3 VIEWING THE RECORDS IN A DATABASE: 

 In dBase records can be viewed by using two commands. 

  a) LIST 
  b) DISPLAY 

13.3.1  LIST command:   This command lists all the records in scrolled manner with their 
record numbers. 

  . USE < filename >  
  .LIST 
  Ex:  .USE STUDENT  
  . LIST 

 It displays all records along with their record numbers. 
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It has different options. The options are given in the following tabular form: 

 

 

 The following are some commands with optional clauses of LIST command. 
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Viewing selected fields: 

   . USE STUDENT  
   . LIST HTNO, NAME 

 This command lists all records with selected fields HTNO, NAME Viewing the records 
without record numbers : 

   .USE STUDENT  
   . LIST OFF 

 This command lists all records without their record numbers. 

   . USE STUDENT 
   . LIST OFF HTNO, NAME 

 This command lists all records with selected fields HTNO, NAME without their record 
numbers. Viewing the records using condition : 

   .USE STUDENT 
   . LIST FOR HTNO >= 300 

 This command lists all records whose HTNO > = 300 

 We can use the Arithmetic operators like <,<>,#,< = ,> = ,$ and logical operators like 
.NOT, .AND., .OR., .T, .F. 

13.3.2 DISPLAY command: This command displays only one record which is at the 
currently pointed by the record pointer. 

   . USE < filename > 
   . DISPLAY 
 Ex:  .USE STUDENT 
  . DISPLAY 

  This command displays the only current record. 

 a) .USESTUDENT 
  . DISPLAY OFF 

  This command displays single record without its record number. 

 b) .USESTUDENT 
  . DISPLAY HTNO: NAME 

  This command displays the current record with selected fields 

 c) .  USE STUDENT 
  . DISPLAY TO PRINT 

  This command is used to print the current record on the printer. 
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13.4 SELF ASSESSMENT QUESTIONS: 

1) What is searching? 

2) Explain how to search for a record in database with example. 

3) Explain the differences between LOCATE and  FIND/SEEK? 

4) Briefly discuss about viewing commands in dBase? 

5) Explain the LIST commands with their different options? 

6) Explain the DISPLAY commands with their different options? 

 

13.5 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 

2. Al.Stevens    : Disk Operating System, BPB 

3. T.D. Malhotra    : Business Data Processing Systems, K.P 

4. Mandova, N Prasad Rao  : Dosware 
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LESSON - 14 

EDITING THE FILES IN DATABASE 
14.0 OBJECTIVE:  

 To know the files editing options in dbase III Plus 

STRUCTURE  

14.1 Editing the records in a database: 

 14.1.1 EDIT command 

 14.1.2 BROWSE command 

14.2 Deletion of a Record 

   14.2.1 DELETE Command 

  14.2.2 PACK Command 

  14.2.3 ZAP Command 

  14.2.4 RECALL Command 

14.3 Self Assessment Questions 

14.4 References 

14.1 EDITING THE RECORDS IN A DATABASE: 

 In dBase records can be editing by using two commands. 

  i) EDIT 
  ii) BROWSE 

14.1.1 EDIT COMMAND:  The Edit command is used to change the content of one or more 
records in a database. Before using the EDIT command, the database must be in USE.  

  The syntax for EDIT command is  
  USE <file name>    
  EDIT [<scope >] [FIELDS <field names>]  
   [WHILE < condition >]  
   [FOR < condition >]  

  Where    <scope > is one of the dBASE scope commands like  
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   RECORDS, NEXT, ALL, REST  

  <field name> is the name of the field  

  < condition > is any valid query condition  

The following are the different EDIT commands:  

a)   EDIT : This command displays the current record 

  

We can delete the current record by using Ctrl + V 

 After editing press Ctrl + W  to save and exit. 

b) EDIT <record number> : This command is used to edit the particular record if we know 
the record number. 

 Ex:     USE STUDENT   .  USE STUDENT 
  EDIT 5   [OR]         GOTO 5 
        .   EDIT 
  The above command edits the 5th record in STUDENT database. 

c) Editing with a condition:   We can edit the records which satisfies the specified 
condition. 

  EDIT  FOR < condition >  
  Ex:   .USE STUDENT  
   . EDIT FOR HTNO > = 200 
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  The above command edit all records in which HTNO > = 200 

 We can also use compound condition by using logical operators like .NOT, .AND., .OR.  

  Ex :  . USE INVENTORY 
   . EDIT FOR QUANTITY >== 200 .AND. STATUS = .T 

 The above command edit all records whose QUANTITY > = 200 and STATUS is true. 

  The other option for condition is 

   EDIT WHILE < condition >  
  Ex :   . USE INVENTORY 
   . EDIT WHILE QUANTITY >= 200 

 The above command edit the records. While the QUANTITY is greater than or equal to 
200. 

d) Editing the selected fields:   We can edit the selected field instead  of all fields. 

  EDIT FIELDS <fieldl>, <field2>, <field3>.... Ex:   . USE INVENTORY 
   . EDIT FIELDS ITEMNAME, QUANTITY, STATUS 
    FOR QUANTITY > = 200  

 Edits the selected tields ITEMNAME, QUANTITY, STATUS all records which satisfies the 
condition QUANTITY > = 200 

14.1.2 BROWSE COMMAND: 

 BROWSE is a special editing command. The EDIT command displays only one record at 
a time, whereas the BROWSE command displays a screen full of information. dBase will show  
up to 20 records in different rows on the screen. With the help of the cursor we can move within 
the same record, or within different records and carry out the changes. Thus, BROWSE helps in 
making quick changes in the database file. 

 Typing BROWSE command from the dBase dot prompt displays the database and an 
editing screen is displayed. 

  . USE STUDENT 
  . BROWSE 
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  We can make the help window ON/OFF display by using  key. 

  We can set the options using menu bar. It can be displayed at the top of the screen 
using key combination Ctrl + HOME or F10   The menu bar has the options as follows : 

  Bottom Top Lock    Record No.     Freeze 

 Bottom :   This option moves the record pointer to the last record of the database. 

 Top :    This option moves the record pointer to the first record. 

 Lock :    Locks the left-most fields on the display for reference purpose. You are prompted 
to "change number of columns to lock to". 

 Record No : It moves the cursor to the selected record number. Here the "Enter new 
record number" is prompted. 

 Freeze :   It restricts the browse to edit the selected field. Here "Enter field name to 
freeze" is displayed. 

   The BROWSE command is used for editing the multiple records at the same time 
and also for the addition, deletion of records also. The following are the examples of the 
optional clauses with BROWSE. 

 a) Editing selected fields with BROWSE:   To view and to edit only the selected 
fields, we can specify the field names with the BROWSE command. 

 Ex:    .USE STUDENT 
  . BROWSE FIELDS HTNO, NAME 

 b) Reducing the field width :   Another important and very useful feature of the 
BROWSE command is to limit the width of the displayed field. This is achieved by using the 
WIDTH option. 
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 Ex:  .USE STUDENT 
  .BROWSE WIDTH 8  
  .USE STUDENT 
  . BROWSE FIELDS HTNO, NAME WIDTH 10  

 The other options with BROWSE command are  

 NO MENU: Makes the BROWSE command not to display the help window  

 NO APPEND:  It makes the BROWSE command not to add the new records to the 
database. That means it disables the prompt Add new records? (Y/N) 

 LOCK n :  It locks the n fields on the screen 

 FREEZE < fieldname >: It restricts the editing the < fieldname > 

14.2 DELETION OF A RECORD:  

 We can delete the unwanted records from the database in dBASE. dBASE supports two 
types of record deletion. 

 i) Temporary deletion of record 
 ii) Permanent deletion of record 

  In order to delete the records permanently first it has to be deleted temporarily. We 
can recall that deleted record when it is deleted temporarily. Once the record is deleted 
permanently it cannot be recalled.  

14.2.1 DELETE Command: 

  To delete the record temporarily the DELETE command is used. When the records 
are deleted using DELETE command, then the DELETE command marks the records to be 
deleted with" * ". The" * “indicates that the record is deleted temporarily. The " * " marked 
records can be viewed using the LIST or DISPLAY command.  

 General format of DELETE command : 

  i) DELETE [< scope >] 
    [FOR < condition >]  
    [WHILE < condition >]  
   (OR) 
  ii) DELETE RECORD <expression> 
   (OR) 
  iii) DELETE NEXT < expression > 
   (OR)  
  iv) DELETE ALL 
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 a) Deleting records with record numbers :  

  The records can be deleted if we know the record number of a record to be deleted.  

   . USE < filename > 
   . DELETE RECORD < expression >  
 Ex:    .USE STUDENT 
   . DELETE RECORD 3  

 This command will delete the record whose record number is 3.    J 

 b) Deleting the current record :   

  We can delete the record which is currently pointed by the record pointer. 

   .USE STUDENT 
   . DELETE 

  This command deletes the current record. 

 c) Deleting record with a condition :  

  The records which satisfies the specified condition can be deleted. 

   . USE < filename > . DELETE FOR < condition > (OR) 
   . DELETE WHILE < condition > 

  Where <condition> can be simple condition or compound condition.  Condition may 
contain relational operators, like <, > = , < = , <>, = , > and logical operators like .NOT, .AND., 
OR.  

 Ex : i) . USE STUDENT 
   . DELETE FOR TOT < 35 

 This command deletes all records (i.e. marks with " * ") whose TOT field contains < 35. 

  ii) .USESTUDENT 
   . DELETE FOR (Ml < 35) .AND. (M2 < 35) .AND. (M3 < 35)  

  This command deletes all records whose Ml, M2, M3 fields contain < 35. 

  iii) .USESTUDENT 
   . DELETE WHILE TOT < 35 

  The above command deletes the records as long as TOT < 35. 

 d) Deleting all records from database :    

  At a single command we  can delete all the records in the database temporarily. 

   . USE < filename >  
   . DELETE ALL  
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 Ex:  .USE STUDENT 
  .  DELETE ALL 

  This above command deletes all records from the student database temporarily. 

14.2.2 PACK Command: 

   The PACK command is used to delete the records permanently. The PACK 
command delete the “*” marked record (i.e. temporarily deleted records) permanently. 

  . USE < filename >  
  . PACK  
 Ex : i)  . USE STUDENT 
   . DELETE FOR TOT < 35  
   . PACK 

  The above PACK command deletes all records whose TOT field contains < 35 
permanently. 

  ii)   .  USE STUDENT  
   . DELETE ALL  
   . PACK 

  The above command deletes all the records from the STUDENT database 
permanently. 

14.2.3 ZAP Command:  

 dBase III PLUS supports another command to clear (delete) all the records from the 
database. The command is ZAP 

  .USE STUDENT 
  .ZAP 

14.2.4 RECALL Command : 

  The DELETE command does not physically remove the records, and hence it is 
possible to undelete them through the RECALL command. RECALL is used in the same way as 
DELETE. We can use the RECALL in the following ways. 

 i) . USE STUDENT    . USE STUDENT 
  . GOTO 3   (OR)      . RECALL RECORD 3 
  .  RECALL 
  If the third record was marked deletion, dBASE recalls it. 
 ii) .USESTUDENT 
  .RECALL NEXT 5 

  This command recalls the first 5 records. 
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 iii) .USESTUDENT 
  .RECALL ALL 

  This command will recall all the records marked for deletion in the database. 

 iv) .USE STUDENT 
  . RECALL ALL FOR TOT < 35 

  This command recalls all the records marked for deletion whose TOT < 35 

14.3 SELF ASSESSMENT QUESTIONS: 

1. Explain the commands available for the deletion of the records in dBase? 

2. Briefly explain the editing commands in dBase? 

3. How to recall the temporarily deleted records? 

4. Explain the following commands: 

   a) DELETE    b) PACK      c) ZAP  d)RECALL 

5. Explain the EDIT commands with their different options? 

6. Explain the BROWSE commands with their different options? 

 

14.4 REFERENCES:  

1. Simpson    : Understanding of Dbase III Plus, BPB 

2. Al.Stevens   : Disk Operating System, BPB 

3. T.D. Malhotra   : Business Data Processing Systems, K.P 

4. Mandova, N Prasad Rao : Dosware 
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LESSON - 15 

SORTING AND INDEXING IN DBASE III PLUS 
15.0 OBJECTIVE: 

 To know the sorting and indexing process in dBase III Plus. 

STRUCTURE 

15.1 Sorting  

15.2 Sorting command options 

15.3 Disadvantage of sorting 

15.4 Sort in sort 

15.5 Indexing 

15.6 Indexing command options 

15.7 Indexing on multiple fields 

15.8 Difference between sorting and indexing 

15.9 Self Assessment Questions  

15.10 References 

15.1 SORTING:  

 Sorting is the process of arranging the information in Ascending order or Descending 
order. SORT command is used to arrange the records in ascending or descending order. 

 SORT command in dBase creates another database file that has; the same structure as 
that of the database file being sorted. It sorts the ' records in the required order and then writes 
the results in the new database file. 

15.2 SORTING COMMAND OPTIONS: 

 The SORT command can be used to sort the records on Character, Numeric or Date 
fields. Sorting can be done on single or on multiple fields.  

 Syntax : 

  . USE <file Name to be sorted > 
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  . SORT To <new file> ON Keyl [/D], Key2 [/D]....  

 Ex : a) On Single field 

 i) Let us sort the STUDENT data base file on the NAME field in ascending order and 
store the sorted data in a new file NAMELIST 

  .USE STUDENT 
  . SORT ON NAME TO NAMELIST .USE NAMELIST . LIST 
 ii) . USE STUDENT 
  . SORT ON TOT/D TO RESULT  

 b) On Multiple fields  

  .  USE STUDENT 
  .  SORT TO RESULT ON TOT/D, MATHS/D, PHY/D|CHEM/D, DOB 

15.3 DISADVANTAGE OF SORTING: 

  First, it requires vacant space on the disk that should be atleast equal to the size of 
the original database file. Therefore, the maximum size of a database file that can be sorted is 
only half the disk area. Secondly, sorting is a slow and time consuming process. 

1) In applications, where sorting the original file has created many files, if any change is made 
to the original file, this is not automatically carried over to the other files. 

2) The searching from sorted file is sequential, so it needs much time. 

15.4 SORT IN SORT: 

  When a table is to be sorted on more than one field or on multiple fields, you have 
to specify the fields on which the table is to be sorted.  First the records are sorted basing on 
the first field and the resultant record order is sorted basing on the second field in the specified 
order i.e. Ascending or Descending order 

  Sorting of records on multiple columns is called Sort in Sort. It can be performed by 
both Sort and Index commands.  

 Sort in Sort by SORT command/Sort on Multiple fields : 

  . USE STUDENT 
  . SORT TO RESULT ON TOT/D, MATHS/D, PHY/D, CHEM/D, DOB 

 Sort in Sort by INDEX command/Indexing on multiple fields : 

  Indexing can also be done on multiple fields. Let us create an index Me loi STU1 
WENT database file on the fields HTNO, NAME. .USE STUDENT 

  . INDEX ON NAME + STR (HTNO, 5) TO IND1 . LIST 
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15.5 INDEXING: 

 The INDEX command is an alternative to SORT command and is used to sort the data in 
the desired order. Indexing does not create another database file, but creates an index file. The 
information is stored in the index file in a way that is quite similar to the index used at the end of 
a text book, where words arranged in an alphabetical order and the page number. 

  The extension of Index file in dBase III -4- is .NDX. The following are the three 
advantages of Index files over sorting. 

 1) Index files are small 

 2) Index files are automatically updated when the information is changed, added or 
deleted in the database file. 

15.6 INDEXING COMMAND OPTIONS: 

 Amount of time required to query the database is less.  

 Ex : Let us create an Index file for the STUDENT database file on the NAME field. 

  . USE STUDENT 
  . INDEX ON NAME TO INDNAME 
  . USE STUDENT INDEX INDNAME .LIST 

  It will arrange all the Names in an alphabetical order and write them in the index file. 
It also write the record number against each name, where the name can be found in the 
STUDENT database file. 

  The Indexing does not duplicate the entire database file and the Index file is smaller 
than the original database file. 

  We can create as many index files as needed (on different fields). Again we can 
create Index file for the STUDENT database file on the HTNO field. 

  .USE STUDENT 
  . INDEX ON HTNO TO INDHTNO  
  . LIST 

1) A database file can be indexed on Character, Date or Numeric fields or a 
combination of all of these fields. But Indexing is not possible on Memo or Logical fields. 
2) Indexing is always done in the ascending order. 
3) Upto 7 Index files can be active with a database file. 
4) Indexed fields must be converted to character data type.  

15.7 INDEXING ON MULTIPLE FIELDS:   

  Indexing can also be done on multiple fields. Let us create an Index file for 
STUDENT database file on the fields HTNO, NAME  
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 .USE STUDENT 
  . INDEX ON NAME + STR (HTNO, 5) TO IND1  
  .LIST 

15.8 DIFFERENCE BETWEEN SORTING AND INDEXING:  

  SORTING    INDEXING 

 1) Sorting sorts a database file 1) Indexing creates only an Index 
  and creates a new data  table which occupies very less 
  base file which contains all  space. 
  records and occupies the   
  same space as that of the   
  original file.   
 2) In the sorted file, the 2) In an Indexing process no 
  record numbers are modi-  record numbers are modified. 
  fied from that of the   
  original file.   
 3) Sorting is the time con- 3) Index files are automatically 
  suming process. Especially  updated when the data is 
  when data is changed,  changed, added or deleted in 
  added or deleted in the  the original database file. 
  file, the entire data is to   
  be sorted again.   
 4) In sorted file, only linear 4) When an index file is available 
  search is permitted with a  then Random access is possible 
  command LOCATE.  with the commands SEEK and 
           Find 

15.9 SELF ASSESSMENT  QUESTIONS: 

 1) What is sorting? Explain the commands for sorting in dBase? 
 2) Explain the concept of Sort within Sort? 
 3) What are the disadvantages of sorting? 
 4) What is Indexing? Explain the commands for Indexing in dBase? 
 5) Explain the differences between Sorting and Indexing? 

 15.10 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 
2. Al.Stevens    : Disk Operating System, BPB 
3. T.D. Malhotra    : Business Data Processing Systems, K.P 
4. Mandova, N Prasad Rao  : Dosware 
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LESSON - 16 

CREATION OF LABELS IN DBASE III PLUS 
16.0 OBJECTIVE: 

  Learn how to prepare a report in dbase III Plus 

STRUCTURE 

16.1 Introduction 

16.2 Creation of label 

16.3 Modification of label format 

16.4 Printing of label format 

16.5 Self Assessment Questions 

16.6 References 

16.1 INTRODUCTION: 

 DBase II PLUS offers a very useful facility for printing of "Mailing Address Labels" from 
any database file. The mailing labels are useful for bulk mailing labels. This is achieved by 
creating and using a label formal file (file with .Ibl extension). Let us create a ADRL1ST.DBF file 
with the following structure 

  File Name: ADRL1ST.DBF 
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16.2 CREATION OF LABEL: 

 The command for creating (designing) label is CREATE LABEL.  

 Syntax : 

  . USE < filename > 
  . CREATE LABEL < label file> 

 Where < filename > is the database file from where the data is present 

  < label file> is used to store label format  

 Ex:  . USE ADRLIST 
  . CREATE LABEL ADDRESS 

 Where the ADDRESS is used to -store the label format with extension  .ibl 

 When the command is executed, then the Label menu is displayed. 

 This menu contains the following menus. 

  a)  Options 
  b)  Contents 
  c)  Exit 

 a)  Options Menu: 

 

 

 Initially this menu is activated. This menu contains 6 options related to properties of the 
label. 



 
 
Business Data Processing Systems   16.3  Creation of Labels in DBASE    
 

  

  label width  specifies the label width 
  label height specifies the label height 
  left margin   specifies the left margin of the paper 
  Lines between labels   Specifies the number of lines to be 
  left between the labels Spaces between labels -" Specifies the spaces between the 
labels 

  Labels across page  Specifies the number of labels across the page 

 Ex : Set the options for the ADDRESS.Ibl 

 

 b) Contents menu : 

  After entering the values in options menu, press Right arrow key to go to the 
contents menu. The contents menu is displayed with 5 options and "Label contents 1" is 
highlighted. 
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The following are the steps to specify the label fields. 

 1) Select the "Label contents 1" and press Enter key. 
 2) Type the field Name and press Enter key. 
 3) Repeat the steps 1, 2 for all the fields. 

 Ex : Enter the options as follows in the contents menu. 

 

  

 c) Exit menu :  After specifying the label format, select the Exii menu to save and exit the 
label format file. The Exit menu contains 2 options. 

  Save   To save the .Ibl file and exit label menu 
  Abondon   To unsave the .Ibl file format and exit from label menu  

 Ex:   Select the save option then Label menu is closed 

16.3 MODIFICATION OF LABEL FORMAT: 

 To modify existing label formal the command MODIFY LABEL is used 

   . USE <file name> 
   . MODIFY L ABEL <label file> 

  Then the label menu is opened with specified label format present in  <label file> 

 Ex :   .  USE ADRLIST 
  .  MODIFY LABEL ADDRESS   

16.4 PRINTING OF LABEL FORMAT: 

 To print the Labels on the printer of specified label format the command LABEL FORM 
command is used.  
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Syntax: 

  LABEL FORM <label file>  [SAMPLE] 
  [WHILE  <condition>] 
  [FOR <condition>] 
  [TO PRINT] 
  [TO FILE <text file name>] 

  Where   < label file> is the label format file 

   <condition > is any simple/compound condition  
   <text file name> is the text file name  

 Ex: i)  . USE ADRLIST 

LABEL FORM ADDRESS TO PRINT  

  The above command prints all labels on the printer. 

  ii) . USE ADRL1ST 
  . LABEL FORM ADDRESS FOR PIN = "110029" TO PRINT  

  The above command prints all labels whose PIN is equal to 110029 

  iii) . USE ADRLIST 
   . LABEL FORM ADDRESS TO TEXTTXT 

  The above command sends all labels to the text file TEXTTXT 

16.5 SELF ASSESSMENT QUESTIONS: 

1.  Explain how lo create the label In dBase III Plus with example? 

2.  Explain how lo modify the label In dBase III Plus with example? 

3.  Explain how lo print the label In dBase III Plus with example? 

16.6 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 

2. Al.Stevens    : Disk Operating System, BPB 

3. T.D. Malhotra    : Business Data Processing Systems, K.P 

4. Mandova, N Prasad Rao  : Dosware 
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LESSON - 17  

CREATION OF REPORTS IN DBASE III PLUS 
17.0 OBJECTIVE: 

 Learn how to prepare a report in dbase III Plus 

STRUCTURE 

17.1 Introduction 

17.2 Creation of Reports  

17.3 Execution of Report Form File 

17.4 Modification of Reports format 

17.5 Printing of Reports format 

17.6 Self Assessment Questions 

17.7 References 

17.1 INTRODUCTION: 

 dBASE III + has a facility of designing and printing the formatted report. It has the 
following features: 

 A report title of maximum 60 characters and 4 lines in height can be specified and 
printed on each page of report along with page number. 

 Any number of columns can be specified and each column can have a column heading 
(maximum of 4 lines in height). The column width can be different from the field width. 

 Automatic totaling of numeric fields can be done. 

 The size of report i.e., the length and width, left and right margins, double spacing or not, 
page number, date and ejection of page before and after printing the report can be 
specified. 

 A report can be grouped and sub-grouped, sub-totals and sub-sub-totals can be printed. 

 A report can be used with more than one database file. 
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17.2 CREATING A REPORT FORMAT: 

 In order to create a report format the command CREATE REPORT command is used. 
Before issuing this command the database file from where the report is to be generated must be 
in use. 

  . USE < filename > 
  . CREATE REPORT < filename > 

 The report created is saved with .frm extension. After issuing the CREATE REPORT 
command, a screen is displayed for designing the report with different options. 

 The following menus appears on the top of the screen with different options. 

  Options        Groups       Columns       Locate          Exit 

 Initially, options are highlighted and corresponding pull-down menu is displayed. The 
lower part of the screen displays Edit Menu, the status bar, navigation and message lines. 
Options: 

 This menu contains the choices for page settings, number of lines per page, single/double 
spacing, page width, margin setting, page ejection etc. as shown below : 
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Groups : 

 This menu contains the choices to specify grouping, sub-grouping the re] >ort format. 
Before using this menu, the database file must be indexed/ sorted on the corresponding field.  

  GROUP ON EXPRESSION 
  GROUP HEADING  
  SUMMARY REPORT ONLY  
  SUB-GROUP ON EXPRESSION 

 

This menu is used to specify the columns, column headings, width and decimal places. 

 COLUMNS field name   :determines the Name of the field 
 HEADING    :determine the column Heading 
 WIDTH default field width  :determines the size of column  
 DECIMAL PALCES default decimal places: used only for Numeric Values 
 TOTAL THIS COLUMN YES/NO : Used only for Numeric Values 
 Exit: It is used to save and close the Report Format. 

17.3 EXECUTION OF REPORT FORM FILE: 

 After creating the report form file,  it can be executed.  After execution the report can be 
displayed on the screen or printed on printer, or redirected to a file. 

 The command REPORT FORM is used to execute the report form file. 

  Before issuing this command, the database must be in use. 
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  .  USE <file  name> 
  .  REPORT FORM <Report form file> 
      [TO PRINT]  [TO FILE  < file>] 
     [FOR  <condition>] 
 Ex: 
 1) .  USE SALES 
  .  REPORT FORM SALESRP    will display the report on the screen  
   (report will be scrolled) 
 2) .USESALES 
  . REPORT FORM SALESRP TO PRINT  will redirect the report to the printer 
 3) .USESALES 
  . REPORT FORM SALESRP TO FILE <filename>  will redirect the report to the file. 
 4) .USESALES 
  . REPORT FORM SALESRP FOR < condition >    will generate a report with records 
which satisfies the condition.  

17.4 MODIFYING THE REPORT FORMAT: 

 After creating the report form file, the format can be modified by using the command 
MODIFY REPORT 

  . USE < filename > 
  . MODIFY REPORT < formfile > 

17.5 PRINTING OF REPORT FORMAT: 

 To print the reports on the printer of specified report format the command REPORT 
FORM command is used.  

Syntax: 

  REPORT FORM < report file>  [SAMPLE] 
  [WHILE  <condition>] 
  [FOR <condition>] 
  [TO PRINT] 
  [TO FILE <text file name>] 
  Where   < report file> is the report format file 
   <condition > is any simple/compound condition  

   <text file name> is the text file name  

 Ex: i)  . USE SALESRP 
  REPORT FORM SALESRP TO PRINT  

  The above command prints all report on the printer. 

  ii) . USE SALESRP 
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   REPORT FORM SALESRP TO TEXT.TXT 

  The above command sends report to the text file TEXT.TXT 

17.6 SELF ASSESSMENT QUESTIONS: 

1.   Explain how lo create the report In dBase III Plus with example? 

2. Explain how lo modify the report In dBase III Plus with example? 

3. Explain how lo print the report In dBase III Plus with example? 

17.7 REFERENCES:  

1. Simpson    : Understanding of Dbase III Plus, BPB 

2. Al.Stevens    : Disk Operating System, BPB 

3. T.D. Malhotra   : Business Data Processing Systems, K.P 

4. Mandova, N Prasad Rao  : Dosware 
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LESSON - 18 

FUNCTIONS IN DBASE III PLUS 
18.0 OBJECTIVE: 

 To know the various character, mathematical, date and conversion functions in dBase III 
Plus. 

STRUCTURE 

18.1 Introduction 

18.2 Character functions 

18.3 Mathematical functions 

18.4 Date functions 

18.5 Conversion functions 

18.6 Self Assessment Questions  

18.7 References 

18.1 INTRODUCTION:  

 Dbase III plus is having several built-in functions to perform some task. Function needs 
some input arguments. By taking those arguments they perform the specific task. The various 
functions in dbase III plus are 

 1) Character functions 
 2) Mathematical functions 
 3) Date functions 
 4) Conversion functions 

18.2 CHARACTER FUNCTIONS: 

LEN( ) : This function is used to get the length of the given string (including spaces).  

 SYNTAX : LEN(String)  
 EX: .S = SPACE(40) 
  . L = LEN(S) 
   .?L 
   .40 

 EX: . STORE "RAVI" To S  
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  . L = LEN(S)  
  .?L  
  .4 
 EX: . ? LEN("WORLD") 
  .5 

1SALPH( ) : This function returns logical .T. if the given character or the first character of given 
 string is alphabet (A TO Z or a to z).  

 EX :  . ? ISALPI IA("23rd STREET")  
  .  .F. 
  . ? ISALPHA("ADITYA BIRLA")  
  . .T. 

LEFT( ) : This function returns a specified number of characters, string from the left of the 
character string. 

 EX : . ALPHA = "MY NAME IS S. RAVI PRASAD" 
  .MY NAME IS S.RAVI PRASAD 
  . ? LEFT(ALPHA, 7) MY NAME 

  The above function returns the first 7 characters from the character ALPHA. 

RIGHT( ) : This function returns a specified number of characters, string from the right of the 
character string. 

 EX : . ALPHA = "MY NAME IS S. RAVI PRASAD"  
  MY NAME IS S. RAVI PRASAD  
  . ? RIGHT (ALPHA, 13)  
  S. RAVI PRASAD 

TRIM( ) :  This function is used to remove trailing blanks from a field or memory variable. The 
field or memory variable must be in character. If not convert to character by STR( ) function.  

 EX :  . STORE "NEW DELHI" TO CITY  
  . ? TRIM (CITY), PIN  
  NEW DELHI 110003  
 NOTE :   RTRIM( ) function is same as the function. 
   TRIM( ). It removes trailing blanks.  

LTR1M( ) : This function is used to remove leading blanks from a field or memory variable. 

 NOTE : To remove leading blanks from the field or memory variable convert to character 
string by STR( ).  

 EX : . STORE "bbbbb S. RAVI PRASAD" TO NAME  
  . bbbbb S. RAVI PRASAD  
  . ? LTRIM(NAME)  
  S. RAVI PRASAD  
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 EX : . STORE 120 TO N  
  120 
  . ? LTRIM(STR (N))  
  120 

SUBSTR( ) : The function returns the specified part of the character string from the main string. 

 EX :  . ? SUBSTR("My Name is Ram Kumar", 12, 3)  
  Ram 
  12 specifies the position from the where substring starts.  
  3 specifies how many characters to be read.  
 EX : . STORE "S. RAVI PRASAD" TO N 
  S. RAVI PRASAD  
  . STORE 3 TO I 
  3 
  . STORE 4 TO J  
  4 
  . ? SUBSTR (N, I, J)  
  RAVI 

STUFF() : This function allows you to put data into an existing character string without 
dismantling the original string.  

 EX : . STORE "S. RAVI PRASAD" TO NAME 
  S. RAVI PRASAD  
  . ?STUFF(NAMi:, 5, 2, "VI") 
  S. RAVI PRASAD  
  . N    STUFF (NAME, 5, 2, "VI") 
  S. RAVI PRASAD 
 EX :  . ? STUFF ("HAHOHA", 3, 2, "HA") 
  HAHAHA 

  The above function returned HAHAHA because "HA" was stuffed al Md character, 
replacing 2 characters. 

AT( ) : This function returns the number equal to the starting position of character string within 
another character string.  

 EX : . ? AT("MY", THIS IS MY PEN")  
  9 
 EX : . ? AT("P", "This is my Pen")  
  12 

ISUPPER( ): The ISUPPER function is used to whether the given character or first character of 
given string is upper case or not. If it is an Upper case then it returns logical T 

 EX : . ? ISUPPERC'R") 
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 .T. 
 EX : . STORE "ravi" TO N ? ISUPPER(N) 
 .F. 

ISLOWER( ) : This function is quite opposite to ISUPPER( ) function But it returns logical 
value .T. if the character or first character of string is in lower case. 

 EX : . STORE "RAVI" TO S . ?ISLOWER(S) M 
 EX: . ? lSLOWER(V) 
 . .T. 

TYPE( ) : This function can be used to find out the Data type of an expression. It returns one of 
the following characters depending on the type of expression. 

  C for Character 
  N for Numeric 
  D for Date 
  L for Logical 
  M for Memo 
  U for Undefined/Invalid/ Memory.  
 EX : . STORE 10 TO N 10 
  ?TYPE("N") N 
  "CHECKING" CHECKING . VTYl'I.C'X")  
 EX :    SET DEVICE TO SCREEN TEXT 
  MY NAME IS S. RAVI PRASAD 
  I AM STUDYING B.SC. FINAL YEAR 
  MATHEMATICS, PHYSICS, COMPUTER SCIENCE 
  ENDTEXT  
 EX :    SET DEVICE TO PRINT 
  TEXT 
  MY NAME IS S. RAVI PRASAD  
  I AM STUDYING B.Sc. FINAL YEAR  
  MATHEMATICS, PHYSICS, COMPUTER SCIENCE  
  ENDTEXT 
  SET DEVICE TO SCREEN 

. REPLICATE( ) : This function is used to repeat a character string for specified number of 
times. 

NOTE : This is most commonly used is to draw long lines. EX : IF we want to display a line of 
30 character long. ? REPLICATE("-"¦, 30) . ? REPLICATE (CHR(196), 30) IF (.NOT. DELETED 
( )) THEN 

  @ 10, 10 SAY "NOT DELETED" ENDIF 
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18.3 MATHEMATICAL FUNCTIONS:  

INT( ) : This function is used to get the integer value of the given expression. 
 Ex : (1) 
  . STORE 123.4567 To C 
  . N = INT(C) 
  . ?N 
  . 123  
 Ex : (2) 
  . STORE N = 12345 
  . N = INT(N/100) 
  . ?N 
  . 123  
 Ex : (3) 
  . ?INT(246.56)  
  . 246 

MOD( ): This function is used to get the remainder for the given expression.  

 SYNTAX : Variable = M0D(D1VIDEND, DIVISOR)  
 Ex : (1) 
  . STORE 1234 To N 
  . M = MOD(N, 10) 
  . ?M 
  . 4 

SQRT( ) : This function is used to find the square root of the integer.  

 SYNTAX : 
  SQRT(variabIe or integer) Ex:  .STORE 19ToN 
  . ? SQRT(N) 
  .3 
  . ? SQRT(25) 
  . 5 

ABS( ) : This function is used to get the absolute value of the specified expression. To get the 
positive value when a - Ve or + Ve value is given. SYNTAX : ABS(variable or integer) E 

 Ex: .? ABS(-IOIGI) 10101 

LOG( ) : This function is used to get the natural logarithm of the given number. 

 SYNTAX : l.C)G(variable or integer) EX : ? LOG(2.72) EX :  . STORE 2.72 To N . ? 
LOG(N) 
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ROUND( ) : This function rounds off a numeric expression to a specified number of decimal 
places. 

 SYNTAX : ROUND (numeric expression, decimal places) Ex : Create a numeric variable 
POINT and STORE. 120.4673 in it . STORE 120.4673 To POINT 120.4673. 

  To Round off POINT to whole numbers (0 decimal) . ?  
  ROUND(POINT, 0) 120 
  To Round off POINT to 2 decimal places . ?  
  ROUND(POINT, 2) 120.47 

 By Specifying the negative decimal places we can ROUND off a number to 10S, 100S etc. 

  . STORE 128324.65 To NUM1 
  128324. 65 . ? R0UND(NUM1, 0) 
  128324.00 . ?ROUND(NUMl,-2) 
  128300.00 . ?ROUND(NUMl,-4) 
  130000.00 

EXP() : This function is used to return the value of en for given n.  

 SYNTAX : EXP(Numeric exp  
 EX :    . ? EXP(2.0) 7.39 

MAX( ) : This function is used to return the minimum of 2 numeric expressions. 

 SYNTAX : MAX(EXPNI, EXPN2)  
 EX :    . STORE 34 TO NUM1 34 
  . STORE 56 TO NUM2 56 
  . ?MAX(NUM1,NUM2) 56 
  . M = MAX(NUM1,NUM2) . ?M 56 

MIN( ) : This function is quite reverse of MAX(). This function returns Iiit-minimum of 2 numeric 
expressions.  

 SYNTAX : Variable = MIN(Exp Nl, Exp N2)  
 EX :   . STORE 34 TO NUM1 34 
  . STORE 56 T0NUM2 56 
  . ?MIN(NUM1,NUM2) 56 
  . M = M1N(NUM1, NUM2) . ?M 34 
 **Or * : These functions are also used for exponentation.  
 SYNTAX : Variable = Variable ** (or) ~ variable.  
 EX:    . ? 100**2 10000.00 . ?12 ~ 2 
  144.00 . STORE 100 TO N 100 
  . STORE 2 TO I p m ini**i 
  10000.00 
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 The dbase 3" will find the A M of all numeric field BASIC, HRA, DA, LIC, PF, 1TAX 
displays. To store the average ol fields to a memory variable. . AVERAGE 1 IC TO AMI [( AVI 
KAC.l I IC, Pi; ITAXTO AUC, APF, AITAX. 

 The above command display sum of contents of all numeric fields LIC, PF, BASIC, HRA, 
DA, ITAX and displays. 

 To find the sum of certain specified fields. . USEEMPMAST 

 . SUM LIC, PF, ITAX TO TLIC, TPF, TITAX . USE EMPMAST . SUM LIC * ITAX TO TOT. 
The above command stores the TOT that is equal to sum of LIC X ITAX for all records in dbf 
file. 

COUNT( ) : The count command is used to count the number records that satisfy the 
conditions specified.  

 EX : . USE EMPMAST 
  . COUNT FOR BASIC > = 5000 TO M 
  . COUNT FOR BASIC > = 5000 .OR. ITAX > 500 TO M 
  . USEEMPRES 
  . COUNT FOR (NET > = 4000. AND. NET < =2000) . .OR. (GROSS >= 400. AND. 
GROSS < =200) TO M 

18.4 DATE FUNCTION: 

DATE() : This function returns the current System Date. The Date will be displayed in MM  
MONTH  ; DD  DAY; YY  YEAR. There are different Date formats. 

  The default Date form is American format i. e. MM/DD/YY But we can select the Date 
format of your choice by using SET DATE Command. 

  Date Format Name & Command Date Format Example 
  SET DATE AMERICAN MM/dd/YY 02/20/98 
  SET DATE BRITISH/FRENCH dd/mm/yy 20/02/98 
  SET DATE ANSI yy. mm. dd 98.02.20 
  SET DATE GERMAN dd. mm. yy 20. 02. 98 
  SET DATE ITALIAN dd-mm-yy 20-02-98 

  ADDITION, SUBTRACTION can be manipulated on Dates. 

   There is a Date data type.  

 EX :    SET DATE. BRITISH  

   ? DATE() 

   01/11/98 
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DAY( ) : This Function returns the Day  from the date type (memory variable or held) returns in 
numeric value.  

 EX :    STORE DATE ( ) TO BEGIN 
   01/11/98 
   ? DAY (BEGIN) 
  01 

  It retrieves "01" from the variable BEGIN. 

  The above command can also be used as follows. 

  STORE DTOC (DATE( )) TO B 
  01/11/98 
  ? LEFT (B, 2) 
  01 

MONTH( ) : This command is used to retrieve the numeric value of month from any Date - type 
exp. (date - type memory variable or field etc' returns in numeric value. 

 EX :    STORE DATE( ) TO B  
   01/11/98  
   ? MONTH (B)  
   11 

  The above command is similar to the following set of commands. 

  STORE DATE( ) TO B 
  BEGIN = DTOC(B) 
  R = LEFT(BEGIN, 5) 
  L = RIGHT(R, 2) 
  ?L 

YEAR() : The above command displays the year in the century form and returns numeric value 
from the Date - type of Memory variable or field.  

 EX :    ? YEAR (DATE( ))  
  1998 
  The command is similar to the following set of commands. 
  SET DATE TO BRITISH 
  SET CENTURY ON 
  STORE DTOC (DATE( )) TO B 
  R = RIGHT(B, 4) 
  ?R 
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CMONTH( ) : The function is used to retrieve the name of month (as character exp.) from any 
date-type data.  

 EX :    STORE DATE( ) TO B 
  01/11/98 
  ? CMONTH(B) 
  NOVEMBER. 

DOW( ) : Day of week function returns a number corresponding to the day of a week from any 
date-type exp.  

 EX :    ? DA 
 DOW (DATE( )) 
 $ 
 I    Sunday 
 7    Saturday 
 DATE( )  01/11/98 

CDOW ( ) : Character Day Of Week function returns the name or a day from date - type data. 

 EX : CDOW (DATE( ))  
  SUNDAY 
  DATE ( )    01/11/98  
  SUNDAY 

18.5 CONVERSION FUNCTIONS: 

ASC( ): This function returns the ASCII value of the given character and returns the ASCII 
value of the first character of character expression. SYNTAX : ASQCharacter or string)  

 EX :    . ?ASC("A")  
  65 
  ?ASC(“ || ”) 
  204 
  STORE "DEEP" To N 
  ? ASC(N) 
  68 

CHR( ) : This function displays the ASCII character for given the integer.  

 EX :   . ? CHR(254) 
  . || 
  ?CHR(199) 
  . || 
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 EX : DISPLAYS ALL ASCII Characters.  
  1 = 1 
  DO WHILE(I <=255) 
  ? CHR((I)) 
  ? 
  1 = 1 + 1 
  "WAIT" 
  ENDDO 

VAL() : This function is used to change the character string to numeric.  

 SYNTAX : VAL(string)  
 EX: . ?VAL("123.456") 
  . 123.456  
 EX : . STORE "102456" To N 
  . ?VAL(N) 
  . 102456 

STR( ) : This function is used to convert the number to ,i string.  

 SYNTAX :   STR(variable or number, [Integer |, [Integei ] )  

 Ex : . STORE 123.4567 To N 
  . S = STR(N, 10,2) 
  . ?S 
  . 00123.45  
 Ex : . N = 123 
  . S = STR(N) .  
  ?S  
  . 123 
 EX :    INDEX ON CODE + STR(AMOUNT, 10, 2) TO TEST 

    INDEXING IS DONE only on the character data type. So, convert the Amount field 
to character data type by STR(). 10 specifies the length of the field and 2 specifies the length of 
the 2 decimal part.  

UPPER( ) : This function is used to convert lower case or upper case letters to upper case 
letters.  

 EX: . STORE "Ravi" TO N  
  Ravi 
  . ? UPPER(N)  
  RAVI 
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 EX:    INDEX ON UPPER(NAME) TO INDNAME 
 EX :  . STORE "Y" TO CH  
  . U - UPPER(CH)  
   Y 

LOWER( ) : This function is quite opposite to UPPER( ). It converts upper case letters to lower 
case letters.  

 EX : . STORE "rAVI" TO N ravi 
 ? UPPER(N) ravi 

DTOC( ) :  Date To Character function converts date - type memory variable (or field) to a 
character string.  

 EX :    TODAY = DTOC(DATE( )) 
  01/11/98 TODAY is a character string.  
 EX :    STORE DATE( ) TO Current 
  01/11/98 
  ? DTOC(Current) 
  01/11/98 
  ? "TODAYS DATE IS" + current.  

 If the following command is executed, then the message Data type mismatch will be 
displayed. 

  STORE DATE( ) TO TODAY ? "TODAYS DATE IS" + TODAY CTOD() : Character 
To Date function is the reverse of DTOC( ) function i.e. it converts a date stored as character to 
a date-type variable. EX :    XX = SPACE (10) 

  @ 10, 10 SAY "ENTER TODAY'S DATE ::" @ 10, 25 GET XX PICTURE "99/99/99" 
READ 

 STORE CTOD(XX) TO DATVAR. 

18.6 SELF ASSESSMENT QUESTIONS: 

1. What is a function and name the different types of functions available in dbase III plus? 
2. Explain about date functions available in dBase III plus. 
3. Explain about Mathematical functions available in dBase III plus.    
4. Explain about Conversion functions available in dBase III plus. 

18.7 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 
2. Al.Stevens    : Disk Operating System, BPB 
3. T.D. Malhotra    : Business Data Processing Systems, K.P 
4. Mandova, N Prasad Rao  : Dosware 
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LESSON – 19  

CONTROL STRUCTURES IN DBASE 
19.0 OBJECTIVE: 

 To know the conditional and control structures in dbase 

STRUCTURE 

19.1 FOR condition 

19.2 WHILE condition 

19.3 Control structures in dbase 

19.3.1 If...else...endif command 

19.3.2 Do case...end case command 

19.3.3 Looping command do while...enddo 

19.4 Set commands in dbase 

19.5 Self Assessment Questions  

19.6 References 

19.1 FOR Condition: 

  The condition corresponds to any logical condition. Only those records satisfying the 
condition would be displayed on the screen. Whatever may be the current position of the record 
pointer, it moves to the beginning of the file and checks whether the specified condition is 
satisfied for the record. If it is satisfied, then the record is displayed on the screen. If it is not 
satisfied, then the record is not displayed on the screen, next the record pointer moves to the 
second record and checks for the condition. This is continued until the (offend of file) is reached. 

19.2 WHILE CONDITION:  

 The WHILE condition starts checking for the validity of the condition from the current 
record. If the condition for the current is satisfied, then the data corresponding to the record is 
displayed 

19.3 CONTROL STRUCTURES IN DBASE: 

 The following control structures are supported by dBase. 

 1) Decision making command. 
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 2) Multi directional conditional command 
 3) Looping command 

19.3.1 IF...ELSE...ENDIF Command :  

 This command is used to take decision between two alternatives.  

  Syntax : IF < condition > 
   < command setl>  
  ELSE 
   < command set2>]  
  ENDIF 

  Where < condition > can be simple valid condition or any compound condition 
formed by logical operators. 

  If the <condition> is true, then the <command setl> is executed otherwise 
<command set2> is executed. Ex : i) IF AGE > =" 18 

  ? "Person is eligible to vote" ELSE 
  ? "Person is~ not eligible to vote" ENDIF 
 ii) IF QUANTITY <= 200 
  ? "QUANTITY HAS REACHED RE ORDER LEVEL" ENDIF 

19.3.2 DO CAS*:...END CASE Command : 

  This command is used to case make decision between multiple alternatives 

  Syntax : 

  DO CASE 
   CASE CHOICE = 1 
    < command set 1> 
   CASE CHOICE - 2 
    <  command set2> 
   CASE CHOICE - 3. 
    <  command set3> 
  ENDCASE  
 Ex :   DO CASE 
   CASE CH = 1    
    DO PROG1  
   CASE CH = 2 
    DO PROG2  
   CASE CH = 3 
    DO PROG3 
  ENDCASE 
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19.3.3 Looping command DO WHILE...ENDDO : 

  This command is used to execute set of commands as long as the condition is true 
and terminates when condition is false.  

  Syntax : 
  DO WHILE <condition> 
    < command set>  
  ENDDO 
  where <condition> is any valid condition.  
  Ex:   .USE STUDENT 
   DO WHILE .NOT EOF( ) 
   ? NAME 
   ? SEX 
   ? HTNO 
   SKIP  
   ENDDO    
   CLOSE DATABASES 

19.4 SET COMMANDS IN DBASE: 

S.NO. COMMAND DESCRIPTION 

01 SET ALTERNATE on/off When Alternate is set to ON records all 
screen activities including keyboard 
entries in a file selected by SET 
ALTERNATE TO command. 

02 SET ALTERNATE TO Opens/creates a text file for storing screen 
and keyboard activities. 

03 SET BELL on/off When set to ON,  a bell beeps when an 
invalid data is entered. 

04 SET CARRY on/off When set to ON, dBASE copies the 
contents of the previous record to the new 
record while using APPEND or INSERT. 

05 SET CENTURY on/off Determines whether 2 or 4 digits will be 
used for year entries in data-type data. 

06 SET CONFIRM on/off When set to OFF, the cursor automatically 
advances to the next variable/field after all 
character positions for the current 
variable/field are filled. 
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07 SET CONSOLE on/off When set to OFF, the output of 
commands does not appear on the 
screen. 

08 SET DATE Determines the display format of date.  
Default format is American. 

09 SET DECIMALS Sets a minimum number of decimal places 
to be displayed in the result of 
mathematical calculations. 

10 SET DEFAULT Selects the default disk drive for read/write 
operations. 

11 SET DELETED on/off When set to ON,  prevents the records 
marked for deletion from being displayed 
with LIST,  DISPLAY,  REPORT etc... 

12 SET DEVICE Determines whether output from @ SAY 
command is directed to screen or printer. 

13 SET HISTORY When ON, command file lines are 
recorded in the history file.  Otherwise 
only commands entered at the dot prompt 
are recorded in the history file. 

14 SET ECHO Determines whether in the history file.  
Determines whether lines from command 
files are displayed on the screen before 
execution. 

15 SET ESCAPE Determines whether pressing the Esc Key 
interrupts command file processing. 

16 SET EXACT on/off Determines whether exact matches are 
required in character string searches, 

17 SET TALK on/off Determines whether the results of 
commands and calculations are displayed 
on the screen.  
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19.5 SELF ASSESSMENT QUESTIONS: 

1. Explain the FOR condition and WHILE condition? 

2. What are the Control structures in dbase? Explain. 

3. Explain about the If...else...endif command? 

4. Explain about the Do case...end case command? 

5. Explain about the Looping command do while...enddo? 

6. Explain the Set commands in dbase? 

 

19.6 REFERENCES:  

1. Simpson     : Understanding of Dbase III Plus, BPB 

2. Al.Stevens    : Disk Operating System, BPB 

3. T.D. Malhotra    : Business Data Processing Systems, K.P 

4. Mandova, N Prasad Rao  : Dosware 
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LESSON - 20  

WINDOWS 
20.0 OBJECTIVE: 

• To know the features and advantages of windows 
• To know the desktop and task bar features 

 

STRUCTURE : 

20.1  Introduction 

20.2  Features of Windows  

20.3  Advantages of Windows  

20.4  Parts of  Windows 

20.5  Different Styles of Desktop 

20.6  Task Bar 

20.7  My Computer 

20.8  Recycle Bin 

20.9  Start Menu 

20.10 Control Panel 

20.11 Wizard 

20.12 Clip Board 

20.13 Self Assessment Questions 

20.14 References 

20.1 INTRODUCTION: 

Microsoft Windows is a powerful operating system that controls the overall activity of the 
computer. The Microsoft Corporation, USA, developed the Windows operating system. It is 
powerful because it holds many useful programs that store important files and also ensures that 
all parts of the computer work together smoothly and efficiently. Unlike the other operating 
systems developed by Microsoft Corporation for PCs is DOS (Disk Operating System) no need 
to type lengthy and difficult commands in order to perform a certain operation. The DOS is 
Character User Interface (CUI) since the commands are in the character form. Windows is an 
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operating system that supports Graphical User Interface (GUI). In windows operating system 
the commands are present in the form of menu commands and graphical images called Icons. 

 Simply, we can also say that windows are an enhancement of DOS. Initially Microsoft 
released the Windows 3.1 which is an environment, runs on DOS. Later they released the 
complete operating system in 1995 and named it as Windows 95. After that they released 
Windows 97, Windows 98, Windows 2000, Windows Millennium, Windows XP etc. Windows is 
a multi user, multi tasking operating system.  

20.2 FEATURES OF WINDOWS: 

• GUI(Graphical User Interface) : A graphical User Interface is a means by which the 
computer can be given commands very easily by the user. The commands, which are to 
be performed, are displayed on the screen in the form of pictures(icons). The user has to 
execute the icon to do a particular work. 

• CLIPBOARD (CUT AND PASTE) : Clipboard is an area in the computer's memory 
where MS-Windows temporarily stores the copied data. The clipboard is a facility to 
transfer the data between two dissimilar or similar programs. The different applications 
are running, the data in one application can be copied or moved to another application 
(picture from MS paint can be moved to WordPad file) using the clipboard. 

• OBJECT LINKING AND EMBEDDING (OLE) : OLE is a method where in an object 
form one application can be pasted to another application and any changes in the 
original picture can be brought to the pasted picture also. There is a provision to change 
the pasted picture also by opening the explication in which it was originally created. 

• MULTITASKING : MS-Windows allows executing more than one program at a time. 
Each program will work in its own window the user can switch to any program without 
closing the previous program. The windows can be displayed side by side or one behind 
the other. 

• WHAT YOU SEE IS WHAT YOU GET (WYSIWYG) : When the document is printed 
on the paper, the printout will look exactly like the document is displayed on the screen. 
That is, the text will be printed using the same character size, text formatting, alignment 
and pictures if any included in the file will be printed at the position it is displayed on the 
screen. 

20.3 ADVANTAGES OF WINDOWS: 

 This operating system is designed for use as a workstation client or desktop system. It is 
not intended to be used as a server, but can be used in simple work groups to share resources 
such as printer and files. Windows offers a number of advantages. These are 

• Easier to use and learn 

• More reliable by protecting the operating system from errant programs 

• Supports all major networking protocols including Novell IPX and TCP/IP 

• Network clients are faster, more reliable, and use no conventional memory 
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• Simplified user interface 

• Automate installation for all users and custom installations 

• Remote administration features built in 

• Support multiple users on a single PC with customized settings for each individual. 

• Preemptive multitasking and multi-threading 

• Plug and play support for hardware devices, making it easier to add new hardware 

• Dial-up networking (remote access services) 

• Supports existing MS-DOS and Windows drivers and programs  

20.4 PARTS OF WINDOWS: 

 Some of the parts of a Windows such as title bar, menu bar etc., are common, so that 
the user can understand and memorize faster. 

 

Fig : Windows showing the parts 

Title bar : 

 The horizontal bar at the top of window is called Title bar. This bar shows the name of 
the application, document, active file name and buttons to minimize, maximize or restore, close 
the window.  
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Menu bar : 

 It is just below the title bar. It is also a horizontal bar containing the list of menus 
available for that application window. This menu contains a list of menu items (choices). 

 Minimize button  : 

 By clicking on this button the active window shrinks and becomes an icon on the task 
bar. Minimizing the window does not quit the application. 

Maximize/Restore Button : 

 By clicking on this button    using mouse the window is enlarged,  the window  so that it 
fills the entire desktop. By clicking on this button  returns to its previous size.  

Close Button: 

 By clicking on this button the active window is closed and application is removed out of 
the main memory. 

Window Border : 

 It is the outside edge of the window. The window can be resized by lengthening or 
shortening the border.  

Insertion Point: 

  It is a flashing vertical bar that marks the place where text or graphics are to appear on 
typing or drawing. That means, it represent the current print position.  

Mouse Pointer : 

 An arrow used for pointing items. It appears if the mouse is installed on the system.  

Scroll bars: 

 Generally, application windows will have 2 scroll bars, one at the bottom and the other at 
the right side. The scroll bar at the bottom of window is called as the horizontal scroll bar and 
the scroll bar at the right is called as the vertical scroll bar. The scroll bars have the scroll 
buttons (left and right for horizontal scroll bar, top and bottom for vertical scroll bar) and a scroll 
box. Scroll bars helps in faster movement from one part of the document to the other.  

Control-menu box : 

 It is in the upper-left corner of each window. Clicking on the control-menu box opens the 
control menu. The control menu can be used to move, size and close a window while working. 

20.5 DIFFERENT STYLES OF DESKTOP: 

 Your desktop can be configured in one or two styles, or in a custom-designed 
combination of the two : 
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Web style : Your desktop looks and acts much like a web page, as shown in below Figure, icon 
labels are underlined, like web page links. Filenames in folder and Windows Explorer windows 
are underlined too. To run a program or open a file, click the icon or filename once. To select an 
icon or file, just-let the mouse pointer rest on the object. 

 

Classic style :  Your desktop looks and acts just like as shown in below Figure. Icon labels are 
not underlined, nor are the filenames in Folder or Windows Explorer windows. To run a program 
or open a file, double-click the icon or filename. To select an icon or file, click the object once. 

 

Custom style : Your desktop looks and acts as you want it to look and act.. For example, you 
can create your own combination of Web and Classic styles. 
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20.6 TASK BAR: 

 
 The Taskbar is a row of buttons and icons that usually appears along the bottom of the 
screen. You can configure Windows to display the Taskbar along the top or side of your screen. 
You can also tell Windows to hide the Taskbar when you aren't using it. 

 

The Taskbar has several parts : 

• The Start button, which is usually at the left end of the Taskbar. 

• The Task Manager, which contains button for each window that is open on the desktop. 

• The toolbar area, which can contain one or more toolbars (set of buttons). 

• The system tray, which contains icons for some windows programs and folders, 
including the system clock. 

20.7 MY COMPUTER: 

 My Computer is a tool to browse all disks (floppy disk, hard disk and compact disk) 
connected to the computer. Folders and files in any drive can be accessed from the My 
Computer icon. When Windows is first started, My Computer icon is located at the top left 
corner on the desktop. 

 To start My Computer, double-click on My Computer icon. A window appears displaying 
the icons for floppy disk, hard disk, compact disk, control panel and printers. 
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My Computer can be used to do the following operations. 

• To see what is on the disk in a particular drive, double-click on the drive icon. 

• To see what is in a folder, double-click on the folder icon. 

• To see the contents of a file, double click on the file icon. 

• To close anything that is opened, click on close button. 

20.8 RECYCLE BIN: 
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 Files and folders sent to the Recycle Bin may disappear from the folder tree, but 
Windows still stores them on your hard drive and keeps track of them. Eventually, one of four 
things happens: 

• You get rid of things in the Recycle Bin, either by emptying it or by deleting some of the 
files and folders there. 

• You retrieve files from the Recycle Bin and put them in some other folder. 

• The Recycle Bin gets full. 

• You turn off the Recycle Bin so that deleted files aren't put there any more. 

 
 Like most other things in Windows, the Recycle Bin has properties. To display them 
right-click the Recycle Bin icon on the desktop, and choose properties from the menu or select 
the Recycle Bin in a Folder or Windows Explorer window and click the properties button on the 
toolbar. In either case, the properties dialog box for the Recycle Bin is displayed, as in above 
figure. The Properties dialog box contains a Global tab, plus a tab for each hard drive on your 
system.  

Emptying the Recycle Bin: 

 Getting rid of old files serves two purposes: It clears useless files away so that you don't 
confuse them with useful files, and it reclaims the disk space they occupy. The first purpose is 
served by deleting a file-once it's in the Recycle Bin, you aren't going to open it or work on it by 
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mistake. But a file in the Recycle Bin still takes up disk space. The space isn't reclaimed until 
the Recycle Bin is emptied. 

To empty the Recycle Bin : 

• Open the Recycle Bin in either a Folder or Windows Explorer window. I 

• Choose File | Empty Recycle Bin. A dialog box asks you to confirm J your choice. 

• Click Yes. Windows empties the Recycle Bin. 

• Close the Recycle Bin. 

 

20.9 START MENU: 

 The Start Menu appears when you click the Start button on the Taskbar, These are the 
items that are usually on the Start menu : 
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• Window Update : Connects to Microsoft's website to find out about, download and 
install updates to Windows. Choose this command if you want to see whether the 
Windows are available for download. 

• Programs : Displays the Programs menu, a menu of programs you can run. This menu 
is define by the contents of the C:\Windows\Start Menu\Programs folder, which you can. 
Choose the Programs menu when you want to run a program. 

• Favorites : Displays the Favorites menu, a list of documents and files are in the 
Favorites folder at C:\Windows\Favorites. You can change the contents of this folder to 
change the items on the Favorites menu. Choose the Favorites menu when you want to 
open one of the files that you've put in your Favorites folder. 

• Documents : Displays the Documents menu, a list of documents that you have 
opened recently. To open one of the documents, choose it from the list. Windows runs 
the program that handles that type of file, and then opens the document in the program. 
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• Settings : Displays a menu of commands you can use to control how Windows, your 
desktop, and your printers work. The Control Panel command helps you to install 
software and change your Windows settings. The Printers command helps you to see 
the status of your printers. The Taskbar & Start Menu command helps you to customize 
the Taskbar and the commands that appear on the Start menu. The Folder Options 
command helps you to customize your desktop, Folder Windows and Windows Explorer 
windows. The Active Desktop command helps you to display web pages on your 
desktop. The Windows Update command allows you to update Windows from the 
Internet. Applications or utility programs may add other commands to the Settings menu. 

• Find : Displays a menu of the types of things that Windows can help you find. The Files 
or Folders command searches your disks for files and folders. The computer command 
search for computers by name if your computer is part-of a local area network. The 
Internet command runs your web browser to search the Internet for information. The 
People command can various Internet address search for people's addresses by using 
your own Windows Address Book or various Internet address search pages. 
Applications or utility programs may also add other commands to the Find menu. 

• Help : Displays online help. 

• Run : Lets you run a program by typing the name of the file that contains it. 

• Log Off:   If your computer is on a local area network, this command appears allowing 
you to log off from one user name and log on as another 

• Suspend : If your computer has a suspend mode, the command Suspend appears on 
the Start menu, allowing you to put your computer in a state of suspend animation that 
uses less power than when it's fully turned on. 

• Shut Down : Displays the Shut Down Windows dialog box. Choose Shut Down if you 
are ready to turn off your computer. Choose Restart your computer. Choose Restart in 
MS-DOS Mode to shut down Windows 98 and run MS-DOS. 

20.10 CONTROL PANEL: 

  The Control panel, show in Figure, is a window that display icons for a number of 
programs that let you control your computer, Windows and the software you have installed. 
These programs help you to and change the properties of many parts of Windows. 
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 To see the Control Panel, choose Start | Settings | Control panel. The icons in the 
Control Panel window may include these programs, depending on what Window components 
and other software you have installed: 

• Accessibility Options : The Accessibility Properties dialog box lets you configure 
Windows's keyboard, sound, display, mouse and other options for people with 
disabilities. This icon appears only if you installed Accessibility options when you 
installed Windows. 

• Add New Hardware : The Add New Hardware Wizard configures Windows when you 
add new hardware to your computer system. 

• Add/Remove Programs : The Add/Remove Programs Properties dialog box helps 
you install new programs or uninstall programs you no longer use. 

• Date/Time : The Date/Time Properties dialog box lets you set the date, time, and time 
zone where you are located. 

• Display : The Display Properties dialog box controls the appearance, resolution, 
screen saver and other settings for your display. 

• Fonts : The Fonts window lets you install new screen and printer fonts. 

• Game controllers : The Game Controllers dialog box lets you install games. 

• Internet : The Internet Properties dialog box contains settings for your web browser 
and Internet connection. 

• Keyboard : The Keyboard Properties dialog box contains settings that control your 
keyboard and the cursor. 
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• Modems : The Modem Properties dialog box contains settings for how your modem 
works and helps you diagnose problems. 

• Mouse : The Mouse Properties dialog box lets you define the buttons on your mouse 
and lets you choose how fast you need to double click, what your mouse pointer looks 
like on-screen and whether moving the mouse leaves a trail. 

• Multimedia: The Multimedia Properties dialog box contains settings for the audio, 
video, MIDI and audio CD settings of your computer. 

• Network : The Network dialog box contains settings you use when configuring a local 
area network. It also contains settings for connecting to the Internet. 

• Passwords : The Password Properties dialog box lets you set a password for using 
Windows on your computer, user profiles if more than one person will use the computer 
and other security settings. 

• Power Management : The Power Management Properties dialog box contains control 
to set when Windows automatically turns off your monitor, hard disks and other 
computer components to save electricity. Laptops have additional power usage options 
that Windows can handle. 

• Printers : The Printer dialog box includes icons for each printer to which you have 
access, as well as an icon for adding a new printer. 

• Regional Settings : The Regional Setting Properties dia'og box lets you tell Windows 
the time zone, currency, number format and data format you prefer to use. Not all 
programs follow the settings you choose, but many do. 

• Sounds : The Sounds dialog box lets you assign a sound to each Windows event or 
events in other programs. For example, you can set your computer to play a fanfare 
when your e-maii program receives new messages. 

• System : The System Properties dialog box lets you use the Device Manager to 
change advanced settings for each hardware component of your computer. You can 
also optimize the performance of your computer. 

• Telephony : The Dialing Properties dialog box contains settings that control how 
Windows dials the phone using your modem. 

• Users : To Enable Multi-user Settings Wizard helps you set up user names and 
passwords, so your computer can be used by more than one person. Each person's 
user name can store that person's desktop settings. 

You may see additional icons if you have installed additional hardware or software on your 
computer. 
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20.11 WIZARD: 

 Windows, like many other Microsoft programs, includes many Wizards, programs that 
step you through the process of creating or configuring something. For example, the Internet 
Connection Wizard leads you through the many steps required to set up a Dial-up Networking 
connection to an Internet Service Provider (ISP). 

 

  Wizards include instruction for each step, telling you what information you must provide, 
and making suggestion regarding what choices to make. Most Wizards display window after 
window of information and questions, with Back, Next and Cancel buttons at the bottom of each 
window. The above figure shows a window displayed by the Microsoft Windows Registration 
Wizard. Fill out the information requested by the Wizard and then click the Next button to 
continue. If you need to return to a previous Wizard window, click the Back button. To exit the 
Wizard, click the cancel button. The Wizard's last screen usually displays a Finish button, since 
there's no "next" screen to see. 

20.12 CLIP BOARD: 

 The easiest way to move information within an application, or from one application to 
another, is to use the Window Clipboard, a handy little tool that works in the background, saving 
text, number, pictures, or whatever you cut or copy, and allowing you to paste that material 
somewhere else. You can use the Clipboard to move or copy text, a range of spreadsheet cells, 
a picture, a sound, or almost any other piece of information that you can create with a Windows 
application. The Clipboard can hold only one chunk of information at a time, so you have to 
either paste it somewhere else right away, or not cut or copy anything else until you've paste 
the information where you want it. If you cut or copy another chunk of information, it replaces 
the information already on the Clipboard. 
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20.13 SELF ASSESSMENT QUESTIONS: 

1. Explain the features of windows? 

2. Explain the Advantages of Windows? 

3. What is control panel? Explain 

4. Explain Desk top and task bar? 

20.14 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 
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LESSON – 21    

FILE MANAGEMENT UNDER WINDOWS 
21.0 OBJECTIVE: 

• To know Installing Programs Using the Add/Remove Program 
• To know the File management under windows 

 

STRUCTURE 

21.1 Introduction 

21.2 Installing Programs 

21.3 File Management 

• Creating Files and Folders 

• Manipulating files 

• Searching for a File or Folder 

• Setting File Attributes 

21.4 Self Assessment Questions 

21.5 Reference Books 

21.1 INTRODUCTION: 

File management is allows manipulating files, folders and disks. Windows has a program 
called Add/Remove Programs that helps you find and start the installation program for a new 
program. However, you can skip this step and run the installation programs yourself, if you 
know how. Some older DOS and Windows 3.1 programs don't come with installation programs, 
and you have to perform the actions of an installation program yourself.   
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21.2 INSTALLING PROGRAMS USING THE ADD/REMOVE PROGRAM : 

 

Installing a program using Add/Remove Programs is a good idea, because Windows adds 
the program to the list of programs you've installed, making it easier to uninstall the program 
later. Follow these steps to use the Add/Remove Programs command to help you install a 
program: 

1. Choose Start i Settings \ Control Panel. You see the Control panel window. 

2. Run the Add/Remove Programs program. If the icons are underlined, your desktop is 
configured In Web style, so click the icon once. If the icons are not underlined, your 
desktop is configured in Classic style, so double-click the icon. You can control whether 
you need to single or double-click icons to run programs. 

3. You see the Add/Remove Program Properties dialog box, shown in the above figure. If 
the Install/Uninstall tab isn't selected, click it. The box in the lower half of the window 
lists the programs you have already installed on your system, including Windows 98 
itself.  

4. Click the Install button. 

5. If you are installing a program from a floppy disk or CD-ROM, insert the disk or CD-ROM 
into its respective drive and click Next. If you are installing a program from a file on your 
hard disk or on a network drive, just click Next. Windows looks for any floppy disk or CD-
ROM in your drives for an installation program (that is, a program named Setup.exe or 
Install.exe). If Window finds an installation program, you can skip to step 8. 

6. If Windows 98 doesn't find an installation program, you see the Run Installation Program 
dialog box, shown in below Figure. 
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7. Click the Browse button and specify the installation file you want to run in the Browse 
window. 

8. When the path name of the installation program appears in the Command Line For 
Installation Program box, click the Finish button. The installation program runs. Follow 
the instructions on the screen to install the program. 

Once you've installed a program, the program name usually (but not always) appears on 
the Add/Remove Programs Properties dialog box's list programs that you can uninstall. 

21.3 FILE MANAGEMENT:  

 File management is the name of the windows program that allows manipulating files, 
folders and disks.  Various tasks performed by it are: 

1. Working with Files and Folders : One can use file manager commands to work with 
files and directories individually or in groups.  

2. Naming Files and Folders : Newly created folders and files are given default names, 
such as New Folder and New Microsoft Word Document. The name of the file must satisfy the 
following rules. 

• It must be different from Reserved words like CON, AUX, COM1, COM3, 
LPT,PRN and NUL. 

• The name may start with an alphabet or a numeral. 
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• The name should not have the following special characters 

3. Creating Files and Folders : New folders and files of certain types can be created either 
on the desktop or inside any folder window other than My Computer. On the desktop, right click 
any empty area and choose New on the menu that appears.  

4. Searching for a File or Folder : When user wants to find a file or directory, he can use 
the Find command. By using find, you can search for a file : 

  • By name or part of a name 
  • By date created, modified, or last accessed * 
  • By file type 
  • By size 
  • By a string of text contained in the file 
  • By some combination of all the above. 

5. Moving and Copying files and Folders : User can move and copy the files or folders 
from one file manager location to another by dragging with the mouse or by using the cut, copy 
and paste command. The following steps are to be performed for copying and moving the files 
or folders. To move a file from one folder to another folder 

• select the file and click the right button of the mouse and select 'cut' option which 
removes the file from that location and copies into clipboard area. 

• Then select the other folder in which you want to copy the file and press the right 
button of the mouse and choose 'paste' option. Which copies the file in to the 
present directory. 

6. To copy a file from one folder to another, folder : 

 Follow the above steps but in first step instead of 'cut' select 'copy' option. 

7. To delete a file or folder : 

 First select the file or folder, which is to be deleted and press the right button of the 
mouse and choose 'delete' option. 

8. Renaming Files and Folders : To rename a file or folder, right click its icon and chose 
Rename from the menu. A box appears around the current name, and the entire name is 
selected. Type the new name in the box and press ENTER. 

9.  Inserting a file into another file : File Manager supports linking and embedding the 
files. Through OLE (Object Linking and Embedding) user can use File Manager to embed a file 
into another file or link a file to another file. 

10. Setting File Attributes :   The attributes of a file or folder include these settings, which 
can be selected for each file or folder. 

• Read-Only : You can read this file or folder, but not accidentally delete or 
change it. If you try to delete a read-only file or folder, Windows asks if you really 
want to delete it. 
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• Hidden :   File or folder that doesn't usually appear in Folder or Windows 
Explorer Windows. 

• Archive : Depending on which backup programs you use, this setting may 
mean that the file or folder has been changed since the last time it was backed 
up. 

• System : This file or folder is part of Windows itself, and does not usually 
appear in Folder or Windows Explorer windows. 

 The attributes of a file or folder appear at the bottom of the General tab of the Properties 
dialog box. 

11. Printing a File : Using File Manger a fife associated with the application can be printed. 

12. Sorting the contents of a Folder : The Icons in a folder can be sorted automatically by 
name (alphabetically), by file type, by size (from smallest to largest) and by date (earliest to 
most recent). Selecting View/Arrange icons can make any of this 

13. Selecting a single File or Folder : In the contents list, user can select a single file or 
folder and then use File Manger commands to work with it. 

COMMANDS USED FOR CUT, COPY AND PASTE THE INFORMATION 

 Cut and Paste is a feature of Windows that lets you select information from one file and 
move or copy it to another file (or another location in the same file). Cut and Paste works by 
storing information temporarily on clipboard. The following cut and Paste techniques enable you 
to copy or move information within or between any Windows application : 

• Cut : Removes selected information from its current location and stores it (temporarily) 
on the Clipboard. 

• Copy : Copies selected information and makes a (temporary) copy of it on the 
Clipboard. 

• Paste : Copies all the information on the Clipboard to the location of the cursor in the 
active application. 

 To move information, you select it, cut it to the Clipboard, and then paste it in the new 
location. To copy information, you select it, copy it to the Clipboard, and then paste it in the new 
location. 

21.4 SELF ASSESSMENT QUESTIONS: 

1. How to install new programs in windows? 

2. What is file management? Explain 

3. How to create the files and folders in windows? 
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4. How to search the files and folders in windows? 

5. Write about the cut, copy and paste? 

21.5 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 
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WORD PROCESSING 
22.0 OBJECTIVE : 

• To know the applications, features and advantages of word processing under MS-
WORD  

STRUCTURE: 

22.1 Introduction 

22.2 Applications of Word Processing 

22.3 Features of Word Processing  

22.4 Advantages of Word Processing 

22.5 Self Assessment Questions 

22.6 Reference Books 

22.1 INTRODUCTION:  

 M.S. Word is used for word processing. Among the many word processors, M.S. Word is 
the most famous word processor. Word processing means typing the words or information. 
However, word processing not only involves typing but also editing and formatting letters, 
notices, memos or any other textual information. 

22.2 APPLICATIONS OF WORD PROCESSING: 

 Some of the areas where word processing are used given below. 
o A letter requesting leave or order in an office. 
o A notice given, to appeal to members 
o A report sending by a manager to head office. 
o An essay creating by a student. 
o A brochure used for admission in Schools, Colleges and Real Estate Offices. 

22.3 FEATURES OF WORD PROCESSING  

With word processor, like M.S. Word, we can type, edit, save and print the various 
letters, documents, notices, memos and statements. We can have many facilities in Word 
processor than a type writer. 

 A word processor has many unique features as discussed under: 

1. Typing Easy: In M.S. Word, typing is so easy because (a) we need not click enter 
button after the end of a line as in the case of type writer. The word processor itself 
takes the matter to the next line of the document. This facility is called word wrapping, 
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(b) There is no limit for typing the matter in word processing. You can type the matter 
continuously without resorting to new page or file. But in a type writer, if you complete a 
page, you have to take another blank page and start typing, (c) You can easily rectify 
mistakes as the typed matter appears on the screen.  

2. Saving: The document so typed can be stored for future use. The process of storing Is 
called saving. We can preserve the document for any number of years in word 
processing. 

3. Adding, Removing and Copying Text: Documents can be modified easily in M.S. 
Office. We need not strike off any word as in the case of type writer. We can easily place 
a new word in place of existing one. The new words or paras will automatically be 
adjusted in the place of deleted or modified text. We can also copy a part or whole of the 
matter from one file or document to another document. 

4. Spell Check of Words: The spellings of words in the document can be rectified 
automatically. We can find alternative words to our typed words. Not only that, even the 
grammatical errors can also be rectified in word processor. 

5. Change the Style and Shape of Characters and Paragraphs:   The documents 
in word processor can be made attractive and appealing. Because the shape and style 
of characters or letters in the documents can be changed according to our requirements. 
You can even change the gap between one line and other line in the document. This 
process is called line spacing. Not only the lines but also paragraphs can be aligned to 
make it more appealing to the readers. This facility is called alignment in word 
processing. 

6. Bullets and Numbering:    Bullets are special symbols which can be put for different 
points or paras in a document whereas numbers are ascending figures like 1, 2, 3 etc. 
which can be assigned to different points in the para or document. In word processor we 
can assign such bullets or numbers automatically with a single command. 

7. Headers and Footers: A Header is the text appearing above the document and 
Footer is the text appearing below the document. In Word processor, we can create 
these Headers and Footers in the document easily. 

8. Creation of Tables: Tables can be created neatly in word processor. If you give 
directions for required number of rows and columns, word provides a ready made table 
to work. 

9. Inserting Pictures Objects : A  picture is worth 1000 words. In word processor, we 
can insert the picture in the document to make it more attractive. These pictures can be 
obtained from clip art which is available in word processor. 

10. Preview Facility: Before getting a print of our document, we can get a preview of 
document. If mistakes are there, we can change the document. 

11. Mail Merge Facility : If we want to send the same information to different persons, 
there is a facility in Word Processor known as Mail Merge. The main body of the letter 
can be typed once and we can send the same to different addresses. 
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OTHER FEATURES OF M.S. WORD PROCESSING  

 In addition to above features, the following are the additional features in word 
processing. 

a. Paper Size and Orientation: We can select any size of paper and orientation in M.S. 
Word. We can select a small paper for visiting card and a middle size paper for typing a 
notice etc.  

b. Macros: With the help of macros, we can avoid certain type of repetitive works. This 
saves our time and efforts. 

c. Multi-column Facility: We can create different columns to form the text on it. 

d. Index and Table of Contents: We can even prepare the index and table contents in 
M.S. Word. 

e. We can link the word documents with web pages in Internet. 

22.4 ADVANTAGES OF WORD PROCESSING 

 The following are the advantages of word processing. 

1. QUALITY : It produces error free documents. The spell and grammar check in word 
processing makes the document to be neat and error-free. We can get multiple copies of 
excellent formatted nature in word Processing. 

2. STORAGE OF TEXT : We can take any number of copies with word processor. Not 
only that, if we need the same document with some slight changes, we need not type 
the same letter again. Just by making some slight changes, we can obtain a modified 
copy easily. 

3. TIME SAVING : We can get any number of copies of document in future without 
retyping. We can get the copy of document on any printer also. 

4. SECURITY : We can protect the documents in word processing by giving passwords. 
So there is a less chance of viewing the documents by unauthorized persons. 

5. DYNAMIC EXCHANGE OF DATA : We can have dynamic exchange of objects and 
pictures from other documents into word processing documents. The documents can be 
linked-each other. 

22.5 SELF ASSESSMENT QUESTIONS 

1. Explain the various applications of word processing? 

2. Explain the features of word processing? 

3. Explain the advantages of word processing? 
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LESSON - 23 

MS-WORD 
23.0 OBJECTIVE: 

• How to invoke MS Word and displays document window. 
• To know how to use the MS-Word, Creating a new document, Entering some text and 

editing 
• To know how Saving a document, Opening an existing document and Closing a 

document 

 

STRUCTURE 

23.1 Introduction 

23.2 Microsoft Word 

23.3 Procedure to start MS-Word 

23.4 Components of standard Word Window 

23.5 Documents and its different views 

23.6 Self Assessment Questions 

23.7 References 

23.1 INTRODUCTION:: 

 All the application oriented programmes in windows are categorized under the heading 
MS-OFFICE. One of the important features of MS- Windows is MS-OFFICE.  It is otherwise a 
bunch of application software programmes.  The user can make use of any of the software 
programmes independently.  It has several versions like MS OFFICE 978, MS OFFICE 2000, 
MS OFFICE XP, and so on.  This MS-OFFICE is coming in two types.  The first one is known as 
Standard Type and the second one is the Professional Type (here MS-OFFICE XP professional 
has been discussed). 

 It consists of the following independent application software packages. 

• Microsoft Word 
• Microsoft Excel 
• Microsoft PowerPoint 
• Microsoft Access 

       • Microsoft Publisher and so on. 
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23.2 MICROSOFT WORD: 

 This is the word processor through which one can type the text, edit the text, merge the 
text and print the text.  It is a user friendly word processor.  With the help of this software one 
can setup the page to be typed by fixing the margin,  line spacing, font sizing and so on.  Also it 
is possible for the user to attach header and footer facility and inserting the page numbers in 
this word.  It contains spell check and grammar facilities through which the correct spelling may 
be checked and the grammatical correctness may also be checked.  Almost all types of figures 
like lines rectangles, circles, etc can be drawn in this software. 

 This package of application is meant for word processing.  All the companies and 
organizations in almost all the countries are using this software for preparing their documents.  
It is shortly known as word. 

Processes on word: 

 1. Starting MS Word 
 2. Creating a new document 
 3. Entering some text and editing 
 4. Saving a document 
 5. Opening an existing document 
 6. Closing a document 

Equipment/Resources required: 

 A personal computer,  MS-Word software. 

23.3 PROCEDURE TO STARTING MS WORD: 

 The steps to be followed to activate MS Word are: 

 1. Check on the Start button in the task bar 
 2. Select the programs option from the start menu. 
 3. Choose Microsoft Office 
 4. Click on Microsoft Office Word option  

 

Fig: PROCEEDURE TO ENTER INTO WS-WORD 



 
 
Business Data Processing Systems   23.3  MS-Word      
 

  

  This invokes MS-Word and displays the following window: 

 

23.4 COMPONENTS OF STANDARD WORD WINDOW: 

The Standard Word window has the following components: 

Title Bar:  

 This is the bar at the top of the window.  It contains the Minimize, Restore and Close 
buttons. 

Menu Bar : 

 This provides access to the word menu, items and sub menus. 

Standard Toolbar: 

 This contains buttons for commonly used actions that helps quick actions. 

Formatting Toolbar: 

 This contains buttons to formatting text for changing the appearance of text. 

Status Bar: 

 This is displayed at the bottom of the screen.  It shows information about the current 
page, section, line and column numbers. 
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Scroll Tools :  

 These tools helps you travel with in your document using the horizontal  and vertical 
scroll bars. 

 A number of other toolbars are available or you can create your own using any 
combination of menus and buttons.  Toolbars can be dragged and attached to the top, side or 
bottom of the word window or can be made to float inside the window. 

Displaying only the commands and buttons that you use: 

Microsoft Office automatically customizes menus and toolbars based on how often you 
use the commands. When you first start an Office program, only the most basic commands 
appear. Then, as you work, the menus and toolbars adjust so that only the commands and 
toolbar buttons you use most often appear. 

Displaying all the commands on a menu: 

To look for a command that you don't use often or have never used before, click the 
arrows at the bottom of the menu to show all the commands. You can also double-click the 
menu to expand it. When you expand one menu, all of the menus are expanded until you 
choose a command or perform another action. When you click a command on the expanded 
menu, the command is immediately added to the short version of the menu. If you do not use 
the command often, it is dropped from the short version of the menu. 

Positioning toolbars on the same row: 

Toolbars can be positioned next to each other in the same row. For example, the 
Standard toolbar is positioned next to the Formatting toolbar when you first start a Microsoft 
Office program. When you put multiple toolbars in the same row, there might not be enough 
room to display all of the buttons. If there isn't enough room, the buttons that you have used 
most recently are displayed. 

Seeing all of the toolbar buttons: 

You can resize to display more buttons, or you can show all buttons on a toolbar. To see 
a list of buttons that won't fit on a built-in, docked toolbar, click Toolbar Options at the end of 
the toolbar. When you use a button that is not displayed on the toolbar, that button is moved to 
the toolbar, and a button that has not been used recently is dropped to the Toolbar Options 
list. 

Customizing menus and toolbars: 

You can customize menus and toolbars yourself; you can add and remove buttons and 
menus on toolbars, create your own custom toolbars, hide or display toolbars, and move 
toolbars. You can customize the menu bar the same way you customize any built-in toolbar—
 for example, you can quickly add and remove buttons and menus on the menu bar— but you 
can't hide the menu bar. 
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23.5 DOCUMENTS AND ITS DIFFERENT VIEWS 

CREATING A NEW DOCUMENT:  

 You can create a document from scratch or base it on a template or use a wizard. Using 
the Standard toolbar you can create a document quickly with the Normal template by clicking 
the new button. 

 • Click file from the main menu 
 • Click New from the drop-down menu or press Ctrl + N. 
 • Select Blank Document icon *. Click the OK button 

OPENING A DOCUMENT: 

 The Open command on the File menu opens a document thai has been saved on a disk. 
A file can be opened either by clicking the Open button on the Standard toolbar or by choosing 
Open option from the File menu. 

 • Click the from the main menu or press Alt + F keys 
 • Click Open from the drop-down menu or press Ctrl +O. 
 • Select the file name 
 • Click the open button  

SAVING A Document: 

 The Save button on the Standard toolbar is used to save a document or the Save 
command frequently to preserve your work. You can also use the Automatic Save feature to 
save your work automatically at regular intervals. To prevent other users from opening and 
changing a document, you can protect it with a password. 

•  Click file from the main menu or press Alt + F keys 
•  Click Save As from the drop-down menu or press Alt + A keys 
•  Type the file name  
•  Click Tools option or press Alt f L keys 
•  Select General Options from the drop-down menu or press Alt + G keys 
•  Enter password to open and modify the document. Click the OK button to close the 
dialog box. 
•  Enter password to open and modify live document. Click the QK button to close the 
dialog box. 
•  Tick the Save button to save the file with different name 

CLOSING A DOCUMENT: 

 You can close a document without quilting Word. If you changed the document since you 
last saved it, Word asks if you want to save the document. If you are working on a network, 
closing a document makes it available to other users on the network.  

 • Select the title “...............” 
 • Click the down arrow of the font size combo box 
 • Click the Hold button to change the text to bold 
 • Click the close button to close the document 
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 • Click the Yes button to save the changes made 

DIFFERENT VIEWS OF DOCUMENTS IN WORD 

NORMAL VIEW: 

 Normal view is the default document view you probably will use for most typing, editing, 
and formatting. To switch to normal view, click the Normal View button on the horizontal scroll 
bar. or choose Normal from the View menu. To work faster in normal view, select the Draft font 
check box on the View tab in the Options dialog box (Tools menu). This limits the number of 
font sizes and simplifies alignments and spacing.  

OUTLINE VIEW: 

 In outline view, you can collapse a document to see only the main headings or expand it 
to see the entire document, This makes it easy to move and copy text and to reorganize long 
documents. To switch to outline view, click the Outline View button on the horizontal scroll bar, 
or choose Outline from the View menu. 

PAGE LAYOUT VIEW: 

 In page layout view, you can see a document just as it will look when printed and refine its 
text and formatting. To switch to page layout view, click the Page Layout View button on the 
horizontal scroll bar, or choose Page Layout from the View menu.  

PRINT PREVIEW: 

 Print preview shows entire pages at a reduced size so that you can view one or more 
pages at a time, check page breaks, and make changes to text and formatting. To switch to 
print preview, click the Print Preview button on the Standard toolbar, or choose Print Preview 
from the file menu.  

MASTER DOCUMENT: 

 A master document helps you organize and maintain a long document, such as a book or 
a multi part report, that is divided into several separate documents called subdocuments. In 
master document view, you can work in a single document window and still see the overall 
organization of all parts of the master document. To switch to master document view, choose 
Master Document from the View menu.  

FULL SCREEN VIEW: 

 To see only a document on screen - without rulers, toolbars, and other screen elements - 
choose Full Screen from the View menu. In full screen view, you can choose commands with 
shortcuts keys and display shortcut menus while you work. To return to the previous view, click 
the Full Screen button in the bottom-right corner of the screen or press ESC. 
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23.6 SELF ASSESSMENT QUESTIONS: 

1. Explain about the Microsoft word? 

2. What is the procedure to start Ms-Word? 

3. Explain the Components of standard word window? 

4. Explain how to create open and save the Documents in Ms-Word? 

5. Explain different views of documents in Ms-Word? 

23.7 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 
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LESSON - 24 

MENUS IN MS-WORD 
24.0 OBJECTIVE:  

 to know about the menus in MS-Word 

STRUCTURE 

24.1 Introduction 

24.2 Menus in MS-Word 

24.2.1 File menu  

24.2.2 Edit menu 

24.2.3 View menu 

24.2.4 Insert menu  

24.2.5 Format menu  

24.2.6 Tools menu  

24.2.7 Table menu  

24.2.8 Window menu 

       24.2.9  Help menu  

24.3 Self Assessment Questions 

24.4 References 

24.1 INTRODUCTION: 

A menu displays a list of commands. Some of these commands have images next to 
them so you can quickly associate the command with the image. Most menus are located on 
the menu bar, which is the toolbar at the top of the screen. Toolbars can contain buttons, 
menus, or a combination of both. 

24.2 MENUS IN MS-WORD: 

 The following are the 9 different menus that are available under MS-Word application 
window. 
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  1)  File menu  2) Edit menu  3) View menu 
  4) Insert menu   5) Format menu  6) Tools menu  
  7) Table menu   8) Window menu  9) Help menu  

FILE MENU :  

 This menu contains all operations related to document file. The options are as follows : 

 

File Menu 

New : This option is used to  create a new blank document. 

   Select File menu and New option 
   Press   Ctrl + N keys using keyboard.  

Open : This option is used to open the existing document. 

   To   open   the   existing document. 
   Select File menu and open option 
    Select the document to open from the File, open DIALOG box  
    Click on open button  
     (OR) 

   Press Ctrl +   O keys using keyboard 

Close : This option is used to close the active file without exit the application. If the file contains 
any unsaved changes, you will be prompted to save the file before closing. 

Save : This option saves the active file with its current file name, location and file format. In 
c~se a new file is saved for the first time, the user has to specify the file name, location and file 
format. 

 To save the document -"   Select the File menu and Save option 
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  If the file is new file then a Save As DIALOG box is displayed 
  Select the location and enter the file name and select the file format 
  Click on Save button 
  If it is already saved file then unsaved changes are saved 

   (OR) 

  Using keyboard Press Ctrl + S keys 

Save As : This option is used to save the active file with different file name, location or file 
format. 

  To save the file with different file name  
     Select File menu and Save As option 

 

SAVE AS DIALOG BOX 

     A Save As DIALOG box is displayed. Select the file location, file name, file format  

    Click on Save button 

Save As Web Page : This option is used to save the file in Web Page format required for 
creating documents for the Internet. 

Versions : This option saves and manages multiple versions of a document in a single file. 
After you save version of document, you can go back and review, open, print and delete earlier 
versions. 

Web page preview : Allows you to preview the current file as web page in your browser so 
that view it before publishing it. 

Page setup : This option is used to set the margins, paper source. paper size, page 
orientation and other layout options for the active file. 
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Print preview : This option shows a preview of how exactly a file will look when we give print. 

Print : This option is used to print a file or selected items, to the selected printer or fax. 

Send To : This option is used to send a document to a Mail Recipient as an e-mail. 

Properties : This option displays the property sheet for the active file. 

Exit : This option is used to exit or Quit from the MS-Word 

EDIT MENU: 

 This menu contains all the options related to editing the document. 

 

Edit Menu 

Undo last command (S) : Reverses the last command i.e. undoes the effect of the last 
executed command. 

Repeat last command (S) : Reverses the undo command i.e. restores the last command. 

Cut : Removes the selection from the active document and places it on clipboard - a special 
place in computer's  Copies the selection to the again. Copy clipboard. 

Paste : Inserts the contents of the clipboard at the insertion point and replaces any current 
selection, (block) 

Paste special : Pastes, links or embeds the clipboard content in the current file in the format 
you specify. 

Clear : Deletes the selected object or text without putting on the clipboard. 
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Select all : Selects all text and graphics in the active window or selects all text in the selected 
object. 

Find : Searches for specified text, formatting, symbols, comments, footnotes, endnotes in the 
active document. 

Replace : Searches tor and replaces specified text formatting, footnotes, endnotes or 
comment mark in the active document. 

Go To : Moves the insertion pointer to the item where you want to go. 

Links : Displays or changes information for each link in the current file, including the name and 
location of the source file, the item, the type and whether the link is update automatically or 
manually. 

Object : Activates the application in which the selected object was created so that you can edit 
it.  

VIEW MENU :  

 This Menu contains all the options related to viewing the document window. 

 

View Menu 

Normal: Switches to normal view, which is the default document view for most word 
processing tasks. 

Web layout : Switches the active document to web layout view, which is an editing view that 
displays your document as it will appear on the web as a web page. 

Outline : Switches to outline view, where you can examine and work with the structure of your 
file in classic outline form. 
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Toolbars: Toolbars allow you to organize the commands in word, the way you want so that 
you can find and use them quickly. Tool bars can contain buttons (icons), menus, or a 
combinations of both. The menu bar is a special toolbar at the top of the screen that contains 
menus such as File, Edit and View etc. A menu displays a list of commands. 

Ruler : Displays or hides the horizontal ruler, which you can use to position objects, changes 
paragraph indent, page margins and other space settings. 

Document map : Turns the document map on or off which is a vertical pane along the left 
edge of the document window that outlines the document structure. 

Header and Footer : Adds or changes the text that appears at the top and bottom of every 
page or slide. 

Footnotes : Footnotes explain, comment on, or provide references for text in a document. 
Footnotes appear at the end of each page in a document. 

Comments : Displays all comments made by all reviews in the comment pane. 

 Full screen : Hides most screen elements so that you can view more of your document. 

Zoom : Enter a magnification between 10 to 200 percent to reduce or enlarge the display of 
the active document. 

INSERT MENU :  

 This menu contains all the options related to inserting the document. 

 

Insert Menu 

Break : Inserts a column, section or page break. 

Page Numbers : Inserts page numbers in your document pages that automatically update 
when you add or delete pages. 



 
 
Business Data Processing Systems   24.7  Menus in MS-Word      
 

  

Date and Time : Inserts current date and/or current time field that is updated every time you 
open or print this document. 

Auto text: You can use Auto Text to store text or graphic you plan to reuse, such as product 
names, boilerplate text, a company logo, or a formatted table. 

Field : Inserts a field at the insertion point. Use fields to insert a variety of up-to-date, 
information automatically. 

Symbol : Inserts symbols and special characters from the fonts that are installed on your 
computer. 

Comment : Inserts a comment at the insertion point. 

Footnote : Inserts a footnote and/or endnote at the insertion point. 

Caption : Inserts captions for tables, figures, equation and other items. 

Cross-reference : Inserts a cross-reference to an item in a document. 

Index and Tables : Creates indexes, tables of contents, tables of figures, tables of authorities 
and other similar tables. 

Picture : Insert pictures from clip art and other libraries. 

Text Box : Draws a text box where you click and drag in the active window. 

File : Inserts all or part of the file you select into the active file at the insertion point. 

Object : Inserts an object such as a Drawing, Word Art Text affect etc. at the insertion point. 

Book mark : Creates book mark which you can use to mark selectee points in your, 
document. 

Hyperlink : Insert a hyperlink through which you can jump to a location in the current 
document or web page or to a different word document or web page, or to a file that was 
created in a different program.  

FORMAT MENU : 

 This menu contains all the options related to format the document. 
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Format Menu 

Font : Changes the font and character spacing formats of the selected text. 

Paragraph : Changes paragraph indents, text alignment, spacing, pagination and other 
formats in the selected paragraph. 

Bullets and Numbering : Adds and modifies bullets or numbers in selected paragraphs. 

Borders and shading : Applies shading effect and creates borders around selected area. 

Columns : Changes the number of columns in a document or a section of document. 

Tabs : Sets the position and alignment of tabs and determines the type of leader character for 
each tab stop. 

Drop cap : Formats a letter, word or selected text with a large initial or dropped capital letter. 

Text direction : Rotates selected text in table cells, so you can read it from bottom to top or 
from top to bottom. 

Change case : Changes the capitalization of selected text. 

Background : Add different kinds of background, such as a woven texture, to word 
documents and web pages to make them look more interesting. 

Theme : Applies a new or different theme, or removes a theme in a web page, document, e-
mail message, a data access. 

Page : A theme is a set of unified design elements and colour schemes for background 
images, bullets, fonts, horizontal lines, and other document elements. 
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Frames : Creates a table of contents using the headings of your documents and places it in 
the left frame of a frames page. It also creates a new frames page. 

Auto Format : Analyzes the content of the active file and then automatically formats the file. 

Style : Defines or applies to the selection of combination of formats called a style. 

Object : Formats the line, color, fill and pattern, size, position and other properties of the 
selected object. 

Tools Menu : 

 

Tools Menu 

• Spelling and Grammar : Checks the active document for possible spelling, grammar and 
writing style errors, and displays suggestions for correcting them. 

• Language : Designates the language of selected text in a file that contains more than one 
language. 

• Word count : Counts the number of pages, words, character, paragraphs, and lines in the 
active document. Punctuation marks & special symbols are also included in the word document. 

• Auto summarize : Automatically summarizes the key points in the active document. 

• Auto correct : Sets the options used to correct text automatically as you type, or to store 
and reuse text and other items you use frequently. 

• Lookup Reference : To insert lookup references and cross references. 

• Track changes : Marks changes in the current document and keeps track of each change 
by reviewer name. 



 
 
Centre for Distance Education   24.10   Acharya Nagarjuna University   
 

 

• Merge documents : Merges the tracked changes from the active document into the 
specified document, which word opens if it is not open already. 

• Protect Document : Prevents changes to all or part of an online form or document except 
as specified. You can also assign a password so that other users can annotate a document, 
mark revisions, or fill in parts of an online form. 

• Online collaboration : Starts an improper online by sending an invitation to participants 
who must be running Microsoft Net meeting on their computers. 

• Mail merge : Use this option to create form letter, mailing labels or envelopes with same or 
different address. Through Mail Merge you can automatically create personalised letters to 
many different people. 

• Envelopes and Labels : Creates an envelopes or a single mailing label, or inserts the 
same name and address on an entire sheet of mailing labels. 

• Letter wizard : Runs the letter wizard, which helps you quickly create letters. 

• Macro : Opens the Macro dialog box, where you can run, edit or delete a macro. 

• Templates and Add-ins : Attaches a different template to the active document, loads add-
in programs, or updates a document's style. 

• Customize : Customize tool bar buttons, menu commands, and shortcut key assignments. 

• Options : Modifies settings for MS-Office programs such as screen appearance, printing, 
editing, spellings and other options. 

TABLE MENU :  

 

Table Menu 

• Draw table : Inserts a table with the specified rows and columns, in the current document. 
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• Insert: Inserts tables. 

• Delete : Deletes the entire table. 

• Select: Selects the table, columns, rows, or cells that contains the insertion point. 

• Merge cells : Combines the contents of selected adjacent cells into a single cell. 

• Split cells : Splits the selected cells into the number of rows and columns you enter. 

• Split table : Divides a table into two separate tables and inserts a paragraph mark above the 
row that contains the insertion point. 

• Table Auto Format : Automatically applies formats including predefined borders or shading to 
a table. Auto format resizes a table to fit the contents of the table cells. 

• Auto Fit : (a) Distribute Rows Evenly : Changes the selected columns or cells to equal 
column width. 

• (a) Distribute columns evenly : Changes the selected rows or cells to equal row width. 

• Heading Rows Repeat : Designates the selected rows to be a table heading that is repeated 
on subsequent pages if the table spans more than one page. 

• Convert : Text to table converts a range of text entries into a table. 

• Sort: Sorts a range of cells in ascending or descending order based upon selected criteria. 

• Formula : Performs mathematical calculations on numbers. 

• Hide Gridlines : In a table, the Gridlines commands displays or hides dotted gridlines to help 
you see which cell you are working in. 

WINDOW MENU : 

 

Window Menu 
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• New window : Opens a new window with the same contents as the active window. So you 
can view different parts of a file at the same time. 

• Arrange all : Displays all open files in separate windows on the screen. The arrange 
command makes it easier to cut, copy and paste between files. 

• Split: Splits the active window into panes. The user can specify the size of two windows. In 
case the current window is already split this option would change to remove split and can be 
used to remove the split. 

HELP MENU : 

 

Help Menu 

• Microsoft word help : To launch the MS-Office Assistant, which provides help and tips to you to 
execute many tasks. 

• Show the Office Assistant : Displays or removes the Office Assistant from view. 

• What's this ? : Provides help on the topic which is clicked on. 

• Office on the web : Provides a link to Microsoft's home site containing, free stuff, feedback, answers to 
frequently asked questions, technical help etc. 

• Word perfect help : Helps you learn the word equivalents for word perfect for DOS commands and key 
combinations. 

• Detect and Repair : Automatically finds and fixes errors in this program. 

• About Microsoft word : Show you the word's version details and Copyright message along with 
detailed information about your Computer system. 
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24.3 SELF ASSESSMENT QUESTIONS: 

1. Explain various menus in MS-Word? 

2. Explain file menu options in MS-Word? 

3. Explain view and insert menu options in MS-Word? 

4. Explain format menu options in MS-Word? 

5. Explain tools menu options in MS-Word? 

6. Explain table menu options in MS-Word? 

24.4 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 
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LESSON – 25  

FORMATTING IN WORD 
25.0 OBJECTIVE: 

 Learn About How to Formatting Text Characters And Formatting Paragraph 

STRUCTURE 

25.1 Introduction 

25.2 Character formatting 

25.3 Paragraph formatting 

25.4 Introduction to macros 

25.5 Creating, copying and deleting a macro 

25.6 Self Assessment Questions 

25.7 References 

25.1 INTRODUCTION: 

 Formatting is a process to change the appearance of the text document to be attractive 
and easier to read. Broadly, text formatting is divided into 2 categories: 

 I) Character Formatting 
 II) Paragraph Formatting 
 

25.2 FORMATTING TEXT CHARACTERS: 

 When you start Word a blank document appears, ready for use to start typing. A blinking 
vertical bar, called the insertion point, indicates where the text will appear when you type. Word 
automatically wraps text to the next line. You press Enter only when you want to start a new 
paragraph. You can delete characters to either the left or right insertion point. When you want to 
change something in a document, you first mark what you want to change. This is called as 
selecting. A common way to select is to hold down the left mouse button and move the mouse 
pointer over the text you want to select to highlight it. Selecting an item also means simply 
placing the insertion point within it, between documents, and to and from other windows - based 
on applications. 
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 Characters are letters, numerals, symbols such as &,!, @, *, punctuation marks and 
spaces etc. Character formatting is concerned with the altering the appearance of the selected 
text. 

 To change the appearance of the text, select the text and then apply the formats you 
want. If you choose a command without selecting text, word applies the formats at the insertion 
point. Character formatting tools include 

  - Select Fonts 
  - Select Font sizes 
  - Select underline styles 
  - Adding effects like superscript, subscript etc. 
  - Change default characters 
  - Change character spacing 
  - Insert special characters and symbols 
  - Change case 
  - Create drop caps 

 Character formatting can be applied using 

  a) Formatting Toolbar 
  b) Font DIALOG box 

a) Using Formatting Toolbar : It offers a quick way to apply some of the most commonly 
used character formatting options. 

 

Formatting Toolbar 

b)  Using Font DIALOG box : The following are the steps to perform character formatting 
using Font DIALOG box. Font settings: 

  1) Select the text that has to be formatted 
  2) Select Format menu and Format menu is displayed 
  3) Choose the Font option, and then a Font DIALOG box is displayed with 
   3 tabs (Font, Character spacing and Animation) 
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Font DIALOG box 

4) To apply the Font settings on the selected text, to activate the Font tab. Choose the 
required font, required style and required size. 

5) Select the underline type and font color if required. 

6) Check the effects check boxes which are required. Effects include strike through, double 
strike through, superscript, subscript, shadow, outline, emboss, engrave, small caps, All caps 
and hidden. 

7) A sample is displayed at the bottom with the chosen settings applied. On looking at the 
preview click c:. OK button. 

8)   The selected font settings are applied on the selected text.  

Character Spacing : 

The following are the steps to perform character spacing. 

1) Spacing allows over riding the standard spacing between characters in terms of 1 point. 
2) Choose the text of interest. 
3) Select the character spacing tab in Font DIALOG box. 
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4) Select Expanded/Condensed from the spacing list. 
5) Choose a new setting by typing in the By option box or clicking on the triangles and watch 
the preview change. 
6) Click OK button to save change.  

Changing the letter case : 

 The following are the steps to change the case of text in the document.  

  Select the text. for changing the case  
     Select the change case option from Format menu  
  A change case DIALOG box is displayed. 

 
Change case DIALOG box 

    

 



 
 
Business Data Processing Systems   25.5  Formatting in Word       
 

  

   Option    Description 

   Sentence case To make the first character of the sentence upper case 
and rest in the lower case 

   Lower case To make all the characters to lower case 
   Upper case To make all the characters to upper case 
   Title case To make the first character of each word to upper case 
   Toggle case To make the reverse of the case for all characters 

 

25.3  FORMATTING PARAGRAPH: 

 In Word, a paragraph is any amount of text, objects, graphics or other items that are 
followed by paragraph mark. For every ENTER key a new paragraph is created and paragraph 
mark is inserted.  

 The following are some of the formatting characteristics of a paragraph. 

  - Alignment 
  - Indentation 
  - Spacing  

ALIGNMENT 

 Word is preset to align text Hush left with the left margin, producing a ragged right edge. 
However, you have the option of centering text, aligning it along the right margin, or expanding 
the spaces in each line to align text at both the left and right margins. Alignment means an 
arrangement of text into suitable order in the paragraph. Basically, the elements can be done in 
4 ways - Left Alignment, Right Alignment, Centre Alignment and Justify Alignment. 

 The alignment you select affects all text in the selected paragraph. 

 • Click the from the mum menu or press Alt + F key 
 • Click Open from the drop-down menu or press CU40. 
 • Select the file  “........” 
 • Click the Open button 
 • Select the title 'Union is strength”. 
 • Click the Center tool button to align the title to center 
 • Click any where on the screen to deselect the title 
 By default the text in. MS Word is left aligned. These alignments can be changed. 
  - Using Alignment buttons on Formatting Toolbar 
  - Using Keyboard shortcuts 
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Steps to align paragraph : 

1) Place the insertion point anywhere in the paragraph. If multiple paragraphs are to be 
aligned select all paragraphs. 

2) Click the Alignment button on the Formatting Toolbar.  

Keyboard shortcuts : 

   Alignment Name  Keyboard Shortcut 

    Left   Ctrl + L 
    Right   Ctrl + R 
    Center   Ctrl + E. 
    Justify   Ctrl + J 

Indentation: 

 Text in paragraphs usually extends from the left margin lo the right margin.  You can 
indent a paragraph to set it off from other text.  

 • Select the paragraph to change the indent 
 • On the formatting toolbar click the Increase Indent button or press Ctrl+M  
 • A Click Decrease Indent button on the Formatting Toolbar to change it  

 Indenting a paragraph enables it to set off from other text. 

 - To indent paragraphs automatically, drag the top half of the triangular indent marker 
to right to the desired position. Alternatively, you can select paragraph option under 
Format menu and enter a setting the first line Indent box in paragraph DIALOG box. 

 - To increase or decrease indents by one Tab stop, use the Increase Indent and 
Decrease Indent button on the formatting toolbar. 

 - To create the hanging indent, drag the top half of the triangular indent marker to the 
left to the desired position. Alternatively, you can also select the paragraph option 
under Format menu and enter a setting for the first line indent box in the paragraph 
DIALOG box that farther left than the indent of the paragraph as a whole. 

Line spacing : 

 The space between two lines can be adjusted in the document. The following are the 
steps to set the line spacing. 
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Paragraph DIALOG box 

 1) Select the text for which the line spacing is to be adjusted. 
 2) Click on Format menu and select the paragraph option. Then a paragraph DIALOG 
box is displayed. 
  3) Select the Indents and spacing tab. 
 4) Select the line spacing option single, double spacing. 
 5) Click on OK button for implementation of line spacing.  

Keyboard shortcuts of Line spacing 

   Keys   Description 

   Ctrl + 1   Single line spacing 
   Ctrl + 5   1 1/2 line spacing  
   Ctrl + 2   Double spacing 

MACROS 

25.4 INTRODUCTION TO MACROS: 

 If you perform a task repeatedly in Word, you can automate the task using a macro. A 
macro is a series of Word commands and instructions that you group together as a single 
command to accomplish a task automatically. Instead if manually performing a series of time-
consuming, repetitive actions in Word, you can create and run a single macro-in effect, a 
custom command - that accomplishes the task for you. 

 Word offers two ways for you to create a macro: 

  * Macro Recorder 
  * Visual Basic Editor 

 After you've assigned a macro to a toolbar, a menu or short keys, running the macro is as 
simple as clicking the toolbar button or menu item or pressing the shortcut keys. You can also 
point to Macro on the Tools menu, click Macros, and then click the name of the macro you want 
to run. 
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25.5 CREATING, COPYING AND DELETING A MACRO! 

CREATE A MACRO: 

 To create a macro in Word, start the macro recorder and perform a sequence of actions. 
You can then run the macro whenever you need to perform this sequence. For example, if you 
often need to insert a specifically formatted table in your documents, you can record a macro 
that inserts the table with the correct borders, size, and number of rows and columns. 

 When you're recording a macro, you can use the mouse to click commands and options, 
but the macro recorder doesn't record mouse movements in a document window. For example, 
you can't use the mouse to move the insertion point or to select, copy, or more items by clicking 
or dragging. You must use the keyboard to record these actions. When you're recording a 
macro, you can temporarily pause recording and then resume recording where you stopped. 

• Click file from the main menu or press Alt+F key 
• Click New from the drop-down menu or press Ctrl+N. 
• Select Blank Document icon 
• Click the OK button 
• To start recording a Macro, Select the Tools menu, go to Macro and select Record Macro 

option 
• Click the OK button in the Record Macro dialog box 
• To insert a table, select Table menu, go to Insert and Select Table option. 
• Click the Auto Format button to change the format of the table. 
• Select the 'Classic V style   
• click the Ok button to confirm 
• Click the Stop button on the Stop Recording Toolbar to stop the recording  

COPY A MACRO: 

 You can copy Agriculture macro to use in another document or template using the 
Organizer. 

• On the Tool menu, point In Macro, and then click Macros. 
• Click Organizer. 
• Select the macros you want to copy from either list, and then click Copy. 

 Word displays the macros used in the active document in the list on the left and the styles 
in the Normal document template in the list on the right  

• Click file from the main menu or press Alt+F key 
• Click New from the drop-down menu or press Ctrl+N. 
• Select Blank Document icon 
• Click the OK button  
• To use an existing Macro, go to Macro and select Macros option 
• Click the Run button to execute the macro 
• To copy the macro, select Tools, point to Macros and click Macros  
• Click the Organizer button 
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• To copy the selected macro, click the copy button 
• Click the close button to close the Organizer dialog box  

DELETE A MACRO: 

• On the Tools menu, point to Macro, and then click Macros. 
• In the Macro name box, click the name of the macro you want to delete. 
• If the macro doesn't appear in the list,  
• Select a different list of macros in the Macros in box.  
• Click Delete. 
• To delete a Macro, go to Macro and select Macros option 
• Click the Delete button to delete the selected macro  
• Click the Yes button to confirm the deletion.  
• Click the Close button to close the Macros dialog box. 

 

25.6 SELF ASSESSMENT QUESTIONS: 

1. Explain the character formatting options? 
2. Explain the paragraph formatting options? 
3. What is macro? Explain.  
4. Explain how to create, copy and delete a macro? 

 

25.7 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 
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LESSON - 26 

WORD TOOLS 
26.0 OBJECTIVE 

 At the end of this session, you will be able to learn: 
 • Proof a document 
 • Use the Find and Replace option to make global changes 
 • Preview a document 
 • Print a document 

 

STRUCTURE : 

26.1 Proofing a document 

26.2 Using the spell-check utility 

26.3 Using Automatic spell-check 

26.4 Using Autocorrect 

26.5 Using Auto text 

26.6 Inserting and deleting Auto text entries 

26.7 Using grammar command 

26.8 Find and replace 

26.9 Previewing a document 

26.10 Print a document 

26.11 Printing multiple documents 

26.12 Self Assessment Questions 

26.13 References  

26.1 PROOFING A DOCUMENT 

 When a document is typed, no matter how careful the user is, mistakes are likely 
to be committed. Most of these are spelling errors. Word ensures that every document 
is free of spelling errors, and flags the unfamiliar words with a red wavy underline. 
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26.2 USING THE SPELL-CHECK UTILITY 

 The steps to spell-check a document are: 

1. Select the section of the document to be spell-checked. If nothing is selected, 
Word checks the entire document. 
2. Select the Spelling option from the Tools menu. 
 The Spelling dialog box is displayed. The unfamiliar words are displayed in the 
Not in Dictionary text box and the correct spelling appears in the Change to text box. 

 

Spell DIALOG box 

 3. Click on any one of the buttons explained in table. 

   Button   Function 

Change Replaces the misspell word 
Change All Replaces all occurrences of the misspell word 

in the document 
Ignore Ignores the misspell word 
Ignore All Ignores the word throughout the document 
Add Adds the word displayed in the not in dictionary 

text box to the dictionary 
Undo Last Reverses the last change 
Cancel Discontinues the spell check 

  A dialog box is displayed when the spell - check reaches the end of the 
document or the selection  
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Spell check complete Dialog Box 

26.3 USING AUTOMATIC SPELL-CHECK 

 Word automatically underlines misspelt words with a red wavy line. Spell-checking 
and underlining occurs as the user types. 

 The steps to turn on automatic spell-check are:  
 1.  Select the Options item from the Tools menu. 
 
 The Options dialog box is displayed  

 

Options DIALOG box 

 2. Select the Spelling tab  
 3. Select the Automatic Spell Checking check box.  
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26.4 USING AUTOCORRECT: 

 The AutoCorrect feature of Word recognizes common typing mistakes and 
automatically substitutes the correct spelling for the user. 

 The steps to create entries for AutoCorrect are: 

1.  Select the AutoCorrect option from the Tools menu. 
  The AutoCorrect dialog box is displayed. 

 

AutoCorrect dialog box 

2. Type the misspell word that is often misspell and needs to be corrected 
automatically in the Replace text box. 
3. Type the correct spelling of the word in the with text box. 
4. Click on the Add button to add the new entry to the list of AutoCorrect entries. 
5. Click on the OK button. 

 

26.5 USING AUTOTEXT: 

 The AutoText feature of Word stores text and graphics that are used repeatedly. It 
ensures that repetitive text is typed correctly and consistently. 

 The steps to add text or graphics to an AutoText entry are: 
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1. Select the text or graphic items you want to add to the AutoText entry. 
2. Select the AutoText option from the Edit menu. 
 The AutoText dialog box is displayed. The selected text is shown in the Selection 
box. 

 

AutoText Dialog Box 

3. Type an abbreviated name for the text in the Name text box. 
4. Click on the Add button. 

 

26.6 INSERTING AND DELETING AUTOTEXT ENTRIES: 

 The steps to insert an AutoText entry are: 

1. Position the insertion point at the point where the AutoText entry has to appear. 
2. Select the AutoText option from the Edit menu. 
3. Type an AutoText name or select it from the list in the AutoText name box. 
4. Click on the Insert button. 
 The steps to delete an AutoText entry are: 

1. Select the AutoText option from the Edit menu. 
2. Type the name of the AutoText entry to be deleted in the Name text box or select 
the name from the list. 
3. Click on the Delete button. 
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26.7 USING GRAMMAR COMMAND: 

 The steps to check the grammar in a document are: 

1.  Select the Grammar option from the Tools menu:. 

 The Grammar dialog box is displayed when Word finds, a sentence with a 
possible grammatical error. The grammatically questionable word appears highlighted 
in the Sentence box. 

 

Grammar dialog box 

 The suggestions box displays the possible replacement text. 

2.  Select the suggestion in the Suggestions box and click on the Change button. 

26.8 FIND AND REPLACE: 

 The Find and Replace option of Word is a convenient way of searching for a word 
in a document and replacing it with something else. It can be used in situations where 
an error (not an error in spelling) has been committed consistently in a document and 
has to be corrected. 

The steps to find a specific text or special character are: 

 1.   Select the Find option from the Edit menu. 
 The Find dialog box is displayed. 
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Find Dialog Box 

2. Type the text or special character to be searched in the Find What text box. 
3. Select one or more options explained below.. 
 Option    Description 
 Search   : Determines the direction of the search 
 Match Case  : Matches the text exactly as it is typed, including capital 
letters 
 Find whole words only: Finds whole words only, not parts of words 
 Use pattern matching : Uses search operators and expressions with which to 
search 
 Sounds Like  : Matches words that sound a like 
 Find all word forms : Finds all forms of a word 
  

 Format    : Displays the format options including font, paragraph,  

        language and style 

 Special   : Enables the user to search for special codes in the text,   

       such as tab characters 

 No formatting  : Removes any previous formatting 

4. Click on the Find Next button to begin the search. 

The steps to replace text are: 

1. Select the replace option from the Edit menu. 
 The replace dialog box is displayed  
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Replace Dialog Box 

2. Type the text to be replaced in the Find What text box. 
3. Type the new text in the Replace With text box. 
4. Select one or more options explained in Table 3.2. 
5. Click on the Find Next button. 
6. Click on the Replace button to change the text. 
7. Click on the Cancel button to return to the document. 

26.9 PREVIEWING A DOCUMENT: 

 Previewing a document means viewing a screen representation of one or more 
pages of the document before printing them. 

 The steps to print preview a document are: 
1. Open the document to be previewed. 
2. Select the Print Preview option from the File menu or click on the Print Preview 
button on the standard toolbar. 
 The Print Preview window is displayed  
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Print Preview Window  

  At the top of the Print Preview window is a toolbar with buttons that perform the 
actions listed in Table.   

 
26.10 PRINT A DOCUMENT: 
 The steps to print a document are: 
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1.  Select the Print option from the File menu or click on the Print toolbar button on the 
standard toolbar.  

 The following Print dialog box is displayed  

 

2. Select the printer on which you want to print the document in the Name text box. 

3. Select one or more options explained in Table 3.4. 

   Option    Function 

Print to file Prints the document to a file on the disk. 
All Prints all the pages of the document. 
Current Page Prints only the current page of the 

document 
Pages Prints the range specified. 
Number of copies Prints those many copies of the document, 

as specified. 
Collate Prints a complete copy of the document 

before the first page of the next copy is 
 printed. 

4. Select an option from the Print what drop-down list. 

5. Select an option from the Print drop-down list. 

6. Click on the Properties button. 

 The Printer Properties dialog box is displayed  
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7. Select the Paper tab. 
8. Change the Paper size to A4 and Orientation to Portrait. 
9. Click on the OK button to close the Properties dialog box. 
10. Click on the OK button to send copies to the printer.  

26.11 PRINTING MULTIPLE DOCUMENTS: 

 The steps to print multiple documents are: 

1. Right-click on the Start menu of Windows NT and choose Explorer to open the 
Explorer. 
2. Select the files to be printed. 
3. Move the pointer over the selection and right-click to display the shortcut menu. 
4. Select the Print option. 

 

26.12 SELF ASSESSEMNT QUESTIONS: 

1 How to Proofing a document by using the spell-check utility? 

2 Explain the Automatic spell-check? 

3 Create five AutoCorrect entries on your own?. 

4 Create five AutoText entries on your own? 

5 Explain the grammar command 

6 How to Find and replace words on a document? 
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7 Explain the Print Preview your document? 

8 How to print a document? 

9 How to printing multiple documents? 

10 Print only the current page of the document. 

 

26.13 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 
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LESSON - 27 

MAIL MERGE 
27.0 OBJECTIVE: 

 At the end of this session, you will be able to learn how to Use the Mail Merge facility of 
Word 

STRUCTURE : 

27.1 Introduction 

27.2 Advantages of mail merge 

27.3 Steps to creation of mail merge  

• Creating the main document 

• Creating the data source 

• Merging the data source and the main document 

27.4 Self Assessment Questions 

27.5 References 

27.1 INTRODUCTION: 

 In a business scenario, it is often required to send letters with identical information to a 
group of people who reside at different locations. The letters may require the address of each 
recipient to be printed on the top in addition to the standard information. This problem is taken 
care of by the Mail Merge feature of Word. 

 Word's Mail Merge feature is used to combine a data source with a main document. The 
data source can be a Word database file that contains the information which changes for each 
document, or it can be a 

27.2 ADVANTAGES OF MAIL MERGE: 

 The following are the advantages of mail merge: 

 1. Automatic generation of letters with a database of names and addresses. 
 2. Automatic pre-addressed forms to merge with letters. 
 3. Automatic mailing labels to merge with letters. 
 4. Automatic generation of envelopes for letters. 

 5. Automatic generation of catalogs. 
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 All the above advantages are achieved in Mail Merge, database created in another 
application. The main document contains the text that is same in each document, and merges 
field codes, which instruct Word where to insert the data source information in the main 
document text. 

27.3 STEPS TO CREATION OF MAIL MERGE:  

 Performing a Mail Merge involves three basic steps. They are  

 A. Creating the main document 
 B. Creating the data source 
 C. Merging the data source and the main document creating a Main Document 

A. CREATING THE MAIN DOCUMENT: 

 The steps to create a main document are: 

 1.  Select the Mail Merge option from the Tools menu. 
  The Mail Merge Helper dialog box is displayed (refer Figure). 

 

 2. Click on the create button in the main document area. 
  The create drop - down list is displayed (refer fig) 
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 3.  Select Form Letters from the list of displayed options. 

   The Microsoft Word dialog box is displayed as shown in Figure 

 

 4.  Click on the Active Window button to confirm that the currently active document is to 
be the main document, or click on the New Main Document button to open a new document as 
the main document. 

 Once the main document is created, the Mail Merge Helper dialog box is reactivated, 
displaying the type of merge and the path of the main document under the Main Document 
heading. 

B. CREATING THE DATA SOURCE: 

 In a Word data source file, the field name should begin with a letter and can contain as 
many as 40 characters, including letters, numbers, underline characters but not spaces. 
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THE STEPS TO SPECIFY A DATA SOURCE ARE: 

1.  Click on the Get Data button in the Data source area of the Mail Merge Helper dialog box 
(refer Figure). 
 A Get Data drop-down list is displayed. 
2.  Select the Create Data Source option from the Get Data drop-down list to create a new 
document as the data source. 
 A Create Data Source dialog box is displayed (refer Figure). 

 

 This dialog box contains a list of commonly-used field names. 
3.  To create a new field, type the new field name in the Field Name text box. 
 Click on the Add Field Name button to add the new field name to the end of the Field 
Names in Header Row list box. 
4. To move an existing field name, select it in the Field names in the Header Row list box. 
 Use the Move buttons to move its position in the list. The Remove Field Name button can 
be used to delete a selected field name.  
5. Click on the OK button. 
 The Save As dialog box is displayed as shown in Figure. 

 
6. Type the name for the data source and click on the Save button. 
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 The Microsoft Word dialog box gets invoked as displayed in Figure. 

 

7. Select the Edit Data Source button to add records to the data source. 
 The Data Form dialog box is displayed as shown in Figure 3.18. 

 

 Consider a case where the records as shown in Table 3.5 are to be added to the data 
form. 

 

4. Type the appropriate information in all the text boxes. 

5. Click on the Add New button of the Data Form dialog box to add another blank record and 
enter information for that record. 
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6. Select the View Source button to display the data source document. 

EDITING THE MAIN DOCUMENT: 

 After you have created a data source, you need to insert the data source field names into 
the main document as merge fields. To do so: 

1. Select the Mail Merge option from the Tools menu. 
2. Click on the Edit button in the Main document area of the Mail Merge Helper dialog box. 
3. Select the file name from the Edit menu in the Mail Merge Helper dialog box to activate 
the main document. 
4. Edit the text in the main document window. 
5. Position the insertion point where you want to add a merge field. 
6. Click on the Insert Mail Merge field button on the Mail Merge toolbar and select the field to 
be  inserted. 

   Insert Merge Field 

7.  Click on the Save button of the standard toolbar to save the main document. 

C. MERGING THE DATA SOURCE AND THE MAIN DOCUMENT: 

 The steps to merge the data source and the main document are: 
1. Open the main document. 
2. Click on the View Merged Data button on the Mail Merge toolbar.   
3. Select the Mail Merge option from the Tools menu to invoke the Mail Merge Helper dialog 
box. 
4. Click on the Merge button in the Merge the Data with the Document area to begin the 
merge process. 
 The Merge dialog box is displayed as shown in Figure. 

 

5. Select a type of merge from the Merge to drop-down list. 
6. Select the number of records to be merged in the Records to be merged group. 
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7. Click on the Merge button after you have made the appropriate selections in the Merge 
dialog box. 

27.4 SELF ASSESSMENT QUESTIONS: 

1.  What is mail merge? Explain 
2.  Explain the advantages of mail merge? 
3.  Explain the steps to perform the mail merge? 
4.  Explain how to merge the data source and main document? 

27.5 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 

• Windows 98     :   Russel Borland, Microsoft Press. 

• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 

• MS-Office 2003 Unleashed   :   Paul MC fedries 

• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
Business Data Processing Systems   28.1  Templates and Wizard      
 

  

LESSON - 28 

TEMPLATES AND WIZARD 
28.0 OBJECTIVE: 

 At the end of this session, you will be able to learn how to Use the templates and wizard 
in MS-Word. 

STRUCTURE 

28.1 Introduction 

28.2 Templates  

28.3 Types of templates  

28.4 Using templates  

28.5 Exploring templates 

28.6 Modifying templates 

28.7 Letter wizards 

28.8 Creating labels 

28.9 Printing of the Labels 

28.10 Self Assessment Questions 

28.11 References 

28.1 INTRODUCTION: 

 Read-only documents with styles and other design elements that you can use to create or 
restyle your own documents are called 'Templates". "Wizards" are computerized assistants. 
Wizards also use templates to create documents, first asking some questions and making a few 
design decisions on their own. The following wizards came with Word. 

  - Agenda   - News letter 
  - Award - Pleading 
  - Calendar - Resume 
  - Fax  - Table 
  - Letter  - Memo 
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28.2 TEMPLATES: 

 There are at least four ways to use templates: 

1) Start new projects based on templates shipped with Word. 
2) Modify projects by choosing templates completely reformat your work in the template 
styles. 
3) Copy selected styles from templates to use in your projects. 
4) Create templates and save new templates of your own creation.  

 

28.3 TYPES OF TEMPLATES: 

Templates are of 3 types.  They are : 

 1) Contemporary 
 2) Elegant 
 3) Professional 

 Here is a list of word's templates, divided in to those that are available in contemporary, 
elegant and professional, and those that are not available in all three types, available Only one 
type 

    Fax     Boucher 
    Letter     Directory 
    Memo     Invoice 
    Press Release   Manual 
    Report    New letter 
    Resume    Weekly time sheet 
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28.4 USING TEMPLATES: 

  Choose File/New and click the tab you wish in the new DIALOG box an^ pick the 
template you wish by name. You can also start wizards from the r^w DIALOG box double-click 
on your choice. 

 Then simply add your own text by clicking on the appropriate areas of the template and 
replacing the labels with your own words. 

28.5 EXPLORING TEMPLATES:  

 Use the Style Gallery, reached with the Format/Style gallery command to preview 
templates, the steps to be followed are : 

1) Open a New document with the File/New. 
2) Choose Normal 
3) Choose Format/Style Gallery^ you will see a window 
4) Pick the template that you want to see from the scrolling list. 
5) Click the example button in the preview area to see : Preview of the templates 
appearance. 
6) Scroll to make sure you see the entire template. 
7) Click style samples to see the names of styles, displayed in the styles themselves. 
8) When you have finished, click 'cancel'. Clicking OK copies the styles to your current 
document but does not load the other template elements. 
 

28.6 MODIFYING TEMPLATES:  

 You can change templates just as you would any other word documents. The only 
difference is one additional step you must take when saving your work. Suppose you want to 
update the professional letter template to include your company logo. Follow these steps: 

1) Use File/New command to open the contemporary letter. 
2) Make the changes, such as adding your logo and other decoration. 
3) Print a sample and check your work. 
4) When you are satisfied, choose File/Save As. 
5) Type the same file name as the old template if you want to replace the old template or 
type a new file  name if you want to keep both the old and new. 
 

28.7 LETTER WIZARDS: 
 Wizards ask you questions, and then use your responses to design documents for you. 

Ex :  Letter Wizard : 

1) Select File/New 



 
 
Centre for Distance Education   28.4   Acharya Nagarjuna University   
 

 

2) Choose Letters and Faxes tab. In that box select Letter Wizard. 
3) You will see a DIALOG box asking for 
 a) Send one letter 
 b) Send letters to a mailing list 
4) It opens a letter wizard. Select the letter format into that set 
 a) Set the Date line ex: 7/14/01. 
 b) Choose page design and a letter style. 
 

 

5) Select the Recipient Information tab. In that enter 

 a) Recipients name 
 b) Delivery address 
 c) Salutation 
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6) Select the other elements tab. It includes 

 a) Reference line 
 b) Mailing Instructions 
 c) Attention 
 d) Subject and courtesy copies 

 

7) Lastly select sender information tab and enter 

 a) Senders name 
 b) Return address 
 c) Closing remarks 

 
8) After finishing your work, click on finish you will see a letter according to taste. 
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28.8 CREATING LABELS: 

 The Mail Merge Helper can also be used to merge labels of various kinds. The steps to 
create mailing labels for an existing form letter are: 

1. Select the Mail Merge option from the Tools menu. 
 The Mail Merge Helper dialog box is displayed as shown in Figure. 
2. Click on the Create button in the Mail Merge Helper dialog box. 
3. Select the option Mailing Labels from the drop-down list. 
4. Click on New Main Document in the dialog box that appears. 
5. Click on the Get Data button in the Mail Merge Helper dialog box and then select Open 
Data Source from the list. 

 

6. Select the appropriate data source. 
7. If Word displays a dialog box, click on Set up Main Document. A Label Options dialog box 
as shown  in Figure appears. 

 
8. Select the appropriate label group from the Label Products drop-down list. 
9. Select the label type from the Product Number drop-down list. 
10. Click on the OK button. 
 The Create Labels dialog box is displayed  
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11. Insert the appropriate merge fields in the Sample Label box. 
12. Click on the OK button. 
 Word displays the Mail Merge Helper. 

 

13. Click on the Merge button to display the Merge dialog box  
14. Select the appropriate options and click on the Merge button. Printing Labels 

28.9 PRINTING OF THE LABELS: 

 The steps to print one or more mailing labels are: 
1. Activate the main document for the form letter. 
2. Select the Envelopes and Labels option from the Tools menu. 
 The Envelopes and Labels dialog box is displayed  
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3. Examine the fields displayed in the Address box. 
4. Select the Single Label button to print a single address label. 
5. Click on the Print button to print the labels. 

28.10 SELF ASSESSMENT QUESTIONS: 

1 What are templates or wizards? Explain with an example 
2 What is wizard? Explain 
3 What is letter wizard? Explain 
4 How to create labels? 
5 How to print labels in MS-Word? 

28.11 REFERENCES: 

• Windows 98 in 24 hours  :  Greg Parry, Techno Media Publication 
• Windows 98     :   Russel Borland, Microsoft Press. 
• ABCs OF WINDOWS 1998, 2003 :   Sharon Crawford Neil J Salkind 
• MS-Office 2003 Unleashed   :   Paul MC fedries 
• Computer studies    :   John shelly, Roger Hunt 

• Working in Microsoft Office  :   Ron Mansfield. 


